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Introduccion

Harmony es un software de animacién completo que permite crear todo tipo de proyectos de animacion
creativos. Incluye una gran variedad de herramientas y funciones.

En esta Guia de introduccion, aprendera los conceptos basicos del uso de las principales funciones de
Harmony Essentials, que le permitiran ponerse al dia rapidamente. Consulte la documentacion completa de
Toon Boom Harmony Essentials disponible en linea en docs.toonboom.com para aprender acerca de todas las
herramientas y opciones, asi como sobre las técnicas avanzadas.
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Capitulo 1: Creacién de una escena

Capitulo 1: Creacion de una escena

Al iniciar Harmony, aparece la pantalla de bienvenida, desde donde puede:
* Crear escenas
« Seleccionar laresolucion de la nueva escena
* Administrar los valores predeterminados de laresolucion de la escena
e Abrir répidamente escenas recién abiertas
e Examinar y abrir una escena creada
e Ver tutoriales en video de Harmony en laweb

» Acceder alapaginaweb de soporte

Abrir una escena
Creary nombrar reciente

una escena

] Crear o eliminar un

Selec:_:]onar la valor predefinido de

resolucion de la _ resolucidn de una
escena Vidth: 1920 escena

y Tutorials Get Help
Examinar y abrir

Open...
pen una escena

Ver tutoriales en video de Obtener soporte
Harmony para Harmaony

Creacion de una escena desde la pantalla de bienvenida

1. Enel campo Name (Nombre), escriba el nombre de la escena.
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NOTA

El nombre de la escena no debe superar los 23 caracteres y no puede contener
caracteres especiales, como *&"%!.

2. Paradecidir en qué directorio se va a crear la escena, haga clic en el boton Brow se (Examinar) junto
al campo Location (Ubicacion).

4. Hagaclic en Create Scene (Crear escena).

Se crea una nueva escena. La ventana de la aplicacion principal aparecera con la nueva escena
abierta.
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Capitulo 2: Introduccion a la interfaz de usuario de Harmony

El uso de Toon Boom Harmony Essentials ser& mucho mas facil si primero se familiariza con su interfaz de
usuario. En el siguiente capitulo se proporciona una introduccion basica a los elementos mas importantes de la
interfaz de usuario. A medida que avance por los capitulos, conocerd méas detalles sobre cada uno de estos
elementos.

Al iniciar Toon Boom Harmony Essentials por primera vez, se presenta el espacio de trabajo predeterminado.
La zona de trabajo se divide en interfaces de usuario rectangulares denominadas vistas, cada una de ellas con
su propio fin especifico. Los laterales superior e izquierdo de la interfaz de usuario, asi como algunas vistas,
también contienen barras de herramientas, cada una con funciones especificas.

| Vvista de
propiedades de la
_Barra de H herramienta
herramientas de
herramientas

Vista de color

Vista de camara

Barra de
herramientas de
reproduccion

1 Vista de linea de
tiempo

Vistas

Las vistas son pequefias interfaces de usuario con fines especificos. Se pueden agregar a la ventana principal
de la aplicacion, en cuyo caso estan "ancladas" o se pueden abrir como ventanas separadas.

Cada vista tiene una pestafia con su hombre en la parte superior. Las pestafias no solo se pueden utilizar para
identificar las vistas con las que esta trabajando, sino que también le permiten apilar varias vistas en la misma
area de lainterfaz de usuario. Por ejemplo, en la zona de trabajo predeterminada, la vista de camara ocupa la
mayor parte del area. En la parte superior de la vista de cAmara hay dos pestafias: Camera (Camara) y
Drawing (Dibujo). Esto se debe a que la vista de dibujo esté apilada con la vista de cAmara y puede cambiar
rdpidamente entre ambas haciendo clic en cualquiera de las pestafas.

Agregar vista

[Cambiarvista] [ Cerrar vista l

Camera
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A laderecha de las pestafias de cada division de la zona de trabajo se encuentran los botones #= Add View
(Agregar vista) y| % Close View (Cerrar vista), que le permiten apilar mas vistas o eliminar la vista
seleccionada de esta area de la zona de trabajo.

Adicién de una vista

Puede agregar, eliminar, mover y apilar vistas en toda la zona de trabajo para optimizar el flujo de trabajo.

Adicion de unavista al espacio de trabajo como una pestafa

1. Enlaesquinasuperior derecha de una vista existente, haga clic en el botén #= Add View (Agregar
vista).

Tool Properties

bstitutions

Brush Fixed Width 1
1

Brush Fixed Width 2
10

2. Seleccione lavista que desee en la lista.

La vista aparece como una nueva pestafa en la seccion del espacio de trabajo donde la agreg6.



Capitulo 2: Introduccion ala interfaz de usuario de Harmony

NOTA

Algunas vistas, como la de camara, se pueden abrir en varias instancias. Por ejemplo, puede
resultar Util si deseatener dos instancias de las vistas de cAmara abiertas, cada una centrada
en distintas areas de la escena, para cambiar rapidamente entre los trabajos de estas dos
areas.

Adicion de una vista ala zona de trabajo como una ventana

1. Abrael ment Windows (Ventanas).
2. Enel ment Windows (Ventanas), seleccione la vista que desee agregar.

La vista aparecera como una nueva ventana sobre la ventana de la aplicacién principal de Harmony.

Anclaje de una ventana de vista en el espacio de trabajo

1. Hagaclicy arrastre lavista flotante por la pestafiay realice una de las siguientes acciones:
e Cologue laventana sobre otra pestafia para agregarla a ese conjunto de pestafnas.

« Coloque laventana por encima, por debajo o junto a una vista existente. Al acercarse
al borde de una vista, aparece un rectangulo cian que indica donde se anclaré la vista.

10
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sheet

5
Bru —_—
10

Brush 3

Aqui se proporciona una breve introduccion a cada una de las vistas mas utilizadas en Harmony.

Vista de camara

Lavista de cAmara es el centro de operaciones en Harmony. En esta vista puede dibujar, pintar, animar,
configurar la escena, manipular objetos, abrir simbolos y previsualizar la animacién.

La vista de camara también tiene una barra de herramientas superior e inferior que puede utilizar para navegar
en lavista, cambiar el modo de visualizacién o subir la jerarquia de simbolos.

11
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Pila de edicidn

Barra de herramientas de
mara
Modo de vista | Modo de vista
de OpenGL J| de render
I Mesa de luz ] Meni de zoom Nombre de [ Color seleccionado ]
__ i Espacio de color de vista '
Dibujo aclual encima I I Mostrar instantdnea previa
Mascara de camara I ] Tomar instantanea
I Zona segural I Restablecer vista
[ Mostrar guias de alineacién " Trazar dibujos bloqueados I

Vista de dibujo

En Harmony, puede dibujar tanto en la vista de dibujo y como en la de cAmara. Aunque las dos vistas son
similares, hay algunas diferencias cuando se trata de dibujar.

En la vista de dibujo solo se muestra el dibujo seleccionado de forma predeterminada. Puede utilizar funciones
como la mesa de luz para mostrar el dibujo actual de todas las capas habilitadas de la escena con colores

descoloridos, o el papel cebolla para mostrar los dibujos anteriores y siguientes de la capa de dibujo
seleccionada actualmente.

12
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Barra de herramientas de vista de dibujo

Camera Drawing =%

Areade
dibujo

Nombre del dibujo Nombre de herramienta Nimero de fotograma | | Posicion del cursor Selector de color

Vista de propiedades de la herramienta

La vista de propiedades de la herramienta contiene las opciones y operaciones mas comunes relacionadas con
la herramienta seleccionada actualmente. Al seleccionar una herramienta en la barra de herramientas de
herramientas, se actualizala vista de propiedades de la herramienta.

Por ejemplo, si elige la herramienta Select (Seleccionar), la vista de propiedades de la herramienta mostrara
las opciones y operaciones relacionadas con dicha herramienta, como Shap to Contour (Ajustar a contorno),
Apply to All Drawings (Aplicar atodos los dibujos), Flip Horizontal (Voltear en horizontal) y Flatten (Acoplar).

13
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Posibles opciones y
modos para la
herramienta actual

Fosibles operaciones
para la herramienta
actual

Vista de color

La vista de color es donde se crean colores y paletas, y se importan paletas existentes en el proyecto. La vista
de color también es necesaria para dibujar, pintar y crear estilos de color.

[ Quitar paleta I [ Importar paleta I

[ Meni de vista de colorl [ Agregﬁrpﬁletﬁl [Bﬁjﬁr,’subirpﬁletﬁ I

Tolour 4%

[ Contraerfexpandir lista de paletas

Scene Palettes

—[ Lista de paletas

[ Agregar muestra de color

[ Quitar muestra de color

[ Agregar textura

[ Muestra de color

'—[ Lista de muestras de colores

|
 —
—
 I—
 I—
—1
|
—
—1
 I—
—
|
=
 —
 —

14
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Vista de linea de tiempo

Para establecer el tiempo de la animacion, trabajaré principalmente con las vistas de linea de tiempo y de carta
de rodaje. Es muy til familiarizarse con la vista de linea de tiempo, su funcionamiento y su interfaz.

Lavista de linea de tiempo es la vista principal utilizada al ajustar el tiempo de los dibujos, agregar fotogramas
clave y ordenar capas. La vista de linea de tiempo muestra capas, efectos, sonidos, valores de fotogramas
clave, duracion de escena, nombres de capas, dibujos, fotogramas clave, tiempo y fotogramas.

LHabiIitan'deshabilih'cma )
[ Habilitar/deshabilitar modo Soo ) ((Aoregar capa I
[Agregan'quitarpapeloebnlla I [ Slipinancar I
[ Eloguear/desbloguear capa I [ dorerancana dedhuig I
[ Alternar modo de contorno I Agregar peg
[Mostran'ocultarima'genes &n miniatura I [ Para'r:etrns | [ Cursor de linea de tismpo I [ Exposicidn de dibujo I

[Expandir.l’onntraergrupn I Coord dasenel
R R . fotograma actual [ 7 1 I [ i5 I
Mos'imn"ocul [Expandlr.l’onntraerjerarquladecapas I g Zoom de linea de tiempo Fotograma clave de funcidn
tarvincul
adicionales Mostrariocul || Ndmero de dibujo
tar en el fotograma actual
[ Mostrar/ocultar parametros I funci;

Lavistade linea de tiempo permite leer el tiempo de izquierda a derecha. Representa los elementos de la
escena en su forma mas simple. También puede ver las capas y sus nombres, asi como la exposicion del
dibujo. El nombre del dibujo se muestra al colocar el puntero sobre la exposicion del dibujo.

Vista de sustituciones de dibujo

La vista de sustituciones de dibujo le permite ver todos los dibujos de la capa seleccionada en unalista de
imagenes en miniatura, asi como seleccionar rapidamente qué dibujo se debe exponer en el fotograma actual.

15
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h Tool Properties  Library | Drawing Substitutions | 4|3

a Mado de
edicidn

Campo de
blsqueda

| Imégenes
miniatura

Contral
deslizante de
zoom

Animation

Nombre de capa actual

Vista de carta de rodaje

Lavista de carta de rodaje permite leer el tiempo verticalmente mostrandolo en una cuadricula, con cada capa
de dibujo representada por una columna, cada fotograma de la escena representado por unafilay cada dibujo
expuesto mostrado por su nombre en las celdas. Se pretende que funcione como una carta de exposicién de
animacion tradicional.

Con el panel de funciones, también puede ver las funciones y los fotogramas clave de las rutas de movimiento
de la columna seleccionada, con el valor de esas funciones para cada fotograma que se muestra en las celdas.

A diferencia de la vista de linea de tiempo, la vista de carta de rodaje no muestra pegs, efectos o jerarquia de
capas. Por lo tanto, se optimiza para una animacion tradicional y sin papel, mientras que la vista de linea de
tiempo se optimiza para una animacion digital o cut-out.

16
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I Barra de herramientas de carta de rodaje

I Encabezado de columna

Dibujo actual

Fotograma actual

13.577
13.561
13.544
13.528
] 13.511
I Exposicidn de dibujo 13.494 7 .
13.478 kz J o

Panel principal Panel de funciones

13.395 3.946
13.378
13.362
13.345
13.329
13312
13.295
13.279
13.262
13.246
13.229

Current: 1: A

I Numeros de fotograma I Lo Columna de Aumentarredudr Modo de
Dibujo/elemento actual funcidn oo . Pl

Vista de libreria

Lavista de libreria se utiliza para almacenar elementos como animaciones, dibujos, fondos y modelos de
personajes para volver a utilizarlos en distintas escenas y proyectos. También puede utilizar la vista de libreria
para crear y almacenar simbolos, asi como para almacenar e importar imagenes y archivos de sonido.

Parareutilizar elementos de una escena en otras escenas, debe crear una plantilla para poder importarla en
distintas escenas. Las plantillas pueden contener cualquier elemento, desde un solo dibujo hasta una
estructura de escena completa. Puede crear una plantilla en una escenay copiar los elementos que desee de
la plantilla en unalibreria. La plantilla resultante se estructura como una miniescena que solo contiene los
elementos que copid en ella. Una plantilla no tiene ninguna dependencia en la escena en la que se cred
originalmente. Por lo tanto, se puede importar de forma segura en cualquier otra escena.

Ademas, el panel Drawing Substitutions (Sustituciones de dibujo) de la vista de libreria permite cambiar
rdpidamente la exposicion del fotograma actual a uno de los dibujos existentes en una capa. Esto es
especialmente Util para la animacién de las bocas, manos, parpados y otras partes del cuerpo de un personaje
cut-out, que suelen contener varios dibujos donde elegir.

17
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-l

Vista previa de
imagen en
miniatura

s | ¢

Nombre del dibujo * Lista de
recursos
I MNombre del elemento/recurso

Control deslizante de
sustituciones de dibujo

I Barra de blisqueda

Lista de carpetas de
libreria

I 'El campo del nombre del dibujo sclo aparece si se selecciona un elemento de la escena.

Barras de herramientas

Lainterfaz de Harmony contiene barras de herramientas que proporcionan acceso rapido a muchas
herramientas Gtiles. Puede agregar, mover y eliminar barras de herramientas de la zona de trabajo.

Las barras de herramientas se dividen en dos categorias principales:

« Lasbarras de herramientas de la zona de trabajo son barras de herramientas con un propésito general.
Por ejemplo, las barras de herramientas de archivo, edicién, zona de trabajo y deformacion de la parte
superior, asi como la barra de herramientas de herramientas de la izquierda son barras de herramientas
de lazona de trabajo. Esas barras de herramientas se pueden colocar en el borde superior, inferior,
izquierdo o derecho de la ventana de |la aplicacion. Si se prefiere, también se pueden colocar en el borde
de vistas especificas.

e Las barras de herramientas de vista son barras de herramientas Utiles para una vista especifica. Por
ejemplo, lavista de cAmaratiene una barra de herramientas de camara en la parte superior. Las barras
de herramientas de vista solo se pueden mostrar dentro de su vista respectiva. Se pueden colocar en el
borde superior, inferior, izquierdo o derecho de su vista.

Adicion de barras de herramientas

Adicién o eliminacion de la barra de herramientas de una zona de trabajo a la zona de
trabajo general

1. Realice unade las siguientes acciones:

« En el mend superior, seleccione Windows > Toolbars (Ventanas > Barras de herramientas)
y, en el submend, seleccione la barra de herramientas que desee agregar.

18
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¢ Haga clic con el botén derecho en cualquier barra de herramientas situada en la parte
superior o lateral de la zona de trabajo o en la zona vacia junto a estas barras de
herramientas, y seleccione la barra de herramientas que desee agregar en el menu

contextual.

Haga clic con el botén
derecho en esta drea
para agregar o
eliminar barras de
herramientas.

Adicion de una barra de herramientas de vista a una vista

1. Realice unade las siguientes acciones:

¢ Hagaclic en la pestafia de la vista para la que desea agregar una barra de herramientas para
centrarse en ella. A continuacion, en el menu superior, seleccione Windows > Toolbars
(Ventanas > Barras de herramientas) y seleccione la barra de herramientas que desee

agregar.

19
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NOTA

En la lista de barras de herramientas del menu superior y el menu contextual de
la zona de trabajo, las barras de herramientas enumeradas por encima del
separador son barras de herramientas de la zona de trabajo y las que estan
debajo del separador son barras de herramientas de vista.

Workspace
| toolbars

View
toolbars

¢ En el area superior de la vista a la que desee agregar una barra de herramientas, ala
izquierda de la pestafia, haga clic con el botdn derecho y seleccione la barra de herramientas
gue desee agregar en el menu contextual.

Haga clic con el botén derecho
en el drea izquierda de la
pestaria de |a vista de camara
para agregar una barra de
herramientas a la vista de
camara.

Dado que la vista de camara
ya dispone de una barra de
herramientas, también puede
hacer clic con el botén derecho
en ella para agregar barras de
harramientas a la vista de
camara o eliminarlas de la
misma.

20
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NOTAS

e Enlalista de barras de herramientas del menud contextual de una vista, las
barras de herramientas enumeradas por encima del separador son barras de
herramientas de la zona de trabajo y las que estan debajo del separador son
barras de herramientas de vista.

— Barras de
herramientas
de vista

Barras de
herramientas
de la zona de
frabajo

» Siselecciona unabarra de herramientas de la zona de trabajo en el menu
contextual de unavista, esta barra de herramientas de la zona de trabajo se
agregara a la vista. Si ya estaba presente en la zona de trabajo, se eliminara
de su ubicacién anterior.

e Cuando se agrega una barra de herramientas de la zona de trabajo a una
vista que tenga apiladas otras vistas, dicha barra de herramientas serd visible
en todas las vistas apiladas en la misma zona. Por ejemplo, si agrega la barra
de herramientas de animacién avanzada a la vista de cAmara, también sera
visible en la vista de dibujo.

Desplazamiento de una barra de herramientas

1. Hagaclicy mantenga pulsado el controlador situado a laizquierda de la barra de herramientas que
desee mover.

2. Realice unade las siguientes acciones:

» Silabarrade herramientas es horizontal, muévala hacia arriba o hacia abajo para sacarla de
su fila.

21
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» Silabarrade herramientas es vertical, muévala hacia la izquierda o hacia la derecha para
sacarla de su columna.

3. Realice unade las siguientes acciones:

» Parareorganizar las barras de herramientas, arrastre la barra de herramientas hasta donde
deseey coloquela.

La barra de herramientas se movera a su hueva posicion. Las barras de herramientas
situadas a la derecha (o en la parte inferior, si la barra de herramientas es vertical) se
desplazaran para dejar espacio.

e Paramover la barra de herramientas a una nueva fila o columna, simplemente muevala
barra de herramientas donde se deba crear la nueva fila o columna. Por ejemplo, para crear
unanueva fila de barras de herramientas en la parte superior de la interfaz de usuario,
muévala justo debajo de las barras de herramientas existentes en la parte superior de la
interfaz de usuario. Aparecera una nueva fila o columnaresaltada en cian.

Al colocar la barra de herramientas, se creara la nueva filay la barra de herramientas se
colocara en el extremo izquierdo de esta.

Del mismo modo, para crear una nueva columna a laizquierda de la interfaz de usuario,
muévala justo a la derecha de las barras de herramientas existentes alaizquierda de la
interfaz de usuario.

+ Paramover labarra de herramientas a otro extremo de la interfaz de usuario, arrastrela
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hasta dicho extremo.

Desplazamiento de una barra de herramientas sobre otra barra de herramientas

1. Asegurese de que ambas barras de herramientas se encuentren en la misma fila o columna. Sino lo
estan, mueva ambas barras de herramientas a la misma fila o columna siguiendo el método
descrito anteriormente.

» Silas barras de herramientas son horizontales, haga clicy mantenga pulsado el controlador
de laizquierda de la barra de herramientas situada mas ala derecha. A continuacién, sin salir
delafilade labarra de herramientas, deslice la barra de herramientas hacia la izquierda.

e Silas barras de herramientas son verticales, haga clic y mantenga pulsado el controlador de
la parte superior de la barra de herramientas inferior. A continuacion, sin salir de la columna
de labarra de herramientas, deslice la barra de herramientas hacia arriba.

A medida que desliza la barra de herramientas sobre la otra barra de herramientas, los botones de
la otra barra de herramientas se ocultan y aparece un botén de mend emergente.

[ e

Ment emergente para los
botones ocultos
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2. Paraseparar de nuevo las barras de herramientas, simplemente deslice la misma barra de
herramientas en la direccion opuesta.

3. Paraexpandir una barra de herramientas que tenga superpuesta otra barra de herramientas, haga
clic en el botén de expansion situado a la derecha de la barra de herramientas superpuesta.

Barra de herramientas de herramientas

La barra de herramientas de herramientas contiene las herramientas principales que necesita para trabajar en
Harmony. En la zona de trabajo predeterminada, esta barra de herramientas se encuentra en el borde
izquierdo de la ventana de la aplicacion.

Algunos de los botones de la barra de herramientas de herramientas disponen de un tridngulo en la esquina
inferior derecha. Es para indicar que hay varias herramientas apiladas en este botdn. Para acceder a estas

herramientas, haga clicy mantenga pulsado el botén de herramienta, o seleccione la herramientay haga clic
de nuevo.

Una flecha en la esquina indica que hay mas
herramientas disponibles en un mend
emergente.

I

Seleccionar

Editor de contorno ntour Editor

K rline Editor
Pincel

Sello
Borrador
Texto
Rectangulo w Paint

Pintar w Paint Unpainted

=

o
=4

N

[ Cuentagotas de color

Mango

[ Modo Animate (Animar)

Transformar

Fapelcebolla
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CONSEXO

Muchos botones de la barra de herramientas disponen de un atajo de teclado asociado. Puede
comprobar qué atajo de teclado esta asociado a un botén dejando el cursor del ratén sobre el
botdn durante un segundo. Si el bot6n tiene un atajo de teclado, se indicara en la informacion
sobre herramientas que aparece.

Brush (Alt+B)
Create lines or areas like a paint brush.

Barra de herramientas de archivo

La barra de herramientas de archivo contiene botones para operaciones de archivo comunes, como New
(Nuevo), Save (Guardar) y Open (Abrir). Estos comandos también se encuentran en el menu superior File

(Archivo).

Barra de herramientas de edicion

La barra de herramientas de edicién contiene operaciones comunes como Undo (Deshacer), Redo (Rehacer),
Cut (Cortar), Copy (Copiar) y Paste (Pegar). Estos comandos también se encuentran en el menu superior Edit
(Editar).

Crear simbolo

I Corlar] ICopiar I

Barra de herramientas de reproducciéon

La barra de herramientas de reproduccion le permite reproducir la animacién, asi como configurar algunas
opciones de reproduccion, como bucle, reproduccion de audio, rango de reproduccion y velocidad de
reproduccion.
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% Render and Play

rd and Play

[ Desplazar fotogramas

[ Renderizar y reproducir ] [ Habilitar depuracién de sonido ]

[ Bucle ] [ Habilitar sonido ]

Navegacion por la interfaz

Con laayuda de comandos de menu y atajos de teclado, algunas vistas permiten navegar por su contenido al
acercarlo, alejarlo, panearlo y rotarlo. También puede restablecer el nivel de zoom, el paneo y el angulo de
rotacién de estas vistas segln sea necesario.

Los comandos de navegacion de la tabla que se muestra a continuacion se pueden utilizar en las siguientes
vistas, con algunas excepciones:

e Camara

¢ Dibujo

e Lineadetiempo
e Cartaderodaje
¢ Funcion

e Lateral y superior

(Y- CONSEI
Los atajos de teclado se pueden personalizar. Puede ver, buscar y cambiar atajos de teclado para
Harmony en el cuadro de dialogo Keyboard Shortcuts (Atajos de teclado). Para acceder al cuadro

de didlogo Keyboard Shortcuts (Atajos de teclado):
 Windows: en el menu superior, seleccione Edit > Keyboard Shortcuts (Editar > Atajos de
teclado).
*« macOS : en el menu superior, seleccione Harmony Essentials > Keyboard Shortcuts
(Harmony Essentials > Atajos de teclado).

Comando Accion Métodos de acceso

View > Zoom In (Ver > Acercar)

Zoom In (Acercar) Acercalavista.
Pulse 2.
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Comando

Accién

Métodos de acceso

Gire larueda del ratdn hacia arriba (excepto en las vistas de
linea de tiempo y de carta de rodaje)

Zoom Out (Alejar)

Alejalavista.

View > Zoom Out (Ver > Alejar)
Pulse 1.

Gire larueda del ratén hacia abajo (excepto en las vistas de
linea de tiempo y de carta de rodaje)

Zoom In o Zoom
Out (Acercar 0
Alejar)

Acerca o alejalavista.

Gire larueda central del ratén hacia arriba o hacia abajo.

Mantenga pulsada la barra espaciadora y la rueda central del
ratén mientras arrastra el ratén hacia arriba o hacia abajo.

Pan (Panear)

Mueve la vista horizontal
o verticalmente.

Mantenga pulsada la barra espaciadoray arrastre en la
direccién que desee panear la vista.

(Restablecer vista)

posicion predeterminada.

Reset Pan Restablece el paneo de View > Reset Pan (Ver > Restablecer paneo)
(Restablecer vista a su posicion
paneo) predeterminada. Pulse MayUs + N.

View > Reset View (Ver > Restablecer vista)
Reset View Restablece lavistaasu Pulse Mayus + M.

El boton @ Reset View (Restablecer vista) en la parte
inferior de la vista de camara.

Reset Rotation
(Restablecer

Restablece larotaciéon de
vista a su posicion

View > Reset Rotation (Ver > Restablecer rotacion)

rotacion) predeterminada. Pulse MayUs + X.
Reset Zoom Restablece el zoom de
(Restablecer vista a su posicion View > Reset Zoom (Ver > Restablecer zoom)
zoom) predeterminada.
. Mientras mantiene pulsadas las teclas Ctrl + Alt

Rotate View . . . .

) Rota lavista. (Windows/Linux) o Ctrl + 8 (macOS), hagaclicy arrastre el
(Rotar vista)

disco de rotacién para rotarlo ala derecha o alaizquierda.

Rotate 30 CW
(Rotar 30 der.)

Rotalavista de camara
30 grados a la derecha,

View > Rotate View CW (Ver > Rotar vista der.)
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Comando

Accién

Métodos de acceso

como una mesade
animacion.

Rotate 30 CCW
(Rotar 30 izq.)

Rota la vista de camara
30 grados a laizquierda,
como una mesa de
animacion.

View > Rotate View CCW (Ver > Rotar vista izq.)

Mirror View (Vista
de espejo)

Cambia temporalmente
lavistade camarao de
dibujo en horizontal, lo
que permite ver y editar
lailustracién como si se
estuvierareflejando.

View > Mirror View (Ver > Espejo)

En la barra de herramientas de camara o de dibujo, haga clic
en el boton Mirror View (Espejo) Q .

Toggle Quick
Close-up (Alternar
primer plano
r4pido)

Multiplica
inmediatamente el factor
de zoom de la vista por 4.
Por ejemplo, si el factor
de zoom de lavista de
camara se encuentra al
100 %, esto hara que
alterne entre 400 % y
100 %.

Mayus + Z

Toggle Full Screen
(Alternar pantalla
completa)

Pasa por los siguientes
modos de visualizacion:

¢ Normal Full-
Screen (Pantalla
completa normal):
laventana
principal de la
aplicacion se
convierte en
pantalla
completa.

¢ View Full-Screen
(Ver pantalla
completa): lavista
seleccionada se
convierte en
pantalla completa

View > Toggle Full Screen (Ver > Alternar pantalla
completa)

Pulse Ctrl + F(Windows/Linux) 0 ¥ + F(macOS).
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Comando Accién Métodos de acceso

y todas las demas
vistas se
contraen.

¢ Normal:la
ventana principal
de la aplicacion se
restauraasu
tamafio original y
las vistas
contraidas se
expanden.

Interfaz tactil

Si esta trabajando con una pantalla tactil, un trackpad o una tableta que admita funcién téctil, también puede
utilizar los gestos de dos dedos estandar para el zoom, larotacién y el paneo en las vistas de cAmaray dibujo.
Para poder hacer esto, primero debe habilitar la preferencia Support Gestures (Soporte de gestos).

Habilitacion del soporte de gestos

1. En el menu superior, vaya a Edit > Preferences (Editar > Preferencias) (W indows/Linux) o
Harmony > Preferences (Harmony > Preferencias) (Mac OS X).

2. Abralapestafia General.

3. Enlaseccion Touch Interface (Interfaz tactil), marque la casilla de verificacién Support Gestures
(Soporte de gestos).

4. Hagaclicen OK (Aceptar).
5. Reinicie Harmony.

Ahora puede manipular las vistas de camara y de dibujo arrastrando dos dedos sobre la interfaz
tactil.

Uso de gestos

1. Enlavistade camara o de dibujo, presione con dos dedos situados a una distancia corta entre si.
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2. Realice unade las siguientes acciones:

» Para panear lavista, arrastre los dos dedos en cualquier direccion, manteniéndolos ala
misma distancia uno del otro.

» Para acercar el zoom, arrastre los dos dedos separando uno del otro.

e Paraalejar el zoom, arrastre los dos dedos acercando uno al otro.

» Pararotar, arrastre los dos dedos haciendo una curva para que giren en la misma direccion.
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Capitulo 3: Adicion de capas

Al igual que con la animacion tradicional, Harmony utiliza capas para mantener los elementos, como
personajes, fondos y props, separados unos de otros, lo que permite animarlos de forma independiente.

Al crear una nueva escena, la escena tendra una capa predeterminada denominada Drawing (Dibujo) en la
gue se puede comenzar a dibujar de inmediato.

Capa de dibujo
predeterminada

Las capas se pueden seleccionar y gestionar en la vista de linea de tiempo. Una escena puede tener tantas
capas como sea necesario. Cuando la escena tiene varias capas, las capas superiores de la lista aparecen sobre
las capas inferiores.

Y R T— :

Cambio de nombre de capas

En una nueva escena, solo hay una capa creada de forma predeterminada, y se denomina Drawing (Dibujo). En
la animacién tradicional, es comdn nombrar a las capas de animacion con letras individuales (A, B, C, etc.) y las
capas de disefio con acronimos (BG para fondo, OL para superposicion, etc.). Asi, puede comenzar la escena
dando ala primera capa un nombre adecuado.

Cambio de nombre de una capa en la vista de linea de tiempo

1. Enlavistade linea de tiempo, haga doble clic en el nombre de la capa que desee cambiar.

Aparece un campo de entrada de texto sobre el nombre.
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2. Escriba el nuevo nombre de la capay pulse Intro/retorno.

La capa tiene un nuevo nombre.

nO=am

o

Adicion de capas

Adicion de un elemento de dibujo desde la vista de linea de tiempo

1. Realice unade las siguientes acciones:

» Enlavistadelinea de tiempo, hagaclic en el boton ¥ Add Drawing Layer (Agregar capa de
dibujo).

» En el menu superior, seleccione Insert > Drawing (Insertar > Dibujo).

e Pulse Ctrl + R (Windows/Linux) o # + R (macOS).

Aparece el cuadro de didlogo Add Drawing Layer (Agregar capa de dibujo).

Add and Close

2. Enel campo Name (Nombre), escriba el nombre de la nueva capa.
3. Realice una de las siguientes acciones:

e Hagaclicen Add (Agregar) para crear esta capa, pero deje abierto el cuadro de dialogo para
poder crear mas capas.

e Hagaclicen Add and Close (Agregar y cerrar) para crear esta capay cerrar el cuadro de
dialogo.
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Se agrega alavista de linea de tiempo una nueva capa de dibujo.

Eliminacion de capas

Eliminacion de capas en la vista de linea de tiempo

1. Enlavistade lineadetiempo, seleccione las capas que desea eliminar.

NOTA

Puede seleccionar varias capas contiguas manteniendo pulsada la tecla Mayus,
haciendo clic en la primera capa que desee seleccionar y, a continuacion, en la tltima.
También puede seleccionar varias capas manteniendo pulsada la tecla Ctrl
(Windows/Linux) o # (macOS)y haciendo clic en cada capa que desee seleccionar.

2. Realice unade las siguientes acciones:

e Enlabarrade herramientas de capa de la vista de linea de tiempo, haga clic en el boton —
Delete Layers (Eliminar capas).

» Hagaclic con el botdn derecho en la seleccion y seleccione Delete (Eliminar).

Las capas seleccionadas se eliminan de la vista de linea de tiempo.
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Cambio de orden de capas

Reorganizacion de capas en lavista de linea de tiempo

1. Enlavistade linea de tiempo, seleccione las capas que desea mover.

2. Hagaclicy arrastre la seleccién, y realice una de las siguientes acciones:

» Coloque la seleccién entre dos capas para moverla entre ellas. Aparecera una linea cian
entre las capas donde se movera la seleccion.

rnosam

e Cologue la seleccién en una capa para aplicar un rig de las capas seleccionadas como hijas
sobre esa capa.

Agrupacion de capas
La agrupacién de capas permite mantener la estructura de la escena organizada.

Ademas, puede colocar varias capas dentro de un grupo y, a continuacion, agregar un efecto en este grupo
para aplicarlo en todas las capas del mismo.

35



Capitulo 3: Adicion de capas

Agrupacion de capas en la vista de linea de tiempo

1. Enlavistade lineade tiempo, seleccione los elementos que desee agrupar.

NOTA

Las capas que se encuentren entre las seleccionadas se agruparan con las capas
seleccionadas.

2. Realice unade las siguientes acciones:

e Hagaclic con el botdn derecho en las capas resaltadas y seleccione Group Selection
(Agrupar seleccidn).

e Pulse Ctrl + Mayus + G (Windows/Linux) o # + mayusculas + G (macOS).

Se agrega una nueva capa de grupo alavista de linea de tiempo.

Si hace clic en el botén Expand Group (Expandir grupo), encontrara las capas agrupadas en rig
como hijos de la capa de grupo.

Ocultar y visualizar capas

Puede ocultar capas temporalmente para que no desordenen la vista de camara mientras trabaja en otras
capas.

36



Guia de introduccion de Harmony 22 Essentials

Como ocultar una capa en la vista de linea de tiempo

1. Enlavistade lineade tiempo, a laizquierda de la capa que desea ocultar, haga clic en el boton (e
Disable Layer (Deshabilitar capa).

La capase volverainvisible en la vista de camara.

2. Sideseamostrar la capa, haga clic en el boton @ Enable Layer (Activar capa) para volver a
mostrarla.

Blogueo y desbloqueo de capas

Puede bloquear capas temporalmente. Las capas blogueadas se pueden editar en la vista de linea de tiempo o
de carta de rodaje, pero no puede seleccionarlas, dibujarlas o manipularlas en la vista de camara. Esto puede
ser Util para evitar seleccionar o dibujar accidentalmente sobre los fondos, superposiciones, props o
personajes con los que no esté trabajando actualmente.

Bloqueo de una capa en la vista de linea de tiempo

1. Enlavistade lineade tiempo, a laizquierda de la capa que desea bloquear, haga clic en el boton
i Lock (Bloquear).

Seraimposible seleccionar la capa o dibujar en ella en la vista de camara. El nombre de la capa
aparecerd en rojo en lavista de linea de tiempo.

2. Sideseadesbloquear la capa, hagaclic en el botdn Unlock Layer (Desbloquear capa) para
volver a mostrarla.
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Capitulo 4: Como dibujar

Cuando crea una escena, la escena incluye una capa de dibujo predeterminada en la que puede comenzar a
dibujar de inmediato.

NOTA

Segun su estilo de dibujo y con lo que se sienta comodo, es posible que prefiera trabajar con la
herramienta Brush (Pincel) o la herramienta Pencil (Lapiz). Para obtener mas informacién sobre la
diferencia entre estas dos herramientas, consulte Cuando crea una escena, la escena incluye una
capa de dibujo predeterminada en la que puede comenzar a dibujar de inmediato. en la pagina 39.

Dibujo con la herramienta Brush (Pincel)

1. Enlavistadelineadetiempo o de carta de rodaje, haga clic en la primera celda de la capa de
dibujo.

2. Sideseadibujar con la herramienta Brush (Pincel), realice una de las siguientes acciones:
e Enlabarrade herramientas de herramientas, seleccione la herramienta »~ Brush (Pincel).
* En el menu superior, seleccione Tools > Brush (Herramientas > Pincel).
e Pulse Alt + B.

Si desea dibujar con la herramienta Pencil (L4piz), realice una de las siguientes acciones:

« Enlabarrade herramientas de herramientas, seleccione la herramienta & Pencil (Lapiz).
e En el menu superior, seleccione Tools > Pencil (Herramientas > Lapiz).
e Pulse Alt +/.

3. EnlalistaPresets (Valores predefinidos) de la vista de propiedades de la herramienta, seleccione
un pincel o lapiz predefinido que desee utilizar.
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4. Utilice el control deslizante Maximum Size (Tamafio maximo) para seleccionar el tamafio deseado
para el pincel o lapiz.

5. Para seleccionar un color, haga clic en el color que desee utilizar en la vista de color. Para obtener
mas informacién sobre la creacién y edicién de colores, consulte Creacién o edicion de muestras de
colores en la pagina51.

Colour  ==[%

4+ - = 3}

Scene Palettes

[Adlw ]

7. Siestautilizando la herramienta Brush (Pincel) y desea realizar cambios en su pincel, en la vista de
propiedades de la herramienta, haga clic en el boton de flecha para abrir el cuadro de diadlogo
Brush Properties (Propiedades del pincel). En este cuadro de didlogo, puede personalizar el
tamafio, laformay el suavizado del pincel.

. /\/ n
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CONSEXOS

» Puede ajustar rapidamente el tamafio de la herramienta de dibujo seleccionada
manteniendo pulsada la teclay, a continuacion, haciendo clicen lateclaOy, a
continuacion, arrastrando en el espacio de dibujo. Si utiliza un lapiz de tableta, al hacerlo
con la punta del borrador del lapiz ajustara el tamafio de la herramienta Eraser (Borrador),
independientemente de la herramienta de dibujo seleccionada.

» Simantiene pulsadalatecla Mayus antes de dibujar o mientras lo hace, dibujara una linea
recta.

« Simantiene pulsadalatecla barra espaciadora mientras dibuja una linearecta, se fijara el
angulo de lalinea. Si utiliza una tableta sensible ala presion, puede dibujar sobre lalinea
para ajustar su grosor.

* Simantiene pulsadas las teclas Mayus y Alt antes de dibujar o mientras lo hace, dibujara
una linea recta horizontal o vertical.

e Simantiene pulsadalatecla Ctrl (Windows/Linux) o 8 (macOS) mientras dibuja, su trazo
de dibujo se convertira en una forma cerrada.

¢ Si mantiene pulsada latecla Alt antes de dibujar un trazo y comienza a dibujar cerca de un
dibujo existente, el comienzo del trazo se conectara con el otro dibujo.

¢ Simantiene pulsadalatecla Alt mientras dibuja, y finaliza el trazo de dibujo cerca de otro
dibujo existente, el final del trazo se conectara con dicho dibujo.

Ajuste de ilustracion

Harmony ofrece distintas maneras de ajustar los dibujos. Puede deshacer el Ultimo trazo, borrar partes de un
dibujo, mover, transformar o eliminar trazos, y modificar los puntos y las curvas de los trazos.

Deshacer el tltimo trazo

1. Realice unade las siguientes acciones:
» En el mend superior, seleccione Edit > Undo (Editar > Deshacer).

e Pulse Ctrl + Z (Windows/Linux) 0 # + Z (macOS).

Como borrar

1. Enlabarrade herramientas de herramientas, seleccione la herramienta & Eraser (Borrador) o
pulse Alt + E.
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2. Enlavistade dibujo o de camara, dibuje un trazo de borrador sobre las partes del dibujo que desee
borrar.

Manipulacién de los trazos del dibujo

1. Enlabarrade herramientas de herramientas, seleccione la herramienta ® Select (Seleccionar) o
pulse Alt + S.

2. Enlavistade cAmara, seleccione los trazos que desee editar realizando una de las siguientes
acciones:

» Hagaclic en un trazo para seleccionarlo.

e Mantenga pulsadalatecla Mayus mientras hace clic en un trazo para agregarlo ala
seleccion.

» Dibuje un lazo alrededor de los trazos de dibujo para seleccionarlas simultdneamente.
3. Realice unade las siguientes acciones para editar la seleccion:

« Para cambiar lailustracion seleccionada de posicion, haga clic en ellay arrastrelaala
posicion deseada.

NOTA

También puede realizar un desplazamiento pequefio de la seleccion con las
teclas de flechay, para realizar un desplazamiento rapido, mantenga pulsado
MayUs y pulse las teclas de flecha.

e Pararotar lailustracion seleccionada, haga clic fuera de laimagen y coja uno de los
controladores en las esquinas del cuadro de control y rétela.
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e Paraescalar lailustracion seleccionada, haga clicy arrastre uno de los puntos de control en
las esquinas o en el centro de los bordes del cuadro de control.

[]
_‘Q’_ CONSEJO
4 \
Mientras escala lailustracion, puede conservar las proporciones manteniendo
pulsada latecla Mayus.

e Para sesgar, arrastre hacia los lados o hacia arriba y abajo de los lados o los segmentos
superior e inferior, entre los puntos de control.
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» Para eliminar, pulse Supr (W indows/Linux) o retroceso (macQOS).

Como cortar dibujos

1. Enlabarrade herramientas de herramientas, seleccione la herramienta Cutter (Cuchilla) 2 o
pulse Alt + T.

2. Enlavistade camara o de dibujo, dibuje un lazo alrededor del trabajo que desea cortar.

El trabajo dentro del lazo que ha dibujado se cortara del resto del trabajo y se seleccionara.

_‘Q’_ CONSEJOS
» Puede agregar otra parte del trabajo a la seleccion manteniendo pulsado Mayus y
dibujando otro lazo.
» Deforma predeterminada, la herramienta Cutter (Cuchilla) solo funcionara en la
capa actual. Puede cortar trabajos de todas las capas visibles manteniendo pulsada
latecla Ctrl (Windows) o0 8 (macOS).

3. Unavez que haya cortado laimagen, puede manipularla como con la herramienta Select
(Seleccionar). Por ejemplo:

e Paramover el trabajo seleccionado, haga clicy arrastrelo.
» Para eliminar el area seleccionada, pulse Supr.

» Paraescalar, rotar o sesgar la seleccion, utilice los controles alrededor del cuadro
delimitador de la seleccion.
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[ Rotar Sesgar I [ Escala I Sesgar LJ Rotar I
d-“—"— l— e

— (o)

M sesgar | Escala |[ Sesgar

Coémo recortar una sola linea

1. Enlabarrade herramientas de herramientas, seleccione la herramienta Cutter (Cuchilla) £ o
pulse Alt + T.

2. Enlavistade propiedades de la herramienta, en Cutter Tool Options (Opciones de herramienta de
cuchilla), seleccione el lazo

Se activan los modos Line Cutter Gesture (Gesto de cuchilla de linea).
3. Seleccione el modo Single Line Cutting Gesture (Gesto de corte de una sola linea) * .

4. Enlavistade escena o de camara, deslice la herramienta Cutter (Cuchilla) por el extremo de una
linea que desee recortar.

El extremo de la linea desaparece.

Antes
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Después

NOTA

Incluso si el gesto del ratén toca otras lineas, solo desaparece la primeralinea con la que la
herramienta Cutter (Cuchilla) entra en contacto.

46



Guia de introduccion de Harmony 22 Essentials

Coémo recortar varias lineas

1. Enlabarrade herramientas de herramientas, seleccione la herramienta Cutter (Cuchilla) = o
pulse Alt + T.

2. Enlavistade propiedades de la herramienta, en Cutter Tool Options (Opciones de herramienta de
cuchilla), seleccione el 1azo

Se activan los modos Line Cutter Gesture (Gesto de cuchilla de linea).

3. Enlavistade propiedades de la herramienta, seleccione Multiple Lines Cutting Gesture Mode
(Modo de gesto de corte de varias lineas) 5 .

4. Enlavistade escenao de camara, deslice la herramienta Cutter (Cuchilla) por el extremo de una
linea que desee recortar.

Los extremos de la linea desaparecen.

Antes

Después
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Capitulo 5: Como pintar

Toon Boom Harmony Essentials incluye algunas funciones de pintura muy Utiles para agregar color alos
dibujos. Mientras que otro software solo permite que los usuarios trabajen con muestras de color de una en
una, la pintura en Harmony se realiza con paletas que contienen varias muestras de color que se pueden
almacenar y reutilizar segun sea necesario.

00 L0 TG | i

En la vista de color, seleccione una muestra de color distinta para cada color que desee pintar en el dibujo.
Puede agregar todas las muestras de color que desee. También puede cambiar el nombre a las existentes 'y
modificarlas.

IHOOA00NNN
NORR0OgID

Cuando modifique el color de una muestra existente, se actualizardn automaticamente todas las zonas
pintadas con esta muestra en toda la escena. La muestra de color tiene un nimero de ID exclusivo que la
asocia con las zonas pintadas. De este modo, puede cambiar el aspecto del personaje en cualquier momento
sin necesidad de volver a pintarlo.
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Otra ventaja de este sistema es que puede crear paletas completas para distintas situaciones de luz. Por
ejemplo, ademas de la paleta habitual para un personaje, también puede tener una para ese personaje en la
[luvia con colores méas apagados y menos vivos que los colores de dias secos, o incluso otra para una escena
de noche. De este modo, el uso de paletas vinculadas a un personaje permite cambiar el color al instante para
ajustarse al climay al ambiente de la escena sin necesidad de volver a pintar cada elemento.

Paletas de colores

En animacion se utilizan colores especificos para pintar cada parte de cada personaje. Con el fin de mantener
una coherencia absoluta, se debe crear una paleta de colores base para cada personaje, prop y efecto de la
produccion. A esto se le denomina paleta maestra.

Las paletas maestras contienen una muestra de color para cada area que se deba colorear. Cada muestra
almacena un color de niveles precisos de rojo, verde, azul y opacidad (a este Gltimo se le denomina alfa).

El uso de una paleta de colores maestra tiene muchas ventajas, entre otras:
» Cada personaje conserva permanentemente sus colores especificos.
* No puede usar por error un color que no esté en la paleta maestra.
¢ Estandarizacion y uniformidad del color durante la produccion.
e Varios artistas pueden usar la misma paleta de colores y generar los mismos resultados.

Harmony utiliza paletas para mantener todos los colores necesarios para pintar los elementos, lo que permite
un control y uniformidad totales del proceso de pintado.

Una paleta se crea asignando un conjunto de colores a cada personaje, prop o efecto. Creara una nueva paleta
y agregara un nuevo color, conocido como muestra de color, para cada zona del personaje, como la piel, el
pelo, lalengua, la camiseta, los pantalones, etc.

Creacion de una nueva paleta

1. Enel menu de vistade color, seleccione Palettes > New (Paletas > Nueva) o haga clic en el botén
New Palette (Nueva paleta).

Se abre el cuadro de didlogo Create Palette (Crear paleta).

2. Introduzca el nombre de la paleta segun el modelo.

New Palette Name | New_Palette

oK Cancel

3. Hagaclicen OK (Aceptar).

La paleta aparece en lalista de paletas.
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Colour =%

[Adlw ]

Creacion o edicion de muestras de colores

1. Sideseacrear una nueva muestra de color, haga clic en el botén 4 Add Colour (Agregar color) en
la vista de color. Si desea editar una muestra de color existente, seleccione el color en la vista de
color.

2. Realice unade las siguientes acciones para editar la muestra de color:
e En el menu de vista de color, seleccione Colours > Edit (Colores > Editar).
e Hagadoble clic en lamuestra de color.

Se abre la ventana Coulour Picker (Selector de color).

Multi Wheel Mode

3. Paradefinir el color, realice una de las siguientes acciones:

« Seleccione Red (Rojo), Green (Verde), Blue (Azul), Hue (Matiz), Saturation
(Saturacion) o Value (Valor) para cambiar el espectro del circulo crométicoy, a
continuacién, haga clic en el color que desee en el circulo cromatico.

* Introduzcalos valores de matiz, saturacion, valor, rojo, verde y azul de forma manual
en los campos correspondientes. Todos los valores oscilan entre 0 y 255.
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NOTA

Si cambia una muestra de color después de haber dibujado o pintado con él areas de un
dibujo, todas las &reas pintadas con este color en los dibujos se actualizaran al nuevo color.

Pintado

Puede pintar las zonas cerradas de los dibujos con la herramienta Paint (Pintar).

Cbémo pintar dibujos

1. Enlavistade lineade tiempo o de carta de rodaje, seleccione el dibujo que desea pintar.

2. Enlabarrade herramientas de herramientas, seleccione la herramienta ® Paint (Pintar) o pulse
Alt + 1.

3. Enlavistade color, seleccione una paleta del personaje.

4. Seleccione un color de la paleta.

Scene Palettes

+ TOOMN

[Adlw ]

5. Enlavista de dibujo o de camara, comience a pintar el dibujo con los colores.
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NOTA

Al abrir una escena, las paletas de esta no se cargaran inmediatamente en la vista de color.
Primero debe seleccionar un dibujo.

Cierre de huecos

Al pintar, puede encontrar que algunas areas del dibujo no estaban completamente cerradas debido a
pequefios huecos en los contornos, lo que impide que la herramienta Paint (Pintar) rellene el area, ya que solo
rellena formas cerradas. Para cerrar la zona, puede dibujar una linea sobre el hueco con la herramienta Brush
(Pincel) o Pencil (Lapiz). Sin embargo, solo es posible cerrar el hueco agregando encima una linea invisible,
gue la herramienta Paint (Pintar) considerard como una linea normal. En Harmony, las lineas invisibles
utilizadas para definir las areas que se deben colorear se denominan lineas vectoriales transparentes.

La herramienta Close Gap (Cerrar hueco) permite cerrar pequefios huecos en el contorno de un dibujo
dibujando al instante una linea vectorial transparente pararellenar el hueco. A diferencia de la herramienta
Stroke (Linea vectorial transparente), con la herramienta Close Gap (Cerrar hueco) no tiene que dibujar con
precisién. Solo tiene que dibujar un trazo basico junto al hueco para que se cree automéaticamente unalinea
vectorial transparente recta que conecte directamente un extremo del hueco al otro.
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Uso de la herramienta Close Gap (Cerrar hueco)

1. Antesde trabajar con lineas vectoriales transparentes, se recomienda habilitar la opcién Show
Strokes (Mostrar lineas vectoriales transparentes), de modo que pueda verlas en la vista de dibujo
o0 de cAmara. Puede habilitar la opciébn Show Strokes (Mostrar lineas vectoriales transparentes)
realizando una de las siguientes acciones:

» En el mend superior, seleccione View > Show > Show Strokes (Ver > Mostrar >
Mostrar lineas vectoriales transparentes).

e Pulse K.
2. Realice unade las siguientes acciones:

e Enlabarrade herramientas de herramientas , seleccione la herramienta ( Close
Gap (Cerrar hueco).

» En el mend superior, seleccione Drawing > Drawing Tools > Close Gap (Dibujo >
Herramientas de dibujo > Cerrar hueco).

e Pulse Alt + C.
3. Enlavistade camara o de dibujo , trace unalinea invisible cerca del hueco que se va a cerrar.

El hueco se cierra automaticamente.

NOTA

La herramienta Paint (Pintar) también incluye una opcién Close Gap (Cerrar hueco), que se
puede habilitar en la vista de propiedades de la herramienta. Cuando esté habilitada,
Harmony intentara encontrar y cerrar automaticamente pequefios huecos cuando intente
rellenar una forma que no esté cerrada.
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Capitulo 6: Creacion de una animacion tradicional sin papel

Creacion de un boceto de animacion

El primer paso para crear una animacion sin papel es la creacién de un boceto, que es el esqueleto de la
animacion. Por lo general, empezaria animando la parte mas importante de la accidon de un personaje. Por
ejemplo, para animar un ciclo de andar, comenzara por el movimiento del torso y de las piernas. Después se
puede agregar una animacion secundaria como la cabeza, los brazos y laropa.

Para que la animacion sea satisfactoria, comience animando la accidn principal con esbozos basicos y rapidos
y, a continuacion, agregue los detalles cuando esté satisfecho con el movimiento. Si comienza a animar todos
los detalles inmediatamente, perdera mucho tiempo en caso de tener que realizar correcciones, y es probable
gue la animacién tenga una apariencia rigida.

Creacion de un boceto de animacion

1. Enlafilasuperior de lavista de linea de tiempo, haga clic en [g] Show All Thumbnails (Mostrar
todas las imagenes en miniatura) para habilitar el modo Thumbnail (Imagen en miniatura).

‘A
wOS AN

CEERT

2. Enlabarrade herramientas de herramientas, seleccione la herramienta »~ Brush (Pincel) o pulse
Alt + B.

3. Enlavistade color, seleccione un color para el pincel. Es una buena idea elegir un color claro para
el boceto de animacion. Esto facilitara el proceso de clean up, ya que las lineas oscuras y limpias
haran contraste con las lineas esbozadas claras.

55



Capitulo 6: Creacidn de una animacion tradicional sin papel

4. Enlavistade linea de tiempo o de carta de rodaje, seleccione la celda en la que desea que aparezca
el primer dibujo.

5. Enlavistade camara o de dibujo, dibuje el primer dibujo clave.

o

6. Aumente el nivel de zoom de la vista de linea de tiempo hasta que vea las imagenes en miniatura
dentro de las celdas realizando una de las siguientes acciones:

e Arrastre el control deslizante_ Timeline Zoom (Zoom de linea de tiempo) hacia
la derecha.

e Hagaclicen lapestafiade lavista de linea de tiempo y pulse 2 de forma reiterada.

e Mueva el cursor del raton en la vista de linea de tiempo, mantenga pulsado Ctrl
(Windows/Linux) 0 # (macOS)y gire larueda del ratdon hacia arriba.
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roSalM

7. Enlavistadelinea de tiempo o de carta de rodaje, seleccione la celda en la que desea que aparezca
el préximo dibujo clave.

8. Enlabarrade herramientas de herramientas, haga clic en el botén é Onion Skin (Papel cebolla).
Esto mostrara los dibujos anteriores y siguientes en un color claro en la vista de camara o de dibujo,
detras del dibujo actual, para que pueda utilizarlos como referencias pararealizar nuevos dibujos
con precision. Esta opcion puede ser Util para dibujar poses de descomposicion entre dos poses
clave, o para agregar un dibujo intercalado entre otros dos dibujos.

[ Intervalo de dibujos mostrados en papel cebolla l

9. Asegurese de que el papel cebolla muestre el primer dibujo clave para que pueda basar el segundo
dibujo clave en él. Parallevarlo a cabo, realice una de las siguientes acciones:

e Enlavistadelinea de tiempo, hagaclicy arrastre el marcador de papel cebollaroja
para que incluya los dibujos anteriores que desea mostrar en el papel cebollay, a
continuacion, haga clicy arrastre el marcador de papel cebolla verde para que incluya
los siguientes dibujos que desea mostrar en el papel cebolla.
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» Utilice los botones de la barra de herramientas sobre el espacio de dibujo para ajustar
la cantidad de dibujos anteriores y siguientes que se van a incluir en el papel cebolla:

e Para aumentar la cantidad de dibujos anteriores que se van a mostrar, haga clic
en el botén == Add Previous Drawing (Agregar dibujo anterior) en la barra de
herramientas de la vista de camara/dibujo.

» Parareducir la cantidad de dibujos anteriores que se van a mostrar, haga clic
en el boton = Remove Previous Drawing (Eliminar dibujo anterior) en la barra
de herramientas de la vista de camara/dibujo.

e Para aumentar la cantidad de dibujos siguientes que se van a mostrar, haga clic
en el botén % Add Next Drawing (Agregar dibujo siguiente) en la barra de
herramientas de la vista de cAmara/dibujo.

« Parareducir la cantidad de dibujos siguientes que se van a mostrar, haga clic
en el botén = Remove Next Drawing (Eliminar dibujo siguiente) en la barra de
herramientas de la vista de camara/dibujo.

[ Intervalo de dibujos mostrados en papel cebolla I
1

10. Cree un nuevo dibujo vacio mediante una de las siguientes acciones:

» Enlabarrade herramientas de linea de tiempo o de carta de rodaje, haga clic en el
boton ¥ Create Empty Drawing (Crear dibujo vacio).

e Pulse Alt + Mayus + R.

11. Enlavistade camara o de dibujo, dibuje el segundo dibujo clave.
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mo=al

13. Al usarlos marcadores de papel cebolla, aseglrese de que el papel cebolla cubratanto el primer
como el dltimo dibujo.

[ Intervalo de dibujos mostrados en papel cebolla ]

14. Cree un nuevo dibujo vacio mediante una de las siguientes acciones:

e Enlabarrade herramientas de linea de tiempo o de carta de rodaje, haga clic en el
boton ¥ Create Empty Drawing (Crear dibujo vacio).

e Pulse Alt + Mayus + R.

15. Enlavista de camara o de dibujo, dibuje la nueva pose.

16. Enlavistadelinea detiempo o de carta de rodaje, seleccione una nueva celday repita los pasos
anteriores para cada nuevo dibujo.
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NOTA

Al trabajar con capas de superposicion en la vista de cAmara, puede habilitar la opcion &
Current Drawing on Top (Dibujo actual encima) de la barra de estado debajo de la vista de
camara para hacer que la capa en la que esta trabajando aparezca sobre las otras capas.

Revision de la animacion

Al realizar un flipping por los dibujos se puede ver si los dibujos en los que se esta trabajando conectan bien
entre siy crean lailusion de movimiento adecuada. Puede desplazarse rapidamente por los dibujos con los
atajos de teclado parair al dibujo anterior e ir al dibujo siguiente.

Desplazamiento por los dibujos

1. Enlavistadelineadetiempo o de carta de rodaje, seleccione el dibujo desde donde desee
desplazarse.

2. Realice unade las siguientes acciones:
» Pulse Fparair al dibujo anterior.
e Pulse G parair al dibujo siguiente.

3. Pulse ambos atajos de forma reiterada con rapidez para desplazarse por los dibujos hacia atras o
hacia delante.

Cuando el boceto de animacién esté terminado, reprodizcalo para asegurarse de que es lo que se esperaba
antes de continuar con el siguiente paso.

Reproduccion de la animacion

1. Enlavistade lineade tiempo, haga clic en el botén del modo @ Solo alaizquierda de cada capa
que desee ver durante la reproduccion en la vista de linea de tiempo para habilitar el modo (®) Solo
en estas capas.

roSalM
[$]

Cuando una 0 mas capas tengan habilitado el modo Solo, Unicamente se mostraran las capas que
tengan este modo habilitado, y las otras capas quedaran ocultas.
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2. Enlavistade linea de tiempo, mueva el cabezal rojo al primer fotograma de la animacién y haga
clicen el botén Start (Iniciar) en la barra de herramientas de linea de tiempo. A continuacion,
mueva el cabezal al Gltimo fotograma de la animacion y haga clic en el botén Stop (Detener).

3. Enlabarrade herramientas de reproduccién, haga clic en el botén O Loop (Bucle) para habilitar la
opcién de bucle durante la reproduccion.

4. Enlabarrade herramientas de reproduccion, haga clic en el boton » Play (Reproducir) para
comenzar la reproduccion.

Limpieza

Unavez que se haya completado el boceto de animacion, es el momento de limpiarlo y tintarlo. A este paso
también se le denomina trazado. Consiste en trazar lineas sélidas y limpias sobre el boceto de animacién para
cerrar las zonas abiertas. Es el paso final de la animacion sin papel antes del paso de ink and paint.

En una animacién tradicional, los dibujos de clean up se suelen trazar en una nueva hoja de papel con el
boceto debajo, que se puede ver con la mesa de luz del disco de animacién. Del mismo modo, en Harmony,
tendra que agregar una nueva capa de dibujo en el dibujo donde desee dibujar dibujos de clean up. Cuando
haya terminado la limpieza, simplemente puede desactivar |la capa que contiene el boceto de animacién para
gue no aparezca en la animacion final. Este enfoque también permite mantener los bocetos y los dibujos de
clean up intactos y administrarlos de manera independiente.

En la vista de cAmara, veré el boceto de animacién mientras trabaja en la capa de clean up. Si prefiere trabajar
en lavista de dibujo, puede habilitar la mesa de luz para mostrar el boceto de animacién mientras realiza
trazados en la capa de clean up.

Trazado de la animacion en una nueva capa

1. Enlavistadelineadetiempo, cambie el nombre de la capa en la que creé el boceto de animacion
haciendo doble clic en su nombre e introduciendo el nuevo nombre, por ejemplo: "Boceto".
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2. Enlavistade linea de tiempo, agregue una capa realizando una de las siguientes acciones:

e Enlabarrade herramientas de capas de la vista de linea de tiempo, haga clic en el
bot6n 43 Add Drawing Layer (Agregar capa de dibujo).

e Pulse Ctrl + R (Windows/Linux) 0 8 + R (macOS).

Aparece el cuadro de didlogo Add Drawing Layer (Agregar capa de dibujo).

Add and Close

2. Enel campo Name (Nombre), escriba el nombre de la nueva capa, por ejemplo: "Clean-up".
3. Hagaclicen Add and Close (Agregar y cerrar) para agregar una nueva capay cerrar la ventana.

Se agrega alavista de linea de tiempo una nueva capa de dibujo.

4. Enlavistade linea de tiempo, haga clic en el icono Lock (Bloquear) de la capa que contiene el
boceto de animacién para impedir que dicha capa se pueda seleccionar en la vista de camara.

5. Enlavistadelinea de tiempo o de carta de rodaje, seleccione la celda de la nueva capa que
corresponda al primer dibujo clave del boceto de animacion.
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6. Enlabarrade herramientas de herramientas, seleccione una herramienta de dibujo, como la
herramienta # Pencil (Lapiz).

7. Enlavistade color, seleccione un color para trazar la animacion. Seleccione un color oscuro
intenso, como el negro, para asegurarse de conseguir un contraste adecuado con el color claro del
boceto de animacion.

8. Enlavistade camara o de dibujo, comience a trazar el primer dibujo clave.

NOTA

Si las capas de superposicion estan en medio, puede deshabilitarlas
temporalmente haciendo clic en su botén (€4 Enable/Disable
(Habilitar/deshabilitar) en la vista de linea de tiempo para que solo se muestren
el boceto de animacion y las capas de clean up.

9. Enlavistadelineadetiempo o de carta de rodaje, seleccione la siguiente celda que corresponde a
un boceto de dibujo.

10. Enlabarrade herramientas de herramientas, haga clic en el boton == Enable Onion Skin (Habilitar
papel cebolla) para habilitar el papel cebolla.

11. Asegurese de que el papel cebolla muestre el dibujo de clean up anterior realizando una de las
siguientes acciones:

» Enlavistade linea de tiempo, hagaclicy arrastre el marcador de papel cebollaroja
para que incluya los dibujos anteriores que desea mostrar en el papel cebollay, a
continuacién, haga clicy arrastre el marcador de papel cebolla verde para que incluya
los siguientes dibujos que desea mostrar en el papel cebolla.
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 Utilice los botones de la barra de herramientas sobre el espacio de dibujo para ajustar
la cantidad de dibujos anteriores y siguientes que se van a incluir en el papel cebolla:

» Para aumentar la cantidad de dibujos anteriores que se van a mostrar, haga clic
en el botén é Add Previous Drawing (Agregar dibujo anterior) en la barra de
herramientas de la vista de camara/dibujo.

» Parareducir la cantidad de dibujos anteriores que se van a mostrar, haga clic
en el boton = Remove Previous Drawing (Eliminar dibujo anterior) en la barra
de herramientas de la vista de cAmara/dibujo.

e Para aumentar la cantidad de dibujos siguientes que se van a mostrar, haga clic
en el boton <2 Add Next Drawing (Agregar dibujo siguiente) en la barra de
herramientas de la vista de camara/dibujo.

e Parareducir la cantidad de dibujos siguientes que se van a mostrar, haga clic
en el botén = Remove Next Drawing (Eliminar dibujo siguiente) en la barra de
herramientas de la vista de camara/dibujo.

12. Enlavistade camara, trace el siguiente dibujo.
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13. Repitalos pasos anteriores para cada dibujo.
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Capitulo 7: Importacion de imagenes

De forma predeterminada, Harmony trabaja con imagenes de vectores creadas dentro de su propia interfaz.
Las imagenes de vectores se componen principalmente de informacion sobre las distintas formas que
componen las imagenes, asi como de sus colores de lineay de relleno. Esto hace que sean faciles de editar y
pintar, y permite redimensionarlas sin que afecte a la calidad de laimagen. Por el contrario, las imagenes de
mapa de bits se componen de informacion de color sobre cada pixel individual que compone laimagen. Por lo
tanto, son méas adecuados para imagenes muy detalladas o realistas, pero no se pueden escalar sin perder
calidad de imagen.

Normalmente, es necesario trabajar con imagenes de mapa de bits si debe crear algunos de los recursos de
escena, como fondos o props, en un software diferente. A continuacién, puede importar los archivos de
imagenes de mapa de bits en su escena de Harmony.

Al importar unaimagen de mapa de bits, debe decidir como debe procesarla Harmony. Puede elegir entre las
siguientes opciones:

e Import as Bitmap (Importar como mapa de bits) : importa laimagen exactamente tal como estay
garantiza que no se pueda modificar cuando se trabaje en la escena. Esta opcién es Gtil para utilizar
fondos creados en el proyecto con un software diferente.

e Vectorize (Vectorizar) : convierte un mapa de bits en un dibujo vectorial de Toon Boom que se puede
pintar y editar facilmente con las herramientas de dibujo vectorial de Harmony. Esta opcién puede ser
util paralaimportacion de capa de lineas escaneadas o creadas con un software diferente.

Importaciéon de unaimagen de mapa de bits en su formato original

1. Realice unade las siguientes acciones:

e En el mend superior, seleccione File > Import > Images (Archivo > Importar >
Imagenes).

» Enlabarrade herramientas de archivo, haga clic en el botén ‘iz Import Images
(Importar iméagenes).

» Enlavistade carta de rodaje, haga clic con el boton derecho en cualquier parte del
area de fotogramas y seleccione Import > Images (Importar > Imagenes).

Se abre el cuadro de didlogo Import Images (Importar imagenes).

66



Guia de introduccion de Harmony 22 Essentials

Cancel

2. Enlaseccion Files (Archivos) del cuadro de dialogo Import Images (Importar imagenes), haga clic
en Brow se (Examinar) para buscar y seleccionar una o mas imagenes en el ordenador.

3. Agregue laimagen de mapa de bits a una nueva capa seleccionando la opcion Create Layer(s)
(Crear capas) y una de las siguientes opciones:

e Create Single Layer Named (Crear una sola capa con nombre): Crea una hueva capa
con el nombre especificado e importa las imagenes en ella.

» Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo):
Crea una capa basada en cada prefijo de nombre de archivo Unico. Por ejemplo, si
importa tres archivos llamados a-1.tga, a-2.tgay b-1.tga, se crearan dos capas, una
denominada "a" y otra denominada "b". La capa "a" contendra las dos primeras
imagenes, mientras que la "b" contendré la tercera.

e Addto a Existing Layer (Agregar a una capa existente): Importalas imagenes en la
capa especificada. Tenga en cuenta que solo puede importar en las capas que son
compatibles con las opciones de importacion. Por ejemplo, si va aimportar imagenes
como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

4. Enlaseccién Vectorization (Vectorizacion), asegurese de que la opcién Vectorize Image (Vectorizar
imagen) no esté marcada.

5. Hagaclic en OK (Aceptar).
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NOTA

De forma predeterminada, las imagenes de mapa de bits se mostraran en baja resolucion en la
vista de cadmara para evitar que afecten al rendimiento de la reproduccion. También puede
ajustar la calidad de visualizacién de unaimagen de mapa de bits seleccionandola con la
herramienta Transform (Transformar) y, a continuacién, abriendo el cuadro de didlogo Bitmap
Image Quality (Calidad de laimagen de mapa de bits) através de View > Bitmap File Quality
(Vista > Calidad del archivo de mapa de bits). También puede previsualizar laimagen de mapa
de bits en laresolucion de la escena activando el modo Render Preview (Vista de render)
en lavista de cAmara.

Vectorizacion de imagenes

Harmony permite importar imagenes como dibujos de vectores. Los dibujos de vectores se pueden pintar y
editar facilmente con las herramientas de dibujo de vectores de Harmony. Esto puede ser Gtil parala
importacion de capa de lineas escaneadas o creadas con un software diferente, ya que luego puede pintarla en
Harmony.

Importacion y vectorizacion de una imagen de mapa de bits

1. Realice unade las siguientes acciones:

» En el menu superior, seleccione File > Import > Images (Archivo > Importar >
Iméagenes).

e Enlabarrade herramientas de archivo, haga clic en el botén "z Import Images
(Importar imagenes).

» Enlavistade carta de rodaje, haga clic con el boton derecho en cualquier parte del
area de fotogramas y seleccione Import > Images (Importar > Imagenes).

Se abre el cuadro de didlogo Import Images (Importar imagenes).
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Cancel

1. Enlaseccion Files (Archivos) del cuadro de didlogo Import Images (Importar imagenes), haga clic
en Brow se (Examinar) para seleccionar una o méas imagenes del ordenador.

2. Seleccione el destino de las imagenes:

e Create Single Layer Named (Crear una sola capa con nombre): Crea una nueva capa
con el nombre especificado e importa las imdgenes en ella.

e Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo):
Crea una capa basada en cada prefijo de nombre de archivo Unico. Por ejemplo, si
importa tres archivos Ilamados a-1.tga, a-2.tgay b-1.tga, se crearan dos capas, una
denominada"a" y otra denominada "b". La capa "a" contendra las dos primeras
imagenes, mientras que la"b" contendra la tercera.

» Addto a Existing Layer (Agregar a una capa existente): Importalas imagenes en la
capa especificada. Tenga en cuenta que solo puede importar en las capas que son
compatibles con las opciones de importacion. Por ejemplo, si va aimportar imagenes
como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

3. Enlaseccién Vectorization (Vectorizacion), seleccione la opcion Vectorize Image (Vectorizar
imagen).

4. Seleccione unade las siguientes opciones:

e Colour (Color): Importa mapas de bits como objetos de vectores con su imagen como textura
de mapa de bits. El dibujo resultante se puede dibujar o borrar, pero no se puede volver a
pintar o ajustar.

e Black and W hite (Blanco y negro): Vectoriza los dibujos con una linea negra sélida. Crea un
dibujo 100 % basado en vectores y lo pinta con la muestra de color de la linea vectorizada a
partir de la paleta de la escena.
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5. Sihaseleccionado la opcién Black and W hite (Blanco y negro), establezca |os siguientes
parametros:

Parametro Descripcion

Determina qué valores de laimagen escaneada se
consideraran parte del dibujo, y qué se ignoraray eliminara
del dibujo vectorizado. Cuanto menor sea el valor, mas oscura
seralaimagen y viceversa.

Threshold (Umbral)

Determinala suavidad de las lineas. Cuanto menor sea el
Smooth (Suavizar) valor, mas detalle se conservara. Cuanto mayor sea el valor,
mas pulidas y facil de editar seran las lineas.

6. Hagaclicen OK (Aceptar).

Las imégenes vectorizadas apareceran en los destinos seleccionados.

NOTA

Si tiene imagenes de mapa de bits en la libreria, puede arrastrarlas y colocarlas directamente en la
escena como una manerarapida de importar unaimagen de mapa de bits. Sin embargo, no tendra
acceso atodas las opciones de importaciéon.
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Capitulo 8: Colocacion y animacion de capas

La configuracién de una escena se puede comparar con la construccion de la escenografia para un programa
de television. Este es el punto en el que coloca el elemento de escena, como el encuadre de camara, los
elementos de fondo y los personajes.

Colocacion de capas

El primer paso para configurar la escena es colocar cada capa en su posicion, angulo y tamafio iniciales. Puede
realizar cualquier tipo de transformacién geométrica en una capa con la herramienta .} Transform
(Transformar).

Paneo, rotacion, escala o sesgo de una capa con la herramienta Transform
(Transformar)

1. Enlabarrade herramientas de herramientas, seleccione la herramienta {.} Transform
(Transformar) o pulse Mayus + T.

2. Enlabarrade herramientas de herramientas, si esta habilitado el modo Animate Current Frame
(Animar fotograma actual) o g‘ﬁ Animate Onion Skin Range (Animar intervalo de papel cebolla),
haga clic en él para abrir el menu emergente Animate (Animar) y seleccione % Animate Off
(Animar desactivado).

3. Enlavistade propiedades de la herramienta, asegurese de que la opcion ~ Peg Selection Mode
(Modo de seleccidn de peg) esta deshabilitada.

4. Enlavistade camara o de linea de tiempo, haga clic en la capa que desea manipular para
seleccionarla.

CONSEXOS

» Sidesea seleccionar varias capas en la vista de camara, mantenga pulsado Mayus y
haga clic en cada capa que desee seleccionar.

» Sidesea seleccionar varias capas en la vista de linea de tiempo, mantenga pulsado
Ctrl (Windows/Linux) o # (macOS)y haga clic en cada capa que desee seleccionar.

» Sidesea seleccionar una serie contigua de capas en la vista de linea de tiempo,
mantenga pulsado MayuUs, haga clic en la primera capa que desea seleccionar y
luego en la dltima.
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Aparece un cuadro de control del manipulador alrededor de la capa seleccionada.

[ Escalar verticalmente ] [ Sesgar horizontalmente ]

Rotar

[ Escalar horizontal y verticalmente

Rotar

[ Sesgar verticalmente

[ Escalar horizontalmente

D—[ Escalar horizontal y verticalmente ]

—[ Sesgar verticalmente ]

. D—[ Escalar horizontalmente ]

—[ Punto de pivote ]

D—[ Escalar horizontal y verticalmente ]

[ Escalar verticalmente [ Sesgar horizontalmente ]

1. Realice unade las siguientes acciones:

« Mover: mueva el cursor por lailustracion. Cuando el cursor se convierta en ++, haga clicy

arrastrelo sobre lailustracién para moverla.

» Rotar: coloque el puntero fuera de una esquina del cuadro de limite. Cuando el cursor se
conviertaen ) , haga clicy arrastrelo para rotar.

ﬁ o

« Escalar: mueva el cursor sobre cualquiera de los puntos de control amarillos del cuadro del
manipulador. Cuando el cursor se conviertaen ", hagaclicy arrastre para escalar la capa.
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NOTA

Al realizar el escalado de la seleccion, puede mantener pulsado Mayus para
mantener las proporciones entre el ancho y la altura.

e Mueva el cursor sobre uno de los bordes verticales del cuadro del manipulador. Cuando el
cursor se convierta en 1L ,haga clicy arrastre hacia arriba o hacia abajo para sesgar la capa
en vertical.

* Mueva el cursor sobre uno de los bordes horizontales del cuadro del manipulador. Cuando el
cursor se conviertaen =, haga clicy arrastre hacia la izquierda o hacia la derecha para
sesgar la capa en horizontal.

Cambio de posicion del pivote

Las transformaciones realizadas sobre una capa de dibujo, tales como rotacién, escala, sesgo y volteo, se
realizan de formarelativa a la posicién del punto de pivote del dibujo. Por ejemplo, al rotar una capa, esta
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rotara alrededor de su punto de pivote, y al escalar la capa, se escalara como si su centro fuera realmente su
punto de pivote.

Mientras realiza transformaciones con la herramienta Transform (Transformar), puede arrastrar y colocar el
pivote de la seleccién. Sin embargo, esto no tiene un efecto permanente. Solo cambiara temporalmente la
posicion del pivote para que le ayude arealizar transformaciones en el fotograma seleccionado, pero el punto
de pivote real de la capa de dibujo permanecera igual.

Puede cambiar de forma permanente la posicion del punto de pivote de una capa utilizando una de las
herramientas de la barra de herramientas de animacién avanzada.

NOTA

Al mover de forma permanente el punto de pivote de una capa que ya estd animada, todas las
transformaciones realizadas en la capa en otros fotogramas clave se volveran a calcular de
acuerdo con la posicidn del nuevo punto de pivote. Por lo tanto, la animacién existente tendra una
apariencia completamente diferente, excepto en el fotograma actual. Es recomendable que
siempre se asegure de que el punto de pivote se encuentre en la posicion idénea antes de
comenzar la animacion.

Cambio de posicién permanente del punto de pivote de una capa

1. Enlabarrade herramientas de animacién avanzada, seleccione la herramienta i~ Translate
(Traslacion), (¥ Rotate (Rotar), 7] Scale (Escalar) o // Skew (Sesgar).

2. Realice unade las siguientes acciones:
« Enlavistade linea de tiempo, seleccione la capa a la que desee mover el pivote.

» Enlavistade camara, utilice Ctrl + clic (Windows/Linux) o 8 + clic (macOS) en la capa para
la que desea mover el pivote.

El punto de pivote @ aparece en la vista de camara.

3. Mueva el cursor sobre el punto de pivote. Cuando el cursor del ratén se convierta en 4—}; hagaclicy
arrastrelo al punto de pivote para cambiar de posicién.
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El punto de pivote de la capa ha cambiado de posicion. Sila capa se ha animado, su posicion se
desplazard por las escenas de formarelativa a la cantidad que acaba de desplazar el punto de
pivote.

Animacion de una capa

Puede animar una capa colocandola en diferentes posiciones, angulos y tamafios en distintos puntos alo largo
de lalinea de tiempo de la escena. Para ello, puede crear fotogramas clave de animacion en la capa. Un
fotograma clave registra las transformaciones geométricas en una capa en un punto especifico en el tiempo.
Cuando dos fotogramas clave de animacion se encuentren en una capa en diferentes puntos de lalineade
tiempo de la escena, Harmony interpolara automaticamente la posicion, el angulo y el tamafio de la capa en
cada fotograma entre esos dos fotogramas clave, creando una animacion.

Colocar en el segundo
fotograma clave

Colocaren el
primer fotograma
clave

| Colocar para cada fotograma intercalado ]

Animacion de una capa

1. Enlabarrade herramientas de herramientas, seleccione la herramienta i.! Transform
(Transformar) o pulse Mayus + T.

2. Enlabarrade herramientas de herramientas, si esté seleccionado el modo § Animate Off (Animar
desactivado) o gﬁ Animate Onion Skin Range (Animar intervalo de papel cebolla), haga clic en él
para abrir el menl emergente Animate (Animar) y seleccione < Animate Current Frame (Animar
fotograma actual).
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3. Silacapatiene un peg padre:

» Sideseaanimar en el peg en lugar de en la capa, asegurese de que el modo & Peg
Selection (Seleccién de peg) esté habilitado en la vista de propiedades de la herramienta.

» Sidesea animar directamente en la capa, asegurese de que el modo /x Peg Selection
(Seleccion de peg) esté deshabilitado en la vista de propiedades de la herramienta.

4. Enlavistade linea de tiempo, vaya al primer fotograma.

5. En el mend superior, seleccione Animation (Animacion) y asegurese de que la opcién Stop-Motion
Keyframe (Fotograma clave de Stop-motion) no estd marcada. De este modo, Harmony creard la
animacién automaticamente entre los fotogramas clave de la animacién que cree.

6. Seleccione la celda donde desee crear el primer fotograma clave.

7. Paracrear el primer fotograma clave, realice una de las siguientes acciones:

 Enlabarrade herramientas de linea de tiempo, haga clic en el botén ¢ Add Keyframe
(Agregar fotograma clave).

e Hagaclic con el boton derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

Se crea un fotograma clave en el primer fotograma de la vista de linea de tiempo.

Fotograma clave

8. Enlavista de camara, seleccione el elemento que desea animar y muévalo, rételo, escélelo o
sésguelo de modo que esté en su posicién de inicio correcta.
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10.

11.

12.

13.

En la vista de linea de tiempo, vaya al fotograma en el que desea establecer la segunda posicion.

rHOoO=am Layers Parameters

o

Seleccione la celda donde desee crear el segundo fotograma clave. clic con el botén derecho en la
seleccidn y seleccione Insert Keyframe (Insertar fotograma clave).

El segundo fotograma clave aparece en lalista de linea de tiempo, junto con unalinea desde el
primer fotograma clave al segundo fotograma clave. Esto indica que cada fotograma intercalado se
animard mediante Harmony.

IIIIIIIIIF__|—

[ Fotograma clave l

En la vista de camara, mueva, rote, escale o sesgue el elemento de modo que esté en su segunda
posicién correcta.

En lavista de linea de tiempo, seleccione el primer fotograma para retroceder al comienzo de la
animacion.

En la barra de herramientas de reproduccion, haga clic en el boton » Play (Reproducir) para
obtener una vista previa de la animacion.

NOTA

Si anima capas en el eje Z, puede que desee obtener una vista previa de las animaciones
desde las vistas superior o lateral durante la reproduccion. Sin embargo, la reproduccion esta
deshabilitada de forma predeterminada en esas vistas. Para habilitarlas, en el menua superior
seleccione Play > Enable Playback > Top View (Reproducir > Activar reproduccion > Vista
superior) o Side View (Vista lateral).
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Capitulo 9: Colocaciéon y animacion de la camara

En Harmony, puede animar objetos dibujandolos en su capa individual y colocandolos a continuacion en
distintas ubicaciones en diferentes fotogramas clave a través de la linea de tiempo para crear unaruta de
movimiento. Se puede aplicar el mismo principio a la cAmara de la escena, ya que se trata de una capa.
Adicion de una camara

De forma predeterminada, una escena no tiene capa de camara. Para poder ajustar el &ngulo de lacdmaray la

posicién de la escena, debe agregar una a su escena.

Adiciéon de una cAmara

1. Realice unade las siguientes acciones:

 Enlavistade lineade tiempo, hagaclic en el boton +, Add Layer (Agregar capa) del
menl emergente y seleccione Camera (Camara).

e En el mend superior, seleccione Insert > Camera (Insertar > Camara).

Se agrega a la escena una nueva capa de cAmaray aparece en la vista de linea de tiempo.

ro=al
o

o

Aunque es posible tener varias camaras en la misma escena, solo puede ver su escena utilizando las camaras
de unaen una. Esto puede resultar Gtil si ain esta trabajando en la composicion de escenay tiene distintas
configuraciones de camara para probar.

Cambio entre camaras

1. En el menu superior, seleccione Scene > Camera (Escena > Camara).

2. Entrelas camaras de lalista, seleccione la cAmara con la que desea trabajar.

Adicion de un peg padre

Aunque es posible colocar una camara sin necesidad de usar un rigging debajo de un peg, se recomienda
hacerlo siempre por dos motivos:

« Permite colocar, rotar y alejar o acercar la camara con la herramienta Transform (Transformar).

¢ Permite animar los movimientos de la cdmara. Sin un peg padre, la posicién, el angulo y el zoom de la
camara son estaticos.
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Adicion de un peg padre a una camara

1. Enlavistadelineadetiempo, seleccione la capa de camara.

2. Enlabarrade herramientas de capas, haga clic en el botén (% Add Peg (Agregar peg).

Aparece una capa de peg directamente sobre la capa de cAmaray se conecta a ella
automaticamente.

Colocacion de la camara

La accion de la escenatiene lugar dentro del encuadre de camara, de modo que es muy importante
configurarlo correctamente. Puede ajustar la resolucién de la camaray otros parametros relacionados en la
ventana Scene Settings (Configuracion de escena), a la que se puede acceder desde el menu principal de
Scene (Escena).

Para cambiar la posicién de la camara directamente, puede moverla con la herramienta .} Transform
(Transformar) o «I» Translate (Traslacion), puede rotarla con la herramienta (¥ Rotate (Rotar) y puede alejarla
o acercarla con la herramienta 7 Scale (Escalar) de la barra de herramientas de animacién avanzada.
También puede escribir sus coordenadas directamente en la vista de propiedades de capa. Si ha usado un rig
de camara debajo de un peg, puede aplicarle todo tipo de manipulaciones solo con la herramienta Transform
(Transformar). Los siguientes pasos indican como manipular la camara al usar un rig debajo de un peg.

Colocacién de una camara en la que se ha usado un rig debajo de un peg en la vista de
camara

1. Realice unade las siguientes acciones para seleccionar el peg padre de la camara.

e Enlavistade linea de tiempo, hagaclic en la capa del peg padre de la camara.

» Enlavistade camara, hagaclic en el encuadre de la camara. El encuadre de la cdmara es un
rectangulo fino alrededor de la etapa de la escena.

Aparece un cuadro de control alrededor del encuadre de la camara.
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i

Acercar o 0 o Acercar o
alejar alejar

Mover

Mover

Mover

0 [

Acercar o Acercar o

alejar = = alejar

2. Realice unade las siguientes acciones:

i

» Mover el encuadre de la cAmara: coloque el cursor sobre cualquiera de sus bordes o sobre
el centro. Cuando el cursor cambie a +}+, haga clicy arrastrelo en el encuadre de la camara
para cambiarlo de posicion.

e Acercar o alejar: coloque el cursor en una de las esquinas del encuadre de la camara.
Cuando el cursor cambie a ™ , haga clicy arrastrelo a la esquina para cambiar el tamafio del
encuadre de la cAmara. Al contraer el encuadre de la cAmara se acercara la escena, y al
expandirlo, se alejaré.
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» Rotar la camara: coloque el cursor fuera de una de sus esquinas. Cuando el cursor cambie a
W, haga clicy arrastrelo para rotar el encuadre de la camara.

Animacion de la cAmara

La camara de una escena se puede manipular y animar como cualquier otra capa. Se muestra en la vista de
linea de tiempo y puede utilizar las mismas herramientas y modos de seleccidn para compensarla o animarla.
Sin embargo, la capa de la camara en si es estéatica, lo que significa que mantiene la misma posicién y angulo
en toda la escena. Para poder animar la camara, es necesario conectarla a una capa de peg, que se puede
animar, y que afectara directamente ala posicion y al angulo de la camara.

Puede animar los movimientos de la cAmara directamente en la vista de camara.
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Animacién de la camara

1. Enlabarrade herramientas de herramientas, si esta seleccionado el modo $ Animate Off (Animar
desactivado) o gﬁ Animate Onion Skin Range (Animar intervalo de papel cebolla), haga clic en él
para abrir el menu emergente Animate (Animar) y seleccione <> Animate Current Frame (Animar
fotograma actual).

2. Enlabarrade herramientas de herramientas, seleccione la herramienta {.} Transform
(Transformar) o pulse Mayus + T.

3. Enellado derecho de lavista de linea de tiempo, en la capa de peg de cAmara, seleccione el
fotograma en el que desee que comience el movimiento de camara.

4. Realice unade las siguientes acciones para agregar un fotograma clave:

 Enlabarrade herramientas de linea de tiempo, haga clic en el botén ¢+ Add Keyframe
(Agregar fotograma clave).

» Hagaclic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).
e Pulse F6.

Aparece un fotograma clave en dicha celda. Los fotogramas que preceden a este fotograma clave
mantendran la misma posicion de camara que este fotograma clave.

ro=am

5. Enlavista de camara, manipule la camara para que esté en la posicion correcta cuando la camara
comience a moverse.
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6. Enlavistadelinea detiempo, hagaclic en la celda en la que terminara el movimiento de camara.

7. Realice unade las siguientes acciones:

* Enlabarrade herramientas de linea de tiempo, haga clic en el botén ¢+ Add Keyframe
(Agregar fotograma clave).

» Hagaclic con el botdn derecho y seleccione Add Keyframe (Agregar fotograma clave).
* Pulse F6.

Aparece un fotograma clave en dicha celda.

ro=al
o

L] | | S : an
o 2

8. Enlavista de camara, manipule la cAmara para que esté en la posicion correcta cuando la camara
termine de moverse.

9. Enlavistadelinea de tiempo, seleccione el primer fotograma para retroceder al comienzo de la
animacion.

83



Capitulo 9: Colocacién y animacion de la camara

10. Enlabarrade herramientas de reproduccién, haga clic en el botén » Play (Reproducir) para
obtener una vista previa de la animacion.
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Capitulo 10: Creacion de un rig de un personaje cut-out

En Harmony, un rig de personaje es basicamente una plantilla basada en el modelo del personaje, pero en la
cual todas las partes moviles estan divididas en distintas capas y ordenadas en una jerarquia que facilitala
animacioén digital, también conocida como animacion cut-out.

Pararealizar un rig de personaje, en primer lugar debemos asegurarnos de tener un modelo de personaje del
gue partir. Si tiene un dibujo de un personaje disponible, impértelo en una nueva escenay, a continuacion,
ajuste la escalay coloquelo a su gusto. De lo contrario, puede dibujar el modelo del personaje directamente en
Harmony. Una vez que tenga listo un modelo, podemos comenzar a descomponerlo en partes para crear el rig
con él.

Se pueden emplear muchas técnicas para descomponer una marioneta. En esta seccion, aprenderd uno de los
métodos mas comunes y sencillos. Para la primera descomposicién de personaje, siga estas instrucciones para
hacerse unaidea de como funciona Harmony. Una vez que conozca las funciones y comandos bésicos de
Harmony, podra crear sus propias técnicas para cumplir las necesidades de su produccién.

Dibujo de las piezas

Latécnica de descomposicion principal que se muestra es el trazado del modelo.

Descomposicion de un personaje mediante trazado

1. Enlavistade linea de tiempo, agregue una nueva capa de dibujo para cada parte del cuerpo que
desee separar. Puede pulsar Ctrl + R (Windows/Linux) o ¥ + R (macOS) para agregar nuevas
capas de dibujo.
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2. Enlavistadelinea de tiempo, seleccione la primera celda de la capa en la que desea dibujar la
parte.

3. Enlabarra de herramientas de herramientas, seleccione la herramienta de dibujo que desee.
Existen dos métodos que se suelen utilizar para dibujar las partes de un modelo de personaje cut-
out:

« Utilizar la herramienta # Pencil (Lapiz) y suavizar las lineas con la herramienta R
Smooth Editor (Editor suave).

« Utilizar la herramienta G Polyline (Polilinea). Este método permite dibujar con gran
precision, pero puede llevar mas tiempo.

Estos métodos garantizan que cada parte se realice con el menor niUmero de puntos posible, para
gue sean faciles de manipular, modificar o volver a dibujar.

4. Enlavistade color, seleccione una muestra de color. Si todavia no ha creado ninguna paleta para el
personaje, consulte Como pintar en la pagina 49.

5. Siprefiere trabajar en la vista de dibujo, realice una de las siguientes acciones para mostrar las
demas capas con colores descoloridos:

» Enlabarrade herramientas de la vista de dibujo, haga clicen el botén ¢ Light Table
(Mesa de luz).

e Pulse Mayus + L.

6. Enlavista de camara o de dibujo, dibuje la nueva parte.
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7. Sidesea cerrar unaforma abierta sin dibujar un contorno visible, puede dibujar una linea visible con
la herramienta (~ Stroke (Linea vectorial transparente).

NOTA

De forma predeterminada, las lineas vectoriales transparentes creadas con la
herramienta Stroke (Linea vectorial transparente) no son visibles. Para ver las lineas
vectoriales transparentes en el dibujo, seleccione View > Show > Show Strokes (Ver >
Mostrar > Mostrar lineas vectoriales transparentes) en el menu superior o pulse K.

8. Enlabarrade herramientas de herramientas, seleccione la herramienta ® Paint (Pintar) o pulse
® Paint Unpainted (Pintar area no pintada) para colorear el dibujo.

9. Enlavistade color, cree el color de relleno deseado si no se encuentratodaviaen la paletay, a
continuacion, seleccionelo.

10. Enlavistade camara o de dibujo, pinte el dibujo.
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11.

12.

En la barra de herramientas de herramientas, seleccione la herramienta X Select (Seleccionar).
Seleccione el dibujo y acople las lineas haciendo clic en el botéon == Flatten (Acoplar) de la vista de
propiedades de la herramienta.

Repita todo el proceso para cada parte del cuerpo que desee que se pueda animar.

ot
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Adicion de pegs

Los pegs son un tipo especial de capa que no contiene ningun dibujo. Solo se utilizan para compensar y
transformar dibujos que estén debajo de su jerarquia, sin transformar directamente los dibujos.

Al crear un rigging o configurar una escena, se recomienda emparentar pegs a cada una de las capas de dibujo.
De este modo, se permite mantener los fotogramas clave y los dibujos de animacion en capas separadas, |o
que facilita el trabajo sobre la posicién y exposicion de las capas de dibujo por separado en la vista de lineade
tiempo. También facilita la creacion de una jerarquia de las partes del cuerpo que se pueden animar juntas 'y
por separado.

Contiene las animaciones de posicidn, rotacion y
escala del elemento.

e S VAR A

1

Contiene los dibujos reales, los fotogramas en los que se exponeny
cuéntos fotog SEe expanen.

Si desea animar solo sobre pegs, puede activar el modo Peg Selection (Seleccion de peg) de la herramienta
Transform (Transformar) en la vista de propiedades de la herramienta. También puede deshabilitar las capas
de dibujo de animacion para que solo se puedan animar los pegs.

NOTA
También es posible hacer que una capa de dibujo sea padre de otra capa de dibujo. Al igual que la

forma de animacion de un peg anima sus capas hijas, la animacién de una capa de dibujo con hijos
también animard sus capas hijas. Ambas capas seguiran apareciendo en la animacion.

Como emparentar pegs a las capas en la vista de linea de tiempo

1. Enlavistade lineadetiempo, seleccione todas las capas.

+
|
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2. Enlabarrade herramientas de capa de linea de tiempo, haga clic en el boton (- Add Peg (Agregar
peg) para agregar un peg padre a todas las capas seleccionadas.
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+ [ )

Creacion de una jerarquia de capas

Harmony permite crear el rig en una jerarquia elaborada, lo que permite a su vez establecer qué partes del rig
deben influir en otros miembros y como pueden moverse de forma independiente. Por ejemplo, al crear un
rigging del brazo de un personaje simple, puede hacer que la capa del antebrazo sea hija de la capa del brazo,
y que la capa de la mano sea hija de la capa del antebrazo. De esta manera, si el personaje mueve el
antebrazo, la mano también lo hard, y si mueve el brazo, el antebrazo y la mano también lo haran.

Jerarquia de brazo Y Jerarquia de brazo
derecho feje izquierdo

Jerarquia de pierna

Jerarquia de pierna
derecha ) P

= izquierda

Al crear un rig de personaje basico, debe tener al menos una jerarquia para cada brazo y cada pierna. Puede
crear una jerarquia que vaya desde el torso, el cuello y la cabeza, y crear un rig de los brazos al torso y otro de
las piernas alas caderas. Esto crearia una jerarquia como esta:
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Creacion de una jerarquia en la vista de linea de tiempo

1. Enel areaizquierda de lavista de linea de tiempo, seleccione la capa que desee que sea la capa
hija.

2. Arrastre el hijoy coléguelo sobre la capa que desee que sea la capa padre. Asegurese de no
colocar la capa hija entre dos capas.

3. Repita el proceso hasta que haya creado una jerarquia que manipule todas las partes del personaje,
con un peg maestro en laraiz. Al crear un rig, si desea que varias capas tengan un padre comun,
pero ninguna de las partes existentes del rigging puede servir como dicho padre, cree un nuevo peg
y anide esas capas debajo de dicho peg.

+
+
+
+
+
e
+
+

NOTA

En lavista de linea de tiempo, puede desconectar una capa de su capa padre manteniendo
presionada la tecla Mayus, arrastrando la capa padre lejos de la capa hijay colocandola en
cualquier lugar de la lista.
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Al crear un rigging, tenga en cuenta que el orden de las capas en la vista de linea de tiempo afecta al orden en
gue se representan. Las capas de la parte superior de lalista se representaran sobre las capas de la parte
inferior de la lista. Si tiene que cambiar el orden de una capa durante la animacién, puede realizar un
desplazamiento pequefio de la posicion de esta capa sobre el eje Z para anular el orden de lacapay forzarlaa
aparecer debajo o sobre otras capas.

Desplazamiento pequefio de una capa sobre el eje Z

1. Enlabarrade herramientas de herramientas, seleccione la herramienta i.} Transform
(Transformar).

2. Enlavistade linea de tiempo, de nodos o de camara, seleccione la capa que desea desplazar.

3. Sihaseleccionado la capaen lavista de linea de tiempo o de nodos, haga clic en la pestafia de la
vista de camara para establecer el enfoque en esta vista.

4. Realice unade las siguientes acciones:

e Pararealizar un desplazamiento pequefio de la capa hacia delante, pulse Alt + flecha
abajo.

» Pararealizar un desplazamiento pequefio de la capa hacia atras, pulse Alt + flecha
arriba.

Peg maestro

El rig del personaje siempre debe tener un peg maestro que se conecta a todas sus partes. El peg maestro
permite manipular todo el rig desde una Unica capa, sin necesidad de manipular cada parte individual. Esto es
Gtil para colocar y escalar el personaje en relaciéon a la escena, asi como para animar la trayectoria del
personaje cuando tiene que moverse entre las areas de la escena.
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Adicion de un peg maestro en la vista de linea de tiempo

1. Enlavistade linea de tiempo, seleccione la capa superior.
2. Enlavistade linea de tiempo, haga clic en el boton (% Add Peg (Agregar peg).

Se agrega a la linea de tiempo un nuevo peg al que queda emparentada la capa seleccionada.
3. Asigne el nombre Master mas el nombre del personaje al nuevo peg.

4. Enlavistade linea de tiempo, seleccione todas las capas que desee conectar al nuevo peg.
Recuerde que la capa superior ya es un hijo del peg, asi que no lo incluya en |la seleccion.

5. Arrastre la seleccion SOBRE |la capa del peg para emparentar todas las piezas del personaje al
peg. Si se agregan capas encima de las capas que ya tienen padres, mueva dicha capa con padres
de nuevo a la parte superior de la pila de capas.

+
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Capitulo 11: Animacion de un personaje cut-out

Harmony ofrece herramientas muy Utiles para animar modelos de personajes cut-out. Con la herramienta
Transform (Transformar), puede mover las partes del personaje para crear poses clave, mientras que Harmony
crealos intercalados. El tiempo del movimiento se puede ajustar para crear movimientos realistas y los dibujos
de las partes del personaje se pueden intercambiar en cualquier punto de la animacion con objeto de permitir
combinar los cambios del movimiento y del dibujo para crear animaciones cut-out perfectamente ajustadas.

Creacion de una animacion cut-out simple

Crearemos una animacion cut-out simple realizando la primera pose del personaje en el primer
fotograma, la segunda pose en el siguiente fotograma y permitiendo que Harmony las interpole.

1. Enlavistade lineadetiempo, contraiga el personaje con la flecha Expand/Collapse
(Expandir/Contraer).

3. Paragarantizar que el modelo no desaparezca después de 1 fotograma, abra el cuadro de didlogo
Extend Exposure (Extender exposicion) realizando una de las siguientes acciones:
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» Hagaclic con el botén derecho en el primer fotograma de la vista de linea de tiempo y
seleccione Extend Exposure (Extender exposicion).

e Pulse F5.

4. Enel cuadro de dialogo Extend Exposure (Extender exposicién), escriba el nimero de fotogramas
de la escenay confirme. De este modo, el modelo quedara expuesto (sera visible) en toda la
escena.

5. Ahora crearemos la primera pose del personaje. En primer lugar, asegurese de que haya un
fotograma clave en el primer fotograma de cada capa del modelo. Con ello garantiza que cuando
cree la segunda pose mas tarde, la primera pose no se verd afectada. Para llevarlo a cabo, realice
una de las siguientes acciones:

 Enlabarrade herramientas de linea de tiempo, haga clic en el bot6n (¢ Add Keyframe
(Agregar fotograma clave).

» Hagaclic con el boton derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

Se agrega un fotograma clave al fotograma actual.

6. Enlabarrade herramientas de herramientas, seleccione la herramienta i.} Transform
(Transformar) o pulse Mayus + T.

7. Enlabarrade herramientas de herramientas, si esta seleccionado el modo $ Animate Off (Animar
desactivado) o gﬁ Animate Onion Skin Range (Animar intervalo de papel cebolla), haga clic en él
para abrir el menl emergente Animate (Animar) y seleccione <> Animate Current Frame (Animar
fotograma actual).

8. Enlavistade camara, seleccione las partes que desea animar. El cuadro de control de la
herramienta Transform (Transformar) aparecera alrededor de la capa seleccionada. Cada parte del
cuadro de control de la herramienta Transform (Transformar) se puede usar para realizar distintos
tipos de transformaciones:
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9. Utilice laherramienta | Transform (Transformar) para rotar, sesgar, escalar o trasladar la
seleccién a su nueva posicion.

10.

11.

12.

13.

Repitalo en otras partes del modelo del personaje hasta que la primera pose haya terminado.

En la barra de herramientas de herramientas, active la funcién é Onion Skin (Papel cebolla).

En lavista de linea de tiempo, seleccione el fotograma donde desee tener la segunda pose.

Cree un fotograma clave para la segunda pose realizando una de las siguientes acciones:

« Enlabarrade herramientas de linea de tiempo, haga clic en el botén ¢ Add Keyframe

(Agregar fotograma clave).

» Hagaclic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

Pulse F6.
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El segundo fotograma clave aparece, junto con una linea desde el primer fotograma clave al
segundo fotograma clave. Esto indica que cada fotograma intercalado se interpolard mediante
Harmony.

Si no aparece ninguna linea, significa que se ha creado el primer fotograma clave como un
fotograma clave de Stop-motion. Para resolverlo, realice una de las siguientes acciones:

e Hagaclic con el botén derecho en el primer fotograma clave y seleccione Set Motion
Keyframe (Definir fotograma clave de movimiento).

» Seleccione el primer fotograma clave y pulse Ctrl + K (Windows/Linux) o # + K (macQOS)

Para asegurarse de que los nuevos fotogramas clave se establezcan en Motion (Movimiento) de
forma predeterminada, seleccione Animation (Animacién) en el menu superior y aseglrese de que
la opcion Stop-Motion Keyframe (Fotograma clave de Stop-motion) no esté activada.

NOTA

Cada fotograma clave puede ser un fotograma clave de movimiento o un fotograma
clave de Stop-motion. Los fotogramas entre dos fotogramas clave estan interpolados
por Harmony si el primero de los dos fotogramas clave es un fotograma clave de
movimiento.

14. Enlavistade camara, cambie de nuevo la pose del personaje.

—

a

Capm
seleccionady

15. Repita este proceso paratodas las poses que desee agregar a la animacion.
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Ajuste de la velocidad de la animacion

1. Enlavistade lineade tiempo, contraiga la jerarquia del rig (o de la parte del rig) ala que desea
aplicar una velocidad.

NOTA

Cuando se aplica una velocidad a una capa con hijos y se contrae la jerarquia de esta
capa, lavelocidad se aplica a esa capay atodos sus hijos.

2. Seleccione uno de los fotogramas clave de la animacion.

NOTA

Solo debe seleccionar un fotograma clave. El cuadro de dialogo Set Ease for Multiple
Parameters (Definir aceleracion para varios parametros) solo puede editar la
aceleracion en un fotograma clave ala vez, pero también le permite saltar rapidamente
entre fotogramas clave en la linea de tiempo.

3. Realice unade las siguientes acciones:

e Enlavistade linea de tiempo, haga clic con el botdn derecho y seleccione Set Ease
For Multiple Parameters (Definir aceleracion para varios pardmetros).

» Enlabarrade herramientas de linea de tiempo, haga clic en el botén =~ Set Ease For
Multiple Parameters (Definir aceleracion para varios parametros).
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Se abre el cuadro de didlogo Set Ease For Multiple Parameters (Definir aceleracién para varios

parametros).
=
Editor de -
Bézier | =
[

Apply

4. En el editor de Bézier, haga clicy arrastre el controlador Bézier para ajustar la velocidad de los
fotogramas clave seleccionados.

Controladores

5. También puede ajustar la velocidad introduciendo valores en los campos Time Ratio (Ratio de
tiempo) y Value Ratio (Ratio de valor) debajo del editor de Bézier. Los valores se calculan como un
porcentaje.

e Enlos campos Left Time Ratio (Ratio de tiempo izquierdo) y Right Time Ratio (Ratio de
tiempo derecho), escriba el valor como porcentaje correspondiente al tiempo que desea que
dure la velocidad. Las curvas Bézier se alejaran horizontalmente de su fotograma clave. El
valor debe estar entreel 0 % y el 100 %.

» Enlos campos Left Value Ratio (Ratio de valor izquierdo) y Right Value Ratio (Ratio de
valor derecho), escriba el valor como porcentaje correspondiente a la cantidad de sesgo que
desea que tenga la velocidad. La curva Bézier se movera verticalmente hacia el fotograma
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clave mas cercano si el valor es positivo o lejos del fotograma clave mas cercano si su valor
es negativo. El valor debe estar entreel 0 % y el 100 %.

6. Paraaplicar estos parametros de velocidad Unicamente a un tipo de funcion determinado, como
Rotation (Rotacion) o Scale (Escala), en la seccién Filters (Filtros), anule la seleccion de los tipos de
funcion alos que no desee que se apliquen.

Motion (Movimiento): aplica los pardmetros de velocidad a las funciones Position X
(Posicion X), Position Y (Posicién YY), Position Z (Posicion Z) y 3D Path (Ruta 3D)
seleccionadas.

Rotation (Rotacion): aplica los parametros de velocidad a las funciones de angulo
seleccionadas.

Scale (Escala): aplica los parametros de velocidad a las funciones de escala
seleccionadas.

Skew (Sesgar): aplica los parametros de velocidad a las funciones de inclinacion
seleccionadas.

Morphing: aplica los pardmetros de velocidad a las funciones de velocidad de
morphing seleccionadas. Tenga en cuenta que Morphing solo esté disponible
en Harmony Advanced y Harmony Premium.

Other (Otras): aplica los pardametros de velocidad a todas las demés funciones
seleccionadas, como todas las funciones creadas para animar parametros de efecto.

7. Hagaclicen uno delos siguientes botones:

Apply/Previous (Aplicar/anterior): aplica los pardmetros de velocidad al fotograma
clave seleccionado y, a continuacion, salta al fotograma clave anterior de lalinea de
tiempo para que después pueda ajustar su velocidad.

Apply (Aplicar): aplicalos parametros de velocidad al fotograma clave seleccionado.

Apply/Next (Aplicar/siguiente): aplica los parametros de velocidad al fotograma
clave seleccionado y, a continuacion, salta el siguiente fotograma clave de la linea de
tiempo para que después pueda ajustar su velocidad.

Close (Cerrar): cierra el cuadro de dialogo. Si no ha aplicado las modificaciones, se
cancelaran

Desplazamiento por las capas

Dado que la animacién cut-out normalmente implica modelos complejos con amplias jerarquias, aprender los
atajos para desplazarse facilmente entre las capas puede ahorrar mucho tiempo.

Un truco de gran utilidad para aprender es el comando Centre on Selection (Centrar en seleccion), junto con su
atajo de teclado. Este comando permite desplazarse directamente a la capa seleccionada en la vista de linea
de tiempo. Por lo tanto, puede usar |la vista de camara para seleccionar de forma visual la capa con la que
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desee trabajar y, a continuacion, usar el atajo de Centre on Selection (Centrar en seleccion) para encontrar la
capaen lavista de linea de tiempo, en lugar de revisar la estructura de la escena para localizarla.

Centrado en la seleccion actual en la vista de linea de tiempo

1. Enlavistade lineadetiempo, contraigatodas las capas.

2. Enlabarrade herramientas de herramientas, seleccione la herramienta {.} Transform
(Transformar).

3. Enlavistade camara, seleccione una capa.
4. Realice unade las siguientes acciones:

e Hagaclicen la pestafia de lavista de linea de tiempo para ajustar el centrado en la
mismay, a continuacion, pulse O.

» Enlabarrade herramientas de la vista de linea de tiempo, haga clic en el botén
Centre on Selection (Centrar en seleccion).

Lavista de linea de tiempo esta ahora centrada en la capa seleccionada y todos sus padres se han
expandido automaticamente.

Si desea usar el atajo de teclado con frecuencia, le puede parecer tedioso tener que hacer clic en la pestafia de
vista de linea de tiempo cada vez. Para resolverlo, puede habilitar la preferencia Focus On Mouse Enter
(Centrarse en ratén). Ajustara el centrado en una vista en cuanto el cursor del ratén entre en ellay hara
funcionales al instante todos los atajos de teclado de esta vista.

Activacion de |la preferencia Focus On Mouse Enter (Centrarse en raton)

1. En el menu superior, vaya a Edit > Preferences (Editar > Preferencias) (Windows) o Harmony
> Preferences (Harmony > Preferencias) (macOS).

2. Abralapestafia General.

3. Enlaseccién Options (Opciones), active la casilla de verificacion Focus On Mouse Enter (Centrarse
en raton).

4. Hagaclic en OK (Aceptar).

Los atajos de teclado para vistas especificas funcionaran en cuanto el cursor del ratén entre en la
vista prevista.

Harmony también tiene comandos y atajos de teclado para cambiar rapidamente la seleccion de la capa
seleccionada actualmente a su padre o hijo, permitiendo asi el desplazamiento con rapidez por la jerarquia del
personaje.
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Seleccion del padre o del hijo de |a capa seleccionada

1. Enlabarrade herramientas de herramientas, seleccione la herramienta .} Transform
(Transformar).
2. Enlavistade propiedades de la herramienta Transform (Transformar), aseglrese de que esté

desactivado el modo . Peg Selection (Seleccion de peg).

3. Enlavistade camara o de linea de tiempo, seleccione una capa u objeto conectado a una jerarquia.

o)

~yU

v

4. Realice unade las siguientes acciones:
» Seleccione Animation > Select Parent (Animacién > Seleccionar padre) o pulse B para
seleccionar la capa padre.

» Seleccione Animation > Select Child (Animacién > Seleccionar hijo) o pulse Mayus + B para

seleccionar la capa hija.

— 2
™ A’
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Y
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NOTA

Al subir o bajar la jerarquia de nodos, estos atajos de teclado omiten cualquier nodo de efecto
de lajerarquiay solo seleccionan peg o nodos de dibujo. Esto se debe a que estos atajos se
optimizan parala animacién cut-out. En el cuadro de didlogo Keyboard Shortcuts (Atajos de
teclado), en la seccion General, estos atajos de teclado se denominan Select Parent Skipping
Effects (Seleccionar efectos de omisién del padre) y Select Child Skipping Effects
(Seleccionar efectos de omision del hijo). Si desea utilizar los atajos de teclado para navegar
por la jerarquia sin omitir los nodos de efectos, puede asignar atajos de teclado
personalizados para los comandos Select Parent (Seleccionar padre) y Select Child
(Seleccionar hijo).
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Capitulo 12: Uso de deformadores

Los deformadores permiten animar objetos y partes de un modelo de personaje mediante las deformaciones
generadas por ordenador. Las deformaciones funcionan mediante la creacion de puntos de control en un
dibujo. Al mover dichos puntos, el dibujo se dobla o distorsiona de modo que las partes del dibujo que estan
vinculadas a un punto de control siguen dicho punto al lugar donde lo posicione.

Los deformadores pueden aumentar considerablemente el rango de movimientos y animaciones que el rig de
un personaje cut-out sea capaz de realizar sin necesidad de dibujar nuevas poses o recurrir a la animacion
fotograma a fotograma. Un personaje cut-out en rig con deformaciones se puede animar de una forma que se
asemeje alafluidez y flexibilidad de la animacion tradicional. Ademas, los deformadores se pueden utilizar
para modificar, mejorar o facilitar la animacién fotograma a fotograma cuando sea necesario.

Los deformadores funcionan al crear un rigging con ellos en la parte del cuerpo que desee deformar, crear una
estructura de deformacion y, a continuacién, animarlo. Se puede realizar facilmente con la herramienta {T

Rigging.
Hay dos tipos de deformadores disponibles en Harmony Essentials:
e Hueso

* Hueso parajuego

Deformador de huesos

La deformacion de hueso permite crear una estructura similar al hueso en la que cada parte es sélida, pero las
articulaciones son flexibles. Esto es sobre todo Util parala animacién de los miembros de un personaje, como
los brazos o las piernas, u otras partes que se puedan articular, como torsos o dedos.

Por ejemplo, se puede utilizar una deformacién de hueso para articular un brazo que esta hecho de un solo
dibujo, de modo que el brazo y el antebrazo se puedan mover de forma independiente, sin necesidad de
dibujar la parte superior del brazo y el antebrazo en capas diferentes. Harmony deformaré el dibujo para que
parezca que esta articulado. Las distintas partes de una deformacion de hueso se pueden rotar alrededor de su
articulacion, extenderse y acortarse, proporcionandole las mismas capacidades que las articulaciones de
animacion en distintas capas, sin tener que preocuparse por la separacion de piezas, puntos de pivote o recorte
de contornos.
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Punto de desplazamiento

Radio de articulacidn )
.;od—/

Articulacién

Deformador de hueso para juego

La deformacion de hueso para juego es parecida a la deformacion de hueso. Le permite crear estructuras
compuestas de puntos, que representan las articulaciones, y segmentos de lineas rectas vinculando dichos
puntos que representan los huesos. La deformacion de hueso para juego es diferente, ya que se optimiza para
motores de juego como Unity. Por lo tanto, generalmente solo se usa para personajes animados destinados a
importarse en juegos de Unity y no para producciones de animacion.

A diferencia de las deformaciones de hueso, las deformaciones de hueso para juego no tienen una propiedad
de sesgo. Los pliegues de la articulacion también parecen ligeramente mas redondos.

Punto de desplazamiento

Radio de articulacicn - /

Articulacién

Creacion de deformadores

La manera mas sencilla de crear deformadores es usar la herramienta {T Rigging, disponible en la barra de
herramientas de deformacién. Con esta herramienta, todo lo que necesita hacer para crear un deformador es
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seleccionar la capa que desee deformar y, a continuacion, colocar cada punto del deformador en la vista de
camara.

Los deformadores existen en la escena como una jerarquia de capas de deformacién. Cuando crea un nuevo
deformador, el primer punto que define es la raiz del deformador y cada punto nuevo que crea es un hijo del
punto anterior. Por lo tanto, los deformadores se crean en una cadenay se deben crear teniendo en cuentala
jerarquia del personaje. Por ejemplo, si crea un deformador para un brazo, la raiz debe ser la articulacion del
hombro, el segundo punto debe ser el codo y el tercero, la mufieca.

Un deformador afecta a todas las capas que hay debajo de su jerarquia. Al crear un nuevo deformador
utilizando la herramienta Rigging, se crea automaticamente como padre de la capa seleccionada, y afectara a
la capa seleccionada y atodos sus hijos. Por lo tanto, es importante seleccionar la capa correcta antes de
intentar crear un deformador.

Por ejemplo, si se desea crear un deformador para un brazo y el brazo se divide en varias capas, se puede crear
un rig del brazo en una jerarquia donde el brazo superior sea laraiz, el antebrazo sea el hijo del brazo superior
y lamano sea el hijo del antebrazo. A continuacion, si crea su deformador en la parte superior del brazo, se
creara como padre de la parte superior del brazo y, por lo tanto, afectara atodo el brazo.

También puede agrupar varias capas debajo de un peg y crear su deformador con este peg seleccionado. Al
crear un deformador en un peg, el deformador se crea como un hijo del peg, pero como padre de todos los
hijos de este peg. Esto se debe a que es probable que un peg sea mas util sobre un deformador que debajo de
él. Si mueve las capas que estan debajo de un deformador, saldran de la zona de deformacion previstay
pueden aparecer muy deformadas y distorsionadas. Por lo tanto, es mejor crear todas las deformaciones
posibles debajo de los pegs, y los pegs que estén debajo de los deformadores solo deben animarse si el
deformador se queda intacto. Dado que el deformador se creara como padre de todos los hijos del peg,
afectara atodas las capas que haya debajo de este.

Creacion de un deformador de hueso

1. Unavez seleccionado el elemento, seleccione la herramienta §T Rigging en la barrade
herramientas de deformacién.

2. Enlavista de propiedades de la herramienta, habilite el modo 4 Bone (Hueso).
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3. Hagaclicen el lugar donde desee crear la articulacion de raiz de la estructura ésea. La articulacién
de raiz deberia ser la que esté vinculada al resto del cuerpo. Por ejemplo, en un brazo, la
articulacion de raiz seria el hombro.

4. Hagaclicen el lugar donde desee crear la segunda articulacién.

Se creard un hueso entre la primera y la segunda articulacion.

Observe que, al crear un nuevo punto, el anterior aparece ahora rodeado por un circulo. Se trata del
radio de la articulacion, lo que permite determinar qué cantidad de dibujo debe formar parte de la
articulacion. Cada punto de un deformador de hueso, a excepcion del primero y del Ultimo, cuenta
con un radio.

6. Hagaclicy mantenga pulsado el punto de control del radio de la articulacién anterior y ajuste el
radio de la articulacion de modo que cubra la articulacion correctamente.

7. Repitael proceso hasta que hayaterminado de crear la cadena de huesos. Asegurese de crear cada
articulacion en el orden correcto desde la raiz hasta la extremidad.
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Visualizacion de deformadores

Harmony permite controlar qué deformadores se muestran en la vista de camaraindependientemente de la
seleccién actual. Al crear una cadena de deformacion, sus controles de deformacién se muestran en la vista de
camara. Sin embargo, si selecciona un deformador existente o una capa que esté conectada a deformadores
existentes, sus controles de deformacion no se mostraran automaticamente. Asimismo, al desactivar una
cadena de deformacién no se ocultaran sus controles de deformacién.

Para poder animar o modificar una cadena de deformacién existente, debe mostrarla de forma manual.

Visualizacion de los controles de deformacion

1. Realice unade las siguientes acciones:

» Enlavistade camara o de linea de tiempo, seleccione una de las capas de dibujo vinculadas
ala cadena de deformacion que desee visualizacion.

e Enlavistadelinea de tiempo, seleccione cualquier parte de la cadena de deformacion que
desee visualizacion.

2. Enlabarrade herramientas de deformacion:

» Hagaclicen el boton Show the Selected Deformation Chain and Hide All Others (Mostrar la
cadena de deformacién seleccionaday ocultar el resto) © para mostrar la cadena de
deformacién del elemento seleccionado y ocultar cualquier otra cadena de deformacién que
se muestre.

» Hagaclic en el botén Show Selected Deformers (Mostrar deformadores seleccionados) 2
para mostrar la cadena de deformacion del elemento seleccionado junto a cualquier otra
cadena de deformacién que se muestre.

Los controles de deformacién aparecen en la vista de cadmara.

NOTA

El botén Show the Selected Deformation Chain and Hide All Others (Mostrar la cadena de
deformacién seleccionada y ocultar el resto) mostrara todas las cadenas de deformacion que
se encuentran en la jerarquia de la seleccidn. Por ejemplo, si esta seleccionado el peg maestro
de un modelo de personaje, se mostraran todas sus cadenas de deformacién. Asimismo, si
estan seleccionadas varias capas vinculadas con distintas cadenas de deformacion, se
mostraran todas sus cadenas de deformacion.

Cémo ocultar los controles de deformaciéon

1. Realice unade las siguientes acciones:
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» Hagaclic en el espacio negativo de la vista de camara, de linea de tiempo o de nodos
para descartar la seleccién actual y, a continuacion, haga clic en el botén © Show the
Selected Deformation Chain and Hide All Others (Mostrar |la cadena de deformacion
seleccionaday ocultar el resto) de la barra de herramientas de deformacion.

» Seleccione una capa que no esté vinculada a ningin deformador y, a continuacion,
hagaclic en el boton © Show the Selected Deformation Chain and Hide All Others
(Mostrar la cadena de deformacion seleccionaday ocultar el resto) de la barrade
herramientas de deformacion.

» Enlabarrade herramientas de camara, haga clic en el botén »* Hide All Controls
(Ocultar todos los controles).

« En el mend superior, seleccione View > Hide All Controls (Ver > Ocultar todos los
controles).

* Pulse Mayus + C.

Animacion con deformadores

Al igual que con los pegs de animacion y las capas de dibujo, puede animar los deformadores creando
fotogramas clave en sus capas correspondientes en la linea de tiempo. La animacion de deformadores
funciona exactamente igual que la realizacién de modificaciones en un deformador, excepto que requiere el
uso de la herramienta . Transform (Transformar) en lugar de la herramienta Rigging. Al seleccionar la
herramienta Transform (Transformar), los controles de deformacion de la vista de camara se muestran en
color verde, lo que significa que se encuentran en modo de animacion, mientras que cuando se selecciona la
herramienta Rigging, se muestran en rojo, lo que significa que se encuentran en modo de rigging.

Animacion de deformaciones de hueso y hueso para juego

1. Enlavistade lineadetiempo, contraiga el personaje con la flecha Expand/Collapse
(Expandir/Contraer).

109



Capitulo 12: Uso de deformadores

3. Paragarantizar que el modelo no desaparezca después de 1 fotograma, abra el cuadro de didlogo
Extend Exposure (Extender exposicion) realizando una de las siguientes acciones:

e Hagaclic con el botdn derecho en el primer fotograma de la vista de linea de tiempo y
seleccione Extend Exposure (Extender exposicion).

e Pulse F5.

4. En el cuadro de didlogo Extend Exposure (Extender exposicion), escriba el nimero de fotogramas
de laescenay confirme. De este modo, el modelo quedaré expuesto (sera visible) en toda la
escena.

5. Ahora crearemos la primera pose del personaje. En primer lugar, asegurese de que haya un
fotograma clave en el primer fotograma de cada capa del modelo. Con ello garantiza que cuando
cree la segunda pose mas tarde, la primera pose no se vera afectada. Para llevarlo a cabo, realice
una de las siguientes acciones:

 Enlabarrade herramientas de linea de tiempo, haga clic en el bot6n ¢ Add Keyframe
(Agregar fotograma clave).

» Hagaclic con el boton derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

Se agrega un fotograma clave al fotograma actual.

6. Enlabarrade herramientas de herramientas, seleccione la herramienta {.} Transform
(Transformar) o pulse Mayus + T.

7. Enlabarrade herramientas de herramientas, si esté seleccionado el modo § Animate Off (Animar
desactivado) o gﬁ Animate Onion Skin Range (Animar intervalo de papel cebolla), hagaclicen él
para abrir el mend emergente Animate (Animar) y seleccione Animate Current Frame (Animar
fotograma actual).

8. Realice unade las siguientes acciones:

e Enlavistade camara o de linea de tiempo, seleccione una de las capas de dibujo vinculadas
alacadena de deformacion que desee animar.

e Enlavistade linea de tiempo, seleccione cualquier parte de la cadena de deformacién que
desee animar.
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9. Enlabarrade herramientas de deformacion:

» Hagaclic en el botén Show the Selected Deformation Chain and Hide All Others (Mostrar la
cadena de deformacién seleccionaday ocultar el resto) © para mostrar la cadena de
deformacién del elemento seleccionado y ocultar cualquier otra cadena de deformacién que
se muestre.

« Hagaclic en el botén Show Selected Deformers (Mostrar deformadores seleccionados) 2
para mostrar la cadena de deformacion del elemento seleccionado junto a cualquier otra
cadena de deformacién que se muestre.

Los controles de deformacion aparecen en la vista de camara.
10. Enlavistade camara, realice lo siguiente:

» Pararotar el miembro entero, hagaclicy arrastre el primer hueso. Esto girara el
primer hueso y todos los huesos subsiguientes.

» Paradoblar el miembro, haga clicy arrastre otro hueso. Esto girara el hueso y todos
los huesos subsiguientes, pero dejara los huesos anteriores en su posicion actual.

e Para cambiar una articulacién de posicion, haga clic y arrastre su punto de control.
Esto se puede utilizar para rotar, reducir o extender el hueso, y desplazara todos los
huesos subsiguientes.
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» Parareducir o extender un hueso sin rotarlo, mantenga pulsada latecla Alty, a
continuacion, haga clic y arrastre su punto de control.

e Paradesplazar el miembro entero, haga clicy arrastre su punto de raiz.

]
_‘Q’_ CONSEXO
4 \
También puede realizar un desplazamiento pequefio de una articulacion
en cualquier direccion seleccionandolay, a continuacion, pulsando las

teclas de flecha.

11. Enlavistadelinea de tiempo, vaya al fotograma en el que desee definir la siguiente pose clave.

12. Agregue un fotograma clave en el fotograma actual realizando una de las siguientes acciones:
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* Enlabarrade herramientas de linea de tiempo, haga clicen el botén * Add
Keyframe (Agregar fotograma clave).

» Hagaclic con el boton derecho y seleccione Add Keyframe (Agregar fotograma
clave).

e Pulse F6.
13. Transforme el punto del deformador para crear su nueva pose clave.

14. Repitalos pasos anteriores hasta que la animacion haya terminado.
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Capitulo 13: Importacion de sonido y sincronizacion de labios
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Importacién de sonido

Si desea agregar sonido a la animacién, es recomendable que edite y mezcle los archivos de sonido en un
software de edicion de sonido. Al tener pistas de sonido de larga duracién mezcladas previamente, se
garantiza que el sonido conserve su tiempo, mezclay calidad si utiliza software de terceros para la
postproduccién. Otra buena practica es mantener la pista de sonido separada en pistas de musica, efectos de
sonido y personajes para facilitar la sincronizacion de la animacion con voces y sonidos. De lo contrario, es
posible recortar los efectos de sonido y ajustar su volumen directamente en Harmony cuando sea necesario.

Si crea el proyecto en Toon Boom Storyboard Pro, puede exportar todas las escenas del proyecto como
escenas de Harmony independientes. La pista de sonido del storyboard se cortara por escenay cada pieza se
insertara en las escenas exportadas, lo que permite ahorrar tiempo en la division e importacion de la pista de
sonido.

Harmony puede importar archivos de sonido .wav, .aiff y . mp3.

NOTA

Laimportacion de una pista de sonido mas larga que la escena no ampliara lalongitud de esta
tltima. La reproduccién de sonido se detendréa al final de la duracion de la escena.

Importacion de un archivo de sonido

1. Realice unade las siguientes acciones:
e En el menu superior, seleccione File > Import > Sound (Archivo > Importar > Sonido).

e Enlavistade carta de rodaje, haga clic con el boton derecho en cualquier parte del
area de fotogramas y seleccione Import > Sounds (Importar > Sonidos).

Se abre el cuadro de didlogo Select Sound File (Seleccionar archivo de sonido).

2. Enel cuadro de didlogo Select Sound File (Seleccionar archivo de sonido), busque y seleccione un
archivo de sonido.

El archivo de sonido aparece como una capa en la vista de linea de tiempo. Su forma de onda se
muestra en la pista para ayudar a visualizar en qué fotogramas se producen los efectos de sonido
de la pista de sonido.
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La pista de sonido también aparece como una columna en la vista de carta de rodaje, pero no
mostrara una forma de onda de manera predeterminada. Si lo desea, puede visualizar laforma de
onda de una columna de sonido haciendo clic con el botén derecho en ellay seleccionando Sound
Display > W aveform (Visualizacion de sonido > Forma de onda).

Deteccion automatica de sincronizacion de labios

La adicién de la sincronizacion de labios a la animacién es fundamental para que parezca que 10s personajes
estan vivos. Sin embargo, también es una parte especialmente pesada del proceso de animacion.

— e W
~ \

Para solucionar este problema, Harmony proporciona una funcién de deteccién automatica de sincronizacion
de labios. Esta funcion analiza el contenido de una pista de sonido de la escenay asocia cada fonema que
detecta con una de las formas de boca de la siguiente carta de fonemas, que es una carta de fonemas estandar
de laindustria de la animacion.
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Boca adicional
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NOTA

Las letras asignadas a estas formas de boca son identificadores estandar y NO se corresponden
con el sonido que se pretende producir.

Esta es una aproximacion de los fonemas ingleses que cada forma de boca puede utilizar para representar:
e« A:m,b,p,h
e B:s,d,j, ikt
e Cea
« D:AE
« Eo
* Fu,00
« G:f,ph
e X:silencio, sonido indeterminado

Al realizar la deteccidn automatica de sincronizacion de labios, Harmony no crea dibujos de boca. Simplemente
rellenala columna de dibujo de la capa de la boca del personaje con la sincronizacion de labios generada,
insertando la letra asociada con la forma de boca correcta en cada celda de la columna. Por lo tanto, para que
la deteccion automatica de sincronizacién de labios funcione, la capa de la boca del personaje ya debe
contener un dibujo de boca para cada dibujo de la carta de fonemas, y estos dibujos deben tener el nombre de
su letra correspondiente.

Generacion de una deteccion de sonido para sincronizacion de labios mediante la vista
de propiedades de capa

1. Enlavistadelineadetiempo o de carta de rodaje, seleccione la capa de sonido.
Las opciones para dicha capa apareceran en la vista de propiedades de capa.

2. Enlas propiedades de capa, haga clic en Detect (Detectar).
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Harmony analiza los clips de sonido seleccionados y asigna una letra de sincronizacion de labios a
cada celda de sonido.

3. Hagaclicen el boton Map (Asignar) para abrir el cuadro de dialogo Lip-Sync Mapping (Asignacion
de sincronizacion de labios).

4. Enel menu Destination Layer (Capa de destino), seleccione la capa que contiene las posiciones de
la boca parala pista de voz del personaje.
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NOTA

Si la capa seleccionada contiene simbolos, puede asignar la sincronizacion de labios
utilizando dibujos situados directamente en la capa, o bien utilizar los fotogramas del
simbolo. En el campo Symbol Layer (Capa de simbolos), seleccione Don't Use Any
Symbol (No usar ninglin simbolo) si desea utilizar los dibujos o el simbolo deseado del
menu desplegable.

5. Enlaseccion Mapping (Asignacion), escriba el nombre del dibujo o los fotogramas del simbolo en
el campo situado a la derecha del fonema que representa. Si los dibujos ya tienen los nombres de
las letras del fonema, puede saltarse este paso.

6. Hagaclicen OK (Aceptar).
7. Enlabarrade herramientas de reproduccion, habilite la opcion ) Enable Sound (Habilitar sonido).

8. Pulse el boton » Play (Reproducir) en la barra de herramientas de reproduccion para ver y oir los
resultados en la vista de camara.

Si tiene que realizar ajustes a la sincronizacién de labios generada automaticamente, consulte
Animacion manual de sincronizacién de labios en la pagina 118.

Animacion manual de sincronizacion de labios

Puede crear la sincronizacion de labios para la escena de forma manual seleccionando qué dibujo de boca
debe exponerse en cada fotograma del cuadro del dialogo de su personaje. Para este proceso, utilizara la
funcion Sound Scrubbing (Depuracion de sonido), que reproduce la parte de la pista de sonido en el fotograma
actual cadavez que mueva el cursor de lalinea de tiempo, lo que permite identificar los fonemas que debe
hacer coincidir con la boca de su personaje. También se utilizara un dibujo de sustitucion para cambiar el dibujo
de laboca que se expone en cada fotograma.

Animacion de sincronizacion de labios utilizando la vista de linea de tiempo

1. Enlabarrade herramientas de reproduccién, active el boton s Sound Scrubbing (Depuracion de
sonido).

2. Enlavistadelinea de tiempo, arrastre el cabezal de reproduccion rojo a lo largo de laforma de
ondade la capa de sonido.

3. Cuando llegue a un fotograma en el que deba ir una posicion determinada de la boca, por ejemplo,
una boca abierta con labios redondeados para un sonido como "oh", haga clic en ese fotograma en
la capa de formas de boca.

4. Enlaseccion Parameters (Parametros), y continuando en la capa de formas de boca, coloque el
cursor en la parte superior del nombre del dibujo (normalmente una letra) hasta que cambie al
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puntero de intercambio 0.

5. Arrastre el cursor para ver lalistade los nombres de laforma de labocay elijala que desee. El
dibujo actual se cambia automaticamente ala nueva seleccion.
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Animacion de sincronizacion de labios utilizando la vista de libreria

1. Enlabarrade herramientas de reproduccion, active el botén s Sound Scrubbing (Depuracién de
sonido).

2. Enlavistadelinea de tiempo, arrastre el cabezal de reproduccion rojo a lo largo de laforma de
ondade la capa de sonido.

3. Cuando llegue a un fotograma en el que deba ir una posicion determinada de la boca, por ejemplo,
una boca abierta con labios redondeados para un sonido como "oh", haga clic en ese fotograma en
la capa de formas de boca.

4. Enlaventana Drawing Substitution (Sustitucion de dibujo) de la vista de libreria, arrastre el control
para elegir una forma de boca. El dibujo actual se intercambia por el de la ventana de vista previa.
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Intercambio de dibujos utilizando la vista de sustituciones de dibujo

1. Agregue lavista de sustituciones de dibujo a su zona de trabajo realizando una de las siguientes
acciones:

» Enlaesquina superior derecha de las vistas existentes, haga clic en el botén = Add View
(Agregar vista) y seleccione Drawing Substitutions (Sustituciones de dibujo).

e En el menu superior, seleccione Windows > Drawing Substitutions (Ventanas
> Sustituciones de dibujo).

2. Enlabarrade herramientas de reproduccion, active el botén s Sound Scrubbing (Depuracion de
sonido).

3. Enlavistade linea de tiempo, arrastre el cabezal de reproduccién rojo alo largo de laformade
ondade la capa de sonido.

4. Cuando llegue aun fotograma en el que deba ir una posicion determinada de la boca, por ejemplo,
una boca abierta con labios redondeados para un sonido como "oh", haga clic en ese fotograma en
la capa de formas de boca.

5. Enlavistade sustituciones de dibujo, haga clic en la pose de la boca que desee exponer en el
fotograma actual.

Library = Drawing Substitutions = | %

CONSEXO

También puede pulsar [ para sustituir el dibujo seleccionado por el dibujo anterior y ] para
sustituirlo por el siguiente dibujo.
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Capitulo 14: Adiciéon de efectos a una escena

Al crear una escena, crear un rig de personaje o una vez que la animacion esté terminada, puede agregar
efectos, como desenfoques, brillos, sombras, filtros de color y de transparencia, asi como mejorar la calidad
del proyecto. Los efectos cambian la forma en la que las capas o grupos de capas se renderizan en la escena.

Acerca de los efectos

Los efectos son tipos de capas especiales que se pueden agregar a la estructura de la escena. Para que una
capa de efecto funcione, debe estar conectada como hija de un dibujo, grupo u otro efecto. Los efectos solo se
aplican al elemento al que estan conectados. Esto proporciona flexibilidad a la hora de decidir a qué
elementos de la escena afecta un efecto.

Algunos efectos necesitan vincularse a otra capa, denominada capa de mate, que se usa para definir el area a
la que deben afectar. El ejemplo mas basico es el efecto de cuchilla. Por si solo, un efecto de cuchilla no tiene
ningln impacto en el dibujo al que esta conectado. Una vez combinado con una capa de mate, el efecto de
cuchilla corta laforma del mate fuera del dibujo.
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Una capa de mate es una capa de dibujo habitual que esta conectada a un efecto como su mate. El efecto toma
laformadel dibujo en la capa de mate para determinar el area del dibujo a la que afecta. Los colores y detalles
de la capa de mate se ignoran mediante el efecto y solo se tiene en cuenta su forma.

En lavista de linea de tiempo, se debe crear un rig de un efecto como el hijo de una capa de dibujo o grupo al
gue debe afectar.

Si el efecto puede usar una capa de mate, tendra un parametro de mate al ampliar la lista de parametros.
Puede arrastrar y colocar la capa en la que desee usar un mate para el efecto en el parametro de mate del
efecto para vincularlos.

Si el efecto puede usar una capa de mate, tendra un puerto de mate a su izquierda al que se puede conectar la
capade mate.

Unavez que el efecto esta conectado, puede ajustar sus pardmetros seleccionandolo y, a continuacién,
ajustando sus parametros en la vista de propiedades de capa. También puede hacer doble clic en la capa para
abrir su cuadro de diadlogo de propiedades de capa. Si se desea, incluso puede animar los pardmetros del
efecto convirtiendo sus valores a funciones.

Adicion de un efecto

En Harmony, puede agregar efectos seleccionando la capa o grupo al que desee agregar un efectoy, a
continuacion, agregando el efecto a través del menu Add Layers (Agregar capas) de la vista de linea de
tiempo. A continuacion, puede conseguir el efecto previsto ajustando los parametros en la vista de
propiedades de capay conectdndolos a una capa de mate, segun proceda.

Adicion de un efecto
1. Enlavistade lineadetiempo, seleccione la capa en la que desee agregar un efecto.

2. Realice unade las siguientes acciones:

» En el mend superior, seleccione Insert > Effects (Insertar > Efectos) y seleccione el
efecto que desea agregar.
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» Enlabarrade herramientas de capas situada encima de la lista de capas, haga clic en
el boton 4+, Add Layers (Agregar capas), seleccione Effects (Efectos) y, a
continuacién, seleccione el efecto que desee agregar.

e Hagaclic con el botén derecho en la capa, seleccione Insert > Effects (Insertar >
Efectos) y, a continuacion, seleccione el efecto que desee agregar.

El efecto aparece en la vista de linea de tiempo, debajo de la capa seleccionada.

3. Enlavista de camara, haga clic en el botén Render View (Vista de render) para ver el fotograma
y el efecto actuales renderizados de la escena.

NOTA
El fondo aparecera en negro de forma predeterminada. Para corregirlo, puede

agregar una capa de la carta de color en la parte inferior de la lista de capas y
cambiar su color en la vista de propiedades de capa.

4. Enlavistade lineade tiempo, haga doble clic en la capa del efecto para abrir la ventana Layer
Properties (Propiedades de capa). También puede seleccionar la capa del efecto y ver sus
propiedades en la vista de propiedades de capa.

Se abre la vista de propiedades de capa y muestra los parametros disponibles para el efecto
seleccionado.

5. Enlavistade propiedades de capa, ajuste los pardmetros del efecto segun sea necesario.

NOTA

Cada vez que realice un cambio, la vista de cAmara tendra que actualizar laimagen
renderizada, lo cual puede provocar unaligera demora antes de que pueda observar el
efecto.
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6. Lamayoria de los efectos no se reproduciran en tiempo real en Harmony. Para reproducir la escena
con los efectos finales, haga clic en el boton & Render and Play (Renderizar y reproducir) de la
barra de herramientas de reproduccién de la barra de herramientas de la vista de linea de tiempo.

NOTA

Unavez que haya establecido los parametros para el efecto, puede almacenarlo en la vista de
libreria como plantilla para poder reutilizarlo rdpidamente sin necesidad de volver a
establecer los parametros; consulte Creacion y uso de plantillas en la pagina 154.

Uso del efecto de cuchilla

El efecto de cuchilla permite cortar una parte de unaimagen. Para ello, debe conectarse al dibujo que se
pretende cortar, asi como a una capa de mate. La cuchilla adoptara la forma del dibujo de |la capa de mate y
cortara esta forma de la capa de dibujo. Esto es particularmente Util si desea que un personaje desaparezca
entre un elemento de fondo o si desea realizar un agujero en el centro de un personaje.

Al igual que todos los efectos que utilizan un mate, el efecto de cuchilla tiene un pardmetro Inverted
(Invertido), que esta deshabilitado de forma predeterminada. Cuando esté habilitada, la cuchillatendra el
efecto contrario: en lugar de cortar la forma del mate del dibujo, cortard todo lo que se encuentre fuerade la
forma del mate del dibujo, dejando solo las partes del dibujo que estén cubiertas por el mate. Esto puede ser
util si, por ejemplo, desea dibujar sombras o resaltados para un personaje, pero no desea tener que
preocuparse de que abarquen mas alla del contorno del personaje. Simplemente puede conectar la sombra o
el resaltado a una cuchillainvertiday utilizar un clon del personaje como el mate, y el efecto no se mostrara
fuera de los contornos del personaje.
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Uso del efecto de cuchilla

1.

2.

Seleccione una capa de dibujo.
Realice una de las siguientes acciones:

e Enlabarrade herramientas sobre la lista de capas en la vista de linea de tiempo, haga clic
en el boton 4+, Add Layer (Agregar capa) y seleccione Effects > Cutter (Efectos > Cuchilla).

» Hagaclic con el botdn derecho en la capay seleccione Insert > Effects > Cutter (Insertar
> Efectos > Cuchilla).

El efecto de cuchilla se crea como capa hija de la capa seleccionada.

En labarra de herramientas sobre la lista de capas en la vista de linea de tiempo, haga clic en “%
Add Drawing Layer (Agregar capa de dibujo).

En el cuadro de didlogo Add Drawing Layer (Agregar capa de dibujo), asigne ala nueva capa de
dibujo un nombre relevante para una capa de mate, como "Dibujo de mate" y, a continuacion, haga
clicen Add and Close (Agregar y cerrar).

En la nueva capa de dibujo de mate, dibuje un mate para el efecto. El mate puede ser unaforma
simple, pero se debe rellenar con un color, ya que solo se tendran en cuenta las partes del mate
gue sean opacas.
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NOTA

Los mates también pueden tener areas semitransparentes. Las areas del dibujo
cubiertas por areas semitransparentes del mate se ven parcialmente afectadas por el
efecto.

4. Enlavistade lineade tiempo, haga clic en el botén + Expand (Expandir) situado a la derecha de la
capa Cutter (Cuchilla).

5. Arrastrey coloque la capa de mate junto al campo Matte (Mate) de la capa Cutter (Cuchilla), debajo
de la columna Parameters (Parametros).

La capa de dibujo de mate se convierte en el mate de la capa Cutter (Cuchilla). En este punto, las
areas de lailustracién que se cruzan con lailustracion de la capa de dibujo de mate estan ocultas.

6. Sideseainvertir el efecto de cuchilla, para que lailustracion que se cruza con lailustracion de la
capa de mate sea visible y todo lo demés esté oculto, haga doble clic en la capa Cutter (Cuchilla)
(pero no en su nombre) para abrir su cuadro de didlogo de propiedades de capay, a continuacion,
marque el pardmetro Inverted (Invertido).
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Animacion de un efecto

Es posible que necesite animar algunos efectos para obtener los resultados esperados. Por ejemplo, puede
desear que el radio de un efecto de brillo aumente y disminuya lentamente para hacer que vibre alo largo de
una escena, o puede desear que latransparencia de un efecto de transparenciaaumente de 0 % a 100 % para
hacer desaparecer un dibujo.

Casi todos los parametros numéricos de un efecto se pueden unir a una funcién. Una funcién permite definir un
pardmetro para distintos valores en diferentes puntos de la escena agregéandole fotogramas clave y
definiendo cada fotograma clave en un valor especifico. Entre fotogramas clave, el valor del parametro
avanzara desde el valor del fotograma clave anterior al valor del siguiente fotograma clave. Las capas de
dibujo se animan asociando sus coordenadas a funciones. Del mismo modo, los efectos se pueden animar
asociando sus pardmetros a funciones.

Algunos parametros de efectos se pueden animar directamente en la vista de linea de tiempo, pero no todos.
Al expandir los parametros de un efecto en la vista de linea de tiempo, algunos de sus parametros pueden
estar ocultos para evitar saturar la vista de linea de tiempo. Puede animar esos parametros desde la vista de
propiedades de capa o el cuadro de dialogo de propiedades de capa, que muestratodos los parametros de una
capa.

Animacién de un parametro de efecto en la vista de linea de tiempo

1. Enlavistade lineadetiempo, localice el efecto que desea animar y haga clic en el botén 4 Expand
(Expandir) situado a la derecha de su nombre.

nO=am

Aparece en lavista de linea de tiempo la lista de parametros que muestra los parametros de
efectos disponibles.
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2. Enel &readerechade lavistade linea de tiempo, en la misma fila que el pardmetro que desee
animar, seleccione el fotograma en el que desee crear el primer fotograma clave de animacion para
el efecto.

3. Cree un fotograma clave realizando una de las siguientes acciones:

« Enlabarrade herramientas de linea de tiempo, haga clic en el botén ¢ Add Keyframe
(Agregar fotograma clave).

» Haga clic con el bot6n derecho y seleccione Add Keyframe (Agregar fotograma clave).

¢ Pulse F6.

4. Enel areade laizquierda de lavista de linea de tiempo, debajo de la columna Parameters
(Parametros), ajuste el valor del parametro para este fotograma clave realizando una de las
siguientes acciones:

e Haga clicy mantenga pulsado el valor del parametro. A continuacion, arrastrelo hacia la
izquierda parareducir su valor o hacia la derecha para aumentarlo.

ro=al
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» Hagaclicen el valor del parametro. Aparecera un campo de texto. Escriba el nuevo valor del
parametro y pulse Entrar.

5. Enel &readerechade lavistade linea de tiempo, haga clic en el fotograma en el que desee crear el
segundo fotograma clave de animacion para el efecto.

6. Cree el segundo fotograma clave parala animacion del efecto realizando una de las siguientes
acciones:

« Enlabarrade herramientas de linea de tiempo, haga clic en el botén ¢ Add Keyframe
(Agregar fotograma clave).

e Hagaclic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

7. Enlacolumna Parameters (Pardmetros), ajuste el valor del pardmetro en el fotograma clave actual.

8. Repitalos pasos para crear tantos fotogramas clave de animacion para el efecto como sea
necesario.

9. Para ajustar el tiempo entre los fotogramas clave de la animacion, seleccione el primer fotograma
clave.

10. Enlabarrade herramientas de linea de tiempo, haga clic en el boton 4~ Set Ease for Multiple
Parameters (Definir aceleracién para varios parametros).

Aparece el cuadro de didlogo Set Ease For Multiple Parameters (Definir aceleracién para varios
parametros). El grafico de funciones de este cuadro de dialogo se centrara en el primer o
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fotograma clave de la animacion, que debe tener un controlador de la = curva Bézier al lado
apuntando hacia la derecha.

Segundo
= fotograma clave
]
]
Primer =
fotograma |
clave

Controlador
de curva
Bézier

11. Hagaclicen el controlador de la = curva Bézier y arrastrelo hacia la derecha, en cualquier angulo,
para ajustar la aceleraciéon gradual de la animacion.

12. Hagaclicen Apply/Next (Aplicar/siguiente).

El cuadro de dialogo Set Ease For Multiple Parameters (Definir aceleracion para varios parametros)
se centrara en el segundo fotograma clave. Si este es el tltimo fotograma clave de la animacion,
solo tendra un controlador de curva Bézier apuntando hacia la izquierda. Si hay mas fotogramas
clave de animacién después de este, tendra dos controladores de la curva Bézier, uno apuntando
en cada direccion.

130



Guia de introduccion de Harmony 22 Essentials

13. Hagaclicen el controlador izquierdo de la - curva Bézier y arrastrelo hacia la izquierda, en
cualquier angulo, para ajustar la desaceleracion gradual de la animacién entre el fotograma clave
anterior y el fotograma clave actual.

14. Sihay un controlador de curva Bézier » apuntando hacia la derecha, haga clic en él y arrastrelo
hacia la derecha, en cualquier angulo, para ajustar la aceleracion gradual de la animacién entre el
fotograma clave actual y el siguiente fotograma clave.

15. Repitalos pasos anteriores hasta que el tiempo de la animacidn se ajuste alo largo de toda la
escena.
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Animacion de un efecto en el cuadro de didlogo de propiedades de capa

1. Abralas propiedades de capa del efecto realizando una de las siguientes acciones:

e Agregue lavista de propiedades de capa a la zona de trabajo y seleccione el efecto en la
vista de linea de tiempo.

» Enlavistade linea de tiempo, haga doble clic en la capa del efecto, pero no en su nombre.

2. Enlas propiedades de capa del efecto, localice el pardmetro que desea animar y haga clic en el
botén s Function (Funcién) situado a su derecha.

El campo de entrada del pardmetro se atenuard. Esto se debe a que no puede editar un parametro
directamente una vez conectado a una funcién. El campo indicara el nombre de la funcién que se
creb para él en este formato:

Nombre de capa: Nombre de funcién: Valor en fotograma actual
3. Hagaclicde nuevo en el boton Function (Funcién) del parametro.

Se abre el cuadro de didlogo Bezier Editor (Editor de Bézier).
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Cursor de fotograma
actual

Grafico de
= funciones

Este cuadro de didlogo permitira animar la funcion. El gréfico de funciones de la parte inferior sirve
pararepresentar los valores de la funcién alo largo de cada fotograma de la escena.

4. En el gréfico de funciones, haga clicy arrastre el cursor rojo ' para moverlo al fotograma donde
desea crear el primer fotograma clave de animacion.

5. Hagaclicen el botén ¢+ Add Keyframe (Agregar fotograma clave) para crear el primer fotograma
clave de animacion para el efecto.

Se crea un fotograma clave o y debe ser visible en el grafico de funciones. Si no se ve, es porque el
grafico de funciones no esta colocado para incluir el fotograma clave en su fotograma. Para mover
el gréfico de funciones con el fin de ver el fotograma clave de la funcién, haga clic en el botén €
Reset View (Restablecer vista) o <T> Reset View Vertically (Restablecer vista vertical).
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6. Ajuste el valor del pardmetro al fotograma actual realizando una de las siguientes acciones:

» En el campo Value (Valor) sobre el grafico de funciones, escriba el valor deseado para el
parametro.

» En el grafico de funciones, haga clicy arrastre el o fotograma clave y muévalo hacia arriba
para aumentar su valor o hacia abajo para disminuirlo.

“(~. CONSEI

4 \

Si desea establecer el fotograma clave en un valor que esta fuera del fotograma
del grafico de funciones, puede pulsar latecla 1 para alejarse. También puede
pulsar latecla 2 para volver a acercarse.
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7. Hagaclicy arrastre el cursor rojo para moverlo al fotograma donde desea crear el segundo
fotograma clave de animacion.

8. Hagaclicen el boton ¢+ Add Keyframe (Agregar fotograma clave) para crear el segundo
fotograma clave de animacion para el efecto.

9. Ajuste el valor del parametro al fotograma actual realizando una de las siguientes acciones:

« En el campo Value (Valor) sobre el grafico de funciones, escriba el valor deseado parael
pardmetro.

» En el gréafico de funciones, haga clicy arrastre el o fotograma clave y muévalo hacia arriba
para aumentar su valor o hacia abajo para disminuirlo.
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10. Sidesea ajustar el tiempo de la animacion entre el primer y el segundo fotograma clave, haga lo
siguiente:

» Hagaclicy arrastre el controlador de la = curva Bézier del primer fotograma clave hacia la
derecha, en cualquier direccion, para que afecte a la aceleracion gradual de la animacion.

e Hagaclicy arrastre el controlador de la <= curva Bézier del segundo fotograma clave hacia la
izquierda, en cualquier direccion, para que afecte a la desaceleracion gradual de la
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animacion.

11. Repitaestos pasos hasta que haya creado y sincronizado los fotogramas clave de animacion
necesarios para animar el efecto.

Creacion de un efecto basado en un personaje animado

En el siguiente tutorial se demuestra como combinar efectos con otras funciones de Harmony para crear
facilmente una sombra paralela para un personaje animado. Siguiendo estos pasos, puede crear una sombra
paralela que seguira automaticamente la animacion del personaje, incluso si después cambia la animacion.

Creacion de una sombra paralela para un personaje animado

1. Enlavistade lineadetiempo, seleccione todas las capas que forman el rig de personaje. Si el
personaje esta bajo un peg maestro, también funcionard si selecciona el peg maestro.

2. Asegurese de que el rig de personaje se encuentre en un grupo. De no ser asi, haga clic con el
botdn derecho en la seleccién y, a continuacion, seleccione Group Selection (Agrupar seleccion).
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3. Unavez seleccionado el personaje en la vista de linea de tiempo, cree un clon del personaje
realizando una de las siguientes acciones:

» Hagaclic con el botén derecho en la seleccion y, a continuacion, seleccione Clone
Selected Layers: Drawings and Timing (Clonar capas seleccionadas: Dibujos y
tiempo).

» En el menu superior, seleccione Edit > Clone: Drawings and Timing
(Editar > Clonar: Dibujos y tiempo).

nO=am
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NOTA

Al contrario que un duplicado, una capa clonada siempre tiene el mismo tiempoy la
misma exposicidn que su capa de origen, incluso si su capa de origen se cambia mas
tarde. Por lo tanto, puede cambiar la animacion del personaje y la animacion del
personaje clonado se actualizara automéaticamente con estos cambios.

4. Agregue un efecto de sombra al grupo realizando una de las siguientes acciones.

 Enlabarrade herramientas de capas de la vista de linea de tiempo, haga clicen +,
Add Layers (Agregar capas) y seleccione Effects > Shadow (Efectos > Sombra).

» Hagaclic con el botdn derecho en la seleccién y, a continuacion, seleccione Insert >
Effects > Shadow (Insertar > Efectos > Sombra).

5. Enlavistade linea de tiempo, seleccione la capa raiz del clon del personaje.

6. Cree un peg padre parael clon realizando una de las siguientes acciones:
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» Enlabarrade herramientas de capas de la vista de linea de tiempo, haga clic en el
botén (4 Add Peg (Agregar peg).

e Pulse Ctrl + P (Windows/Linux) o 8 + P (macOS).

7. Enlavistadelinea de tiempo, seleccione el peg padre del clon.

8. Enlabarrade herramientas de herramientas, seleccione la herramienta {.} Transform
(Transformar).

9. Enlavistade camara, escaley sesgue el clon de modo que parezca una sombra difuminada.
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Capitulo 15: Uso de guias de dibujo

Las guias de dibujo son ayudas para dibujar que puede agregar a su escena para ayudarle a dibujar fondos y
objetos con lineas rectas, &ngulos rectos y efectos de proyeccion gréafica, como la proyeccion isométrica, la
perspectiva rectay la perspectiva curvilinea. En el arte tradicional, esto se realiza con herramientas, como
reglas, reglas T, escuadras y puntos de desaparicion. Las guias permiten simular el uso de dichas herramientas
junto con las herramientas de dibujo en Harmony.

Harmony admite distintos tipos de guias de dibujo, cada una disefiada para distintos tipos de tareas de dibujo.
La mayoria de las guias de dibujo de Harmony funcionan agregando unalinea de horizonte y puntos de
desaparicion a su espacio de dibujo. Cuando utiliza una guia de dibujo, aparecen lineas de guia de puntos
mediante el cursor del raton. Estas lineas de guia son paralelas o perpendiculares ala linea de horizonte, o van
desde uno de los puntos de desaparicion de la guia hasta el cursor del raton. Cuando empieza a dibujar un
trazo, su herramienta de dibujo se fijainmediatamente a uno de los ejes de la guia, como si dibujara con una
regla. También puede utilizar las guias de dibujo como simples referencias visuales sin fijar la herramienta de
dibujo alos ejes.

Harmony admite los siguientes tipos de guias de dibujo:

» Lareglale permite colocar y rotar un eje y, a continuacion, dibujar unalinea alo largo de dicho eje,
como unareglanormal.

» Lacuadricula cuadrada le ayuda a dibujar lineas paralelas o perpendiculares a la linea de horizonte.

=y
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e Laguiade perspectiva isométrica le ayuda a dibujar lineas paralelas a uno de los tres ejes: el gje x, el
ejey,y el eje z. El angulo de cada eje se puede personalizar seglin sea hecesario.

Este tipo de seudoperspectiva, también conocida como proyeccion paralela, a menudo se utiliza en
juegos 2D, infografias y esquemas para representar objetos y entornos 3D sin utilizar ninguna
perspectiva, escorzo o renderizado 3D real. En la animacion 2D, a menudo se utiliza para dibujar fondos
de paneo largos desde un angulo alto o bajo.

e Laguiade perspectiva con 1 punto le ayuda a dibujar lineas procedentes de un Gnico punto de
desaparicion en el centro del horizonte. También le ayuda a dibujar lineas paralelas o perpendiculares a
lalinea de horizonte.

Esto es util para dibujar estructuras de forma de cuboide que se encuentran de cara a la camara.

« Laguiade perspectiva con 2 puntos le ayuda a dibujar lineas procedentes de uno de los dos puntos de
desaparicion, que se colocan en lalinea de horizonte fuera del campo de la cAmara. También le ayuda a
dibujar lineas perpendiculares a la linea de horizonte.

Esto es util para dibujar estructuras de forma de cuboide desde un &ngulo horizontal especifico.
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e Laguiade perspectiva con 3 puntos le ayuda a dibujar lineas procedentes de uno de los tres puntos de
desaparicion. Como con la guia de perspectiva con 2 puntos, se colocan dos puntos de desaparicién en
lalinea de horizonte que se utilizan para dibujar lineas horizontales en el eje x 0 en el eje z. El otro punto
de desaparicidn se coloca debajo de la linea de horizonte para ayudarle a dibujar lineas en el ejey.

Esto es util para dibujar estructuras de forma de cuboide desde un punto de vista elevado.

» Laguiade perspectiva con 3 puntos (plano nadir) le ayuda a dibujar lineas procedentes de uno de los
tres puntos de desaparicion. Como con la guia de perspectiva con 2 puntos, se colocan dos puntos de
desaparicion en lalinea de horizonte que se utilizan para dibujar lineas horizontales en el eje x o en el
eje z. El otro punto de desaparicion se coloca encima de la linea de horizonte para ayudarle a dibujar
lineas en el gjey.

Esto es Util para dibujar estructuras de forma de cuboide desde un punto de vista bajo.
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» Laguiade perspectiva con 3 puntos (paneo horizontal) le ayuda a dibujar fondos panoramicos
horizontales, con lineas horizontales curvilineas. Un punto de desaparicién se coloca en el centro de la
linea de horizonte para ayudarle a dibujar lineas en el eje zy dos puntos de desaparicién se colocan en
lalinea de horizonte fuera del campo de la camara para definir la curva de las lineas horizontales. Las
lineas verticales se colocan perpendicularmente alalinea de horizonte.

Esto es util para dibujar fondos que se deben recorrer horizontalmente. El paneo horizontal de la
camara sobre el fondo dibujado con una guia de perspectiva con 3 puntos (paneo horizontal) simulara
unarotacion de lacamaraen el gjey.

]

- : -
__/

» Laguiade perspectiva con 3 puntos (paneo vertical) le ayuda a dibujar fondos panoramicos verticales,
con lineas verticales curvilineas. Un punto de desaparicion se coloca en el centro de lalinea de
horizonte para ayudarle a dibujar lineas en el gje zy dos puntos de desaparicidn se colocan debajo de la
linea de horizonte, fuera del campo de la camara, para definir la curva de las lineas verticales. Las lineas
horizontales se colocan en paralelo alalinea de horizonte.

Esto es util para dibujar fondos que se deben recorrer verticalmente. El paneo vertical de la camara
sobre el fondo dibujado con una guia de perspectiva con 3 puntos (paneo vertical) simularad una rotacion
vertical de la camara en el gje X.
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e Laguiade perspectiva continua con 4 puntos es muy parecida a la guia de perspectiva con 3 puntos
(paneo horizontal), salvo que esta disefiada para ayudarle a dibujar fondos panoramicos completos de
360°.

Esta guia utiliza 5 puntos de desaparicion. Cuando dibuja una linea horizontal, se curva formando un
arco sobre uno de los puntos de desaparicién y llegando hasta los dos puntos de desaparicion
circundantes. Esto crea un efecto de perspectiva donde cada punto de desaparicién representa uno de
los puntos cardinales, salvo los puntos mas alaizquierday mas a la derecha que representan el mismo
punto cardinal, lo que crea un fondo en bucle. Los fondos creados con la guia de perspectiva continua
con 4 puntos se pueden repetir en bucle horizontalmente para simular unarotacion completa de la
camaraen el ejey.

Sur | Este I

* Laguiade perspectiva continua con 4 puntos (paneo vertical) es muy parecida ala guia de
perspectiva con 2 puntos, salvo que sus lineas verticales son curvilineas, para que se pueda utilizar para
crear fondos de paneo verticales. Dos puntos de desaparicién se encuentran en la linea de horizonte,
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fuera del campo de la camara, para ayudarle a dibujar lineas en el eje x y el eje z, y dos puntos de

desaparicidn se colocan encimay debajo del campo de la camara para definir la curva de las lineas
verticales.

Esto es util para dibujar fondos que se deben recorrer verticalmente, en los que objetos de forma de
cuboide se ven desde un angulo.

e Laguiade perspectiva con 5 puntos (ojo de pez) le ayuda a dibujar fondos curvilineos en el eje xy en
el ejey. Tiene un punto de desaparicion central en la linea de horizonte desde el que se dibujan lineas
en el gje z; dos puntos de desaparicion en los extremos de su linea de horizonte para definir la curva de

lineas horizontales; y dos puntos de desaparicion encimay debajo de la linea de horizonte para definir la
curvade las lineas verticales.

Esta guia se puede utilizar para dibujar fondos con un efecto de objetivo gran angular con un estilo ojo
de pez. También se puede utilizar para dibujar fondos que se deben recorrer en varias direcciones.

145



Capitulo 15: Uso de guias de dibujo

Para usar una guia de dibujo, en primer lugar debe agregarla a la lista de guias de la escena. Para
familiarizarse con las guias, puede comenzar agregando la guia de dibujo de perspectiva con 1 punto alalista
de guias.

Adicién de una guia de dibujo de perspectiva con 1 punto a la escena

1. Enlabarrade herramientas de herramientas, seleccione Herramienta »” Brush (Pincel), # Pencil
(Lapiz), (-~ Stroke (Linea vectorial transparente) o / Line (Linea).

NOTA

Las guias de dibujo solo estan visibles en la vista de cAmara o de dibujo cuando esta
seleccionada una de las herramientas.

2. Agregue lavista de guias a su espacio de trabajo realizando una de las siguientes acciones:

» Enlaesquina derecha de cualquier vista de su espacio de trabajo, haga clic en el bot6n ==
Add View (Agregar vista) y seleccione Guides (Guias).

» En el menu superior, seleccione Windows > Guides (Ventanas > Guias).
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3. Enlavista de guias, haga clic en el boton 4+, New Guide (Nueva guia) y seIeccioneEﬁ 1-Point
Perspective (Perspectiva con 1 punto).

La nueva guia aparece en la lista de guias.

Number of Lines
-

Cuando se agrega una guia nueva, su linea de horizonte se configura en una posicion y un angulo predefinidos
y sus puntos de desaparicion se configuran en una posicién predefinida. En muchos casos, debe realizar
ajustes en la guia para poder dibujar fondos y objetos desde el punto de vista correcto.

Ajuste de una guia de perspectiva con 1 punto en una

1. Enlabarrade herramientas de herramientas, seleccione Herramienta s~ Brush (Pincel), # Pencil
(Lapiz), (~ Stroke (Linea vectorial transparente) o / Line (Linea).

NOTA

Las guias de dibujo solo estan visibles en la vista de camara o de dibujo cuando esta
seleccionada unade las herramientas.
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2. Enlavistade guias, aseglrese de que la opcion Enable Guides (Habilitar guias) esté activada.

3. Enlalistade guias, seleccione la guia de {<}-perspectiva con 1 punto en unaen la que desee
realizar ajustes.

La guia seleccionada aparece en la vista de camara o de dibujo.

I Linea de horizonte I

]

I Punto de desaparicion

4. Realice unade las siguientes acciones:
e Para cambiar la guia de posicion sin rotarla, haga clic y arrastre su punto de desaparicion @.

e Pararotar la guia, haga clicy arrastre su linea de horizonte.

CONSEJOS

¢ Cuando el ratén se coloca encima de la linea de horizonte, el cursor del ratén
cambiaraa & paraindicar que estéd a punto de rotar la guia.

» Al rotar una guia, su angulo se muestra en la esquina superior izquierda de la
vista de camara o de dibujo.

5. Unavez que haya terminado de realizar ajustes en la guia, puede hacer clic en el boton =»
Lock Guides (Blogquear guias) en la vista de guias para evitar modificar su guia accidentalmente
mientras dibuja.

Unavez que la guia esté seleccionada y correctamente colocada, puede comenzar a dibujar con ella.

Dibujo con guias de dibujo

1. Enlavistade lineadetiempo o de carta de rodaje, seleccione un dibujo o una celda vacia, y cree un
nuevo dibujo realizando una de las siguientes acciones:

e Hagaclic con el botdn derecho en la celday seleccione Drawing > Create Empty Drawing
(Dibujo > Crear dibujo vacio).

e Pulse Alt + Mayus + R.
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2. Enlabarrade herramientas de herramientas, seleccione Herramienta »” Brush (Pincel), # Pencil
(Lapiz), (— Stroke (Linea vectorial transparente) o ./ Line (Linea).

NOTA

Las guias de dibujo solo estan visibles en la vista de cAmara o de dibujo cuando esta
seleccionada una de las herramientas.

3. Enlavistade guias, seleccione la guia que desee usar.

4. Para evitar editar su guia accidentalmente mientras dibuja, haga clic en el botén =~ Lock Guides
(Bloguear guias) en la vista de guias para activarla.

5. Sidesea bloquear sus trazos con los ejes de la guia, asegurese de que la opcién ~" Align
with Guide (Alinear con guia) de la vista de guias esté activa. En caso contrario, desactivela para
poder dibujar libremente y use solo las guias como referencias.

6. Mueva el cursor del ratdn por el espacio de dibujo. Observe que las lineas de guias pasan por el
cursor del ratén, una por cada uno de los ejes de la guia de dibujo.

7. Comience adibujar en trazo en el mismo angulo que uno de los ejes.

Silaopcién ~ Align with Guide (Alinear con guia) esta habilitada, el trazo se alinea con el eje mas
cercano a su angulo, como si dibujara con una regla.
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CONSEXOS

» También puede seleccionar manualmente el eje al que desee fijar el trazo pulsando las
teclas Flecha izquierda y Flecha derecha para pasar por cada eje. El eje seleccionado
aparecera mas resaltado que los demas. Si pasa por todos |os ejes, ningun eje estara
resaltado, lo que significa que el eje al que se fija la herramienta de dibujo se vuelve a
determinar en funcién del angulo de su trazo.

» Esté dibujando o no, puede fijar la posicién y el angulo de las lineas de guia manteniendo
pulsada latecla Alt. Las lineas de guia dejaran de seguir el cursor del ratén, lo que le
permitira mantenerlas en un angulo y posicién especificos. Esto se puede utilizar para
dibujar sobre la misma linea varias veces para ajustar su longitud y grosor.

Unavez que hayaterminado de trabajar con las guias, puede deshabilitarlas. Cuando las guias de dibujo estan
deshabilitadas, no se muestran en el espacio de dibujo y no afectan al comportamiento de las herramientas de
dibujo.

Habilitacién y deshabilitacién de guias de dibujo

1. Parahabilitar o deshabilitar las guias de dibujo, realice una de las siguientes acciones:

» Enlavistade guias, haga clic en el boton Enable Guide (Habilitar guia)

* Pulse Mayus + G.

NOTAS

» Las guias se habilitan automaticamente al agregar una nueva guia o al seleccionar una
guia en lalista de guias.

¢ Laguiaque se seleccioné cuando deshabilité las guias se volvera a seleccionar cuando
vuelva a habilitar las guias.

¢ Las guias de dibujo solo funcionan con las herramientas Herramientas »” Brush (Pincel),
£ Pencil (Lapiz), (- Stroke (Linea vectorial transparente)y / Line (Linea). Si se
selecciona cualquier otra herramienta, las guias de dibujo se comportaran como si
estuvieran deshabilitadas.
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Capitulo 16: Creacion de un multiplano

En la accién en vivo, cuando la cAmara se mueve alrededor de una escena, parecera que los objetos cercanos a
la cdmara se desplazan a una distancia mayor que los objetos alejados de la misma. En la animacion 2D, se
puede conseguir un efecto similar creando un multiplano.

En Harmony, puede configurar facilmente un multiplano creando un fondo sobre varias capas, extendiéndolas
en el eje z para agregar profundidad y moviendo la camara por el entorno resultante para crear unailusion de
perspectiva impresionante.

En el siguiente ejemplo, el fondo se compone de 6 capas diferentes, y cada unarepresenta un objeto que se
encuentra a una distancia diferente de la camara. A la izquierda, puede ver como se sitla cada objeto en
relacidén con la cdmara, como si estuviera mirdndolos desde un lado. A la derecha, puede ver como se sittan
las capas en relacion entre si como si estuviera mirando la escena desde una esquina. A continuacion, puede
ver la escena desde el punto de vista de la camara.

151



Capitulo 16: Creacion de un multiplano

Mediante la herramienta Maintain Size (Mantener tamafio), puede convertir facilmente un fondo multicapa
normal en un multiplano. Esta herramienta permite mover una capa mas cerca o mas lejos de la camara
mientras se ajusta autométicamente el tamafio de la capa proporcionalmente a su distancia de la camara,
conservando su tamafio aparente desde el punto de vista de la camara. Por lo tanto, no tiene que preocuparse
por el tamafio y la posicién de las capas al disefiar el fondo.

En una nueva escena de Harmony, dibuje los distintos elementos de un fondo en capas separadas. Siga los

pasos que se muestran a continuacién para convertir el fondo en un multiplano.

Configuracion de un multiplano con la herramienta Maintain Size (Mantener tamafio)

1. Realice unade las siguientes acciones:

¢ Enlabarrade herramientas de animacién avanzada, seleccione la herramienta 53
Maintain Size (Mantener tamarfio).

e En el menu superior, seleccione Animation > Tools > Maintain Size (Animacién >
Herramientas > Mantener tamafio).

e Pulse Alt + 6.
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2. Enlavistalateral o superior, seleccione una de las capas de la secciébn de imagenes en miniatura.
También puede seleccionar una capa en la vista de linea de tiempo.

La capa seleccionada se resalta en las vistas superior, lateral y de camara.

3. Arrastre lacapaalolargo del eje Z dentro del cono de camara.

El elemento se movera en el eje Z de la escena, pero mantendra el mismo tamafio aparente en la
vista de camara.
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Capitulo 17: Creacion y uso de plantillas

Puede crear una plantilla a partir de una capa o de celdas. Puede almacenar como una plantilla cualquier
elemento disponible en lavista de linea de tiempo.

Creacion de una plantilla

Creacion de una plantilla

1. Enlavistade linea detiempo, seleccione varias celdas o capas.

Puede crear una plantilla a partir de una jerarquia de capas entera contrayendo la jerarquia y
seleccionando su capa raiz. Esto puede ser Util para crear plantillas basadas en rigs de personajes o
fondos de escena.

2. Enlavistade libreria, seleccione una carpeta para almacenar la plantilla. De forma predeterminada,
tendra una libreria denominada Libreria de Harmony Essentials almacenada en el ordenador, en la
subcarpeta Libreria de Toon Boom Harmony Essentials de la carpeta Documentos.

3. Silacarpetade libreria esta | & bloqueada, haga clic con el botén derecho y seleccione Right to
Modify (Derecho para modificar).

4. Arrastre laseleccion ala carpeta de lalibreria elegida.
Library  =[%

ballerina.tpl

[ATWI

W Symbols
Ll

I Al W]
Node Library T |%

Frame 1

+,— % % P=

P ." bLMASTER +

5. En el cuadro de didlogo Rename (Cambiar nombre), asigne un nombre a la nueva plantilla.

6. Hagaclic en OK (Aceptar).
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\ ' 4

_Q- CONSEXO

’ N
Para cambiar el nombre de una plantilla una vez creada, haga clic en ella con el boton derecho y
seleccione Rename (Cambiar nombre).

Importacién de una plantilla

Importacion de una plantilla

1. Enlavistade libreria, seleccione la plantilla que desee importar.

2. Arrastre la plantilla seleccionada a la vista de camara o a laizquierda de la vista de linea de tiempo.

Si coloca la plantilla en la vista de cdAmara, sus capas se agregaran en la parte superior de la lista de
capas. Si coloca una plantilla en la lista de capas de la vista de linea de tiempo, se insertara entre
las capas en las que la coloco.

Si la plantilla tiene la misma estructura de capas que una parte de la escena, puede colocarla
directamente en los fotogramas del lado derecho de la vista de linea de tiempo. En lugar de
insertar nuevas capas en la escena, esta accion reemplazara los dibujos y los fotogramas clave de
la escena por los de la plantilla. Esto es util paraimportar plantillas de pose o animacién para los
personajes que ya se encuentran en la escena.
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Capitulo 18: Exportacion de una pelicula

A través del cuadro de dialogo Export Movie (Exportar pelicula), puede exportar la animacion como un archivo
de video. De forma predeterminada, Harmony exportaré toda la escena en su resolucion completa. Silo
prefiere, puede elegir exportar solo un rango de fotogramas especifico en la escena o exportarlo en una
resolucion mas pequefia, lo cual puede ser Util si necesita ahorrar tiempo o espacio en disco. En funcidn del
formato en el que exporte la pelicula, también puede personalizar |os ajustes de compresién de video y de
audio para mas calidad o para obtener espacio en disco.

Exportacion de un archivo de pelicula

1. Enel menu superior, seleccione File > Export > Movie (Archivo > Exportar > Pelicula).

Se abre el cuadro de didlogo Export to QuickTime Movie (Exportar a pelicula de QuickTime).

Movie Options

2. Enlaseccion Output (Salida), abra el ment desplegable Video Format (Formato de video) y
seleccione el formato deseado para su archivo de pelicula:

e QuickTime Movie (*.mov): formato de Apple QuickTime. Este es el formato de
exportacion predeterminado que se recomienda por su portabilidad y porque le
permite elegir entre varios codecs de video.
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NOTAS

e En Windows, se debe instalar QuickTime de Apple para que Harmony
pueda exportar peliculas de QuickTime. Puede configurar que las
peliculas de QuickTime utilicen cualquier codec compatible con
QuickTime, incluidos H.264, MPEG-4 y Animation, para su
exportacion.

¢ En macOS, Harmony utiliza Apple AVFoundation para exportar
peliculas de QuickTime, lo que le permite utilizar codecs como H.264,
Apple ProRes 422 y Apple ProRes 4444, entre otros.

e Sidesea exportar una pelicula de QuickTime con transparencia,
asegurese de elegir un cédec que admita la codificacion con un canal
alfa.

» H.264/MPEG-4 (*.mov): formato de pelicula sencillo que utiliza el codec H.264
compatible con la mayoria de navegadores web.

NOTAS

e El uso de este formato no requiere software adicional. Sin embargo, si
es la primera vez que exporta una pelicula en formato H.264/MPEG-4,
se le solicitara que descargue lalibreria OpenH264 de Cisco.
Simplemente haga clic en Yes (Si) cuando se le solicite y Harmony
descargara lalibreria autométicamente y, a continuacion, exportara la
pelicula.

« No hay opciones de codificacién para este formato.

+ Este formato admite resoluciones de hasta 4096x2304. Cada
dimensidn debe ser un multiplo de 16 pixeles.

» El audio exportado en este formato esta codificado en PCM estéreo de
16 bitsy 22,05 kHz.

« Windows Media Video (*.wmv): formato nativo para Windows Media Player.
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NOTAS

* Los archivos Windows Media Video (.wmv) solo se pueden exportar
en Windows.

e Losreproductores de video y editores en sistemas que no sean de
W indows normalmente no pueden abrir archivos Windows Media
Video (.wmv).

3. Hagaclic en el boton Brow se (Examinar).

4. En el cuadro de didlogo Save (Guardar) que aparece, examine la ubicacion en la que desee exportar
el archivo de pelicula.

5. En el campo File name (Nombre de archivo), escriba el nombre del archivo que desee darle al
archivo de pelicula.

6. Hagaclic en Save (Guardar).
7. Enlaseccion Export Range (Rango de exportacion), realice una de las siguientes acciones:
« Seleccione All (Todo) si desea renderizar la escena entera.

» Seleccione Frames (Fotogramas) si desea renderizar una parte de la escena. A continuacion,
en el campo de la derecha, introduzca el primer fotograma de la secuencia que desea
exportar, y en el otro campo, el Ultimo fotograma de la secuencia que desea renderizar.

O Frames

8. Abralalista desplegable Resolution (Resolucion) y realice una de las siguientes acciones:

e Seleccione Same as Scene Resolution (Igual que resolucion de escena) si desea exportar
una pelicula con la misma resolucion que la escena.

Height:

» Seleccione 3/4 of Scene Resolution (3/4 de resolucidon de escena), 1/2 of Scene Resolution
(1/2 de resolucién de escena), 1/3 of Scene Resolution (1/3 de resolucion de escena) o 1/4
of Scene Resolution (1/4 de resolucién de escena) si desea exportar una pelicula que sea
inferior alaresolucion de la escena.
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» Seleccione Custom (Personalizado) si desea establecer la resolucién de exportacion
manualmente. A continuacion, en los campos Width (Ancho) y Height (Altura), introduzca
en pixeles la resolucion deseada para su pelicula.

9. Hagaclicen OK (Aceptar).

10. Enel cuadro de didlogo Export to QuickTime Movie (Exportar a pelicula de QuickTime), haga clic en
OK (Aceptar).

Aparece unabarra de progreso.

11. Desplacese alaubicacién en el ordenador en la que ha exportado el archivo de peliculay haga
doble clicen él paraverlo en el reproductor de video.
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Glosario

3D estereoscopico Imagenes o peliculas que generan dos imagenes diferentes, cada uno
desde el punto de vista de uno de los 0jos humanos. Cuando se visualizan o
proyectan através de dispositivos especiales, como una pantalla 3D o
gafas de realidad virtual, se crealailusion que los elementos de laimagen
se encuentran enfrente del espectador.

aberracion En éptica, una aberracién cromética (CA), acromatismo o distorsion
cromatica cromatica, es un tipo de distorsion en el que unalente no puede enfocar
todos los colores en el mismo punto de convergencia.

aceleracion En animacion, la velocidad es la aceleracion y la desaceleracion de un
movimiento. Puede ser un movimiento creado mediante una curva de
funcion o una serie de dibujos animados. Otros términos comunes para
aceleracion gradual y desaceleracidn gradual son aceleracién y
desaceleracion.

aceleracion de Aceleracion drastica al principio de la accion.
entrada

aceleracion de Aceleracion drastica al final de la accion.

salida
aceleracion gradual Aceleraciéon gradual en la accién. Conocida también como aceleracién.
alimentador de Método automatizado de introducir dibujos en un escaner en el que hay
papel automatico varios dibujos apilados en un alimentador de hojas. Cuando se activa el
escaner, los dibujos se digitalizan de forma consecutiva, sin ninguna otra
intervencion del usuario.
animacion Simulacién de movimiento que se crea dibujando o editando fotogramas
individuales.
animacion cut-out El proceso conocido como animacion cut-out es la accion de animar

personajes compuestos por varias piezas moviéndolos de fotograma en
fotograma. La animacion cut-out se puede generar por ordenador o
realizarse del modo tradicional utilizando papel.
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animacion directa

animacion pose a
pose

animacion
secundaria

animacion sin papel

animacion
tradicional

animatica

anime

arco

Técnica en la cual se dibuja por orden una secuencia completa desde la
primera posicion hasta la Ultima. Esta metodologia requiere muy poca
planificacién. El lugar en el que el personaje terminay como llega hasta alli
pueden ser una sorpresatanto para el publico como para el animador. Este
enfoque es espontaneo y creativo, pero puede generar resultados
imprecisos.

El proceso de animacidn pose a pose es la accién que consiste en crear
todas las poses de accioén principales, denominadas poses clave, y después
colocar las poses secundarias entre las claves. Las poses secundarias se
denominan descomposicion. Por Gltimo, el animador rellena los huecos con
los dibujos intercalados para lograr una animacion fluida.

Movimiento secundario provocado por la accién principal. Por ejemplo, un
personaje que corre y lleva puesta una capa. La accién principal es el

cuerpo que corre. Esto provocara que la capa siga el movimiento, aunque no
se movera al mismo tiempo, sino que reaccionara varios fotogramas
despuésy seguird la curva de movimiento principal.

El proceso de animacion sin papel es la accion de animar digitalmente. El
principal proceso de animacion sin papel es dibujar la animacién, fotograma
afotograma, directamente en el software.

Tipo de proceso de animacion mediante el cual todas las secuencias de
animacion se dibujan a mano en papel antes de digitalizarlos o tintarlos en
celdas.

Una pelicula hecha con secuenciacion de paneles en un storyboard, en la
gue se establece el tiempo aproximado de cada panel para la accion que
representay se sincroniza cada panel con la pista de sonido. Las animaticas
se utilizan para convertir el storyboard en un borrador de la pelicula final
con el fin de determinar el tiempo asignado a cada escenay a cada accion y
sincronizar la accién con la pista de sonido.

Animacion japonesa.

La accidn no suele producirse de forma directa, sino que mas bien se suele
desplegar en lo que los narradores denominan un arco. El propésito de un
arco de historia es mover un personaje o situacion de un estado o escenario
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arrastrar

artista de layout

atajos de teclado

baja resolucion

bocetos

campo

canal alfa

capa

capade fondo

al siguiente.

Operacion que consiste en hacer clic en un elemento, mantenerlo pulsado 'y,
a continuacion, moverlo mediante el movimiento del cursor del raton. Esto
se puede realizar con el boton izquierdo del ratén o con la punta del lapiz.

Artista que dibuja el fondo y crea la camaray la guia de campo, haciendo
coincidir la escenay el movimiento de la cAmara. Dibujara en el modelo las
poses de accién principales.

Tecla de teclado o combinaciéon de teclas de teclado que se asigna para
realizar un comando especifico en la aplicacion al pulsarlos.

Formato idoneo para videos destinados alaweb, donde el tamafioy la
descarga rapida del archivo de video tienen prioridad respecto a la calidad.
Unaimagen de baja resolucidn es aquella que no contiene detalles
precisos.

Es un nombre comun en una pelicula de animacién para un dibujo que se
utiliza como referencia, pero no forma parte de laimagen final. Un layout es
un boceto. Es el esbozo del esqueleto de una animacién o disefio. Los
bocetos consisten principalmente en lineas y formas esbozadas, pero
también pueden contener detalles de disefio.

Unidad de medida que se utiliza en la animacion tradicional para registrar y
realizar un seguimiento de la camara, asi como de su proximidad a la
escena.

Canal de imagen que contiene informacion de transparencia. De partida,
unaimagen tiene tres canales: rojo, verde y azul (RGB). El canal alfa es el
cuarto canal (A). El mate, o informacion de transparencia, se almacena en
este cuarto canal. Una imagen sin canal alfa siempre es opaca.

En animacién, una capa es una columna, nivel o personaje individual. Las
capas de una escena estan superpuestas para formar laimagen final.

En animacion, una capa de fondo es una parte especifica de la decoracion
colocada detras de la animacion principal.
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capa superior

cartade color

carta de exposicién

carta de fonemas

carta de rodaje

celda

ciclo

ciclo de andar

Parte del entorno de una escena, como unasilla o un arbusto, que se coloca
delante de la animacién principal.

Una carta de color es unatarjeta que contiene un color sélido con el mismo
tamafio que la camara. La carta de color rellena el fondo con un color solido
cuando no se ha incluido ningunaimagen de fondo.

Hoja con varias columnas verticales y fotogramas horizontales que se
utiliza paraindicar el tiempo de una escena. Cada columna representa una
capa de escena. Los numeros de dibujos de cada columna se indican y se
repiten alo largo de la cantidad de fotogramas determinada en la que
deben aparecer. La carta de exposicion la utilizan los animadores, directores
y otros miembros del equipo paratrazar la secuenciay el tiempo de las
imagenes, el didlogo, los efectos de sonido, las pistas de sonido y los
movimientos de cadmara. Conocida también como carta de rodaje.

Carta basada en los ocho fonemas de la animacion (A,B,C,D,E, F, Gy X,
que se utiliza para representar el silencio) utilizados para la sincronizacion
de labios.

La utilizan los animadores, directores y otros miembros del equipo para
trazar la secuenciay el tiempo de las imagenes, el didlogo, los efectos de
sonido, las pistas de sonido y los movimientos de cAmara. Conocida
también como carta de exposicion.

En la animacion tradicional, una celda (también denominada celuloide) es
una hojatransparente en la que la animacién se tintay se pinta antes de
enviarla ala camara. El trazado de laimagen se dibuja en la parte delantera
de la celday, a continuacion, se colorea por la parte trasera.

Serie de fotogramas de animacioén que se pueden repetir para simular un
movimiento continuo. Por ejemplo, un personaje a menudo camina
mediante una animacion en la que da dos pasos, uno con cada piey, a
continuacion, repitiendo la animacion.

Serie de dibujos "en el lugar" que describen cdmo camina un personaje. La
ilusién de movimiento se crea utilizando paneos de fondo. Para evitar
realizar innumerables dibujos, los animadores suelen realizar un ciclo de
andar para un personaje.
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cineméatica directa

cinematica inversa

(1K)

circulo cromatico

clean up

CMYK

codigo de tiempo

composicion

corte

corte de salto

La cinematica directa es una funcion utilizada para animar principalmente
personajes 3D y marionetas cut-out con jerarquia. Se utiliza para animar
una marioneta a partir de una de sus partes padres, como un hombro, y
hacer que el resto del brazo se mueva con ella como un todo.

Funcién utilizada principalmente para animar personajes 3D y marionetas
cut-out con jerarquia. La cinematica inversa animara una marioneta desde
unade las extremidades, como una mano, y permitird que el resto del
cuerpo la siga con naturalidad.

Visualizacion del espectro de colores en forma de circulo.

Unavez que los bocetos se han evaluado y aprobado, se quitatodo el ruido
de laimagen (lineas sobrantes, notas, etc.) para crear dibujos finales que se
pueden tintar, pintar y filmar. El proceso de clean up hace referencia al
trazado de una linea limpia sobre un boceto para conseguir la version final o
alaeliminacién de la suciedad y las lineas adicionales que han quedado
tras el proceso de digitalizacion.

Acrénimo en inglés de cian, magenta, amarillo y negro. Estos colores
forman el modelo estandar utilizado en un proceso denominado impresion
offset.

Informacion de tiempo impresa en un clip de pelicula paraindicar la escena,
hora, minuto y segundo que se muestran actualmente en pantalla.

La composicién es la accion de incorporar todos los elementos de una
escena para crear el resultado final antes del renderizado. Por ejemplo, el
artista de la composicion importara todas las secuencias, el fondo, las
superposiciones y las subcapas de la animacion en la escenay los colocara
correctamente. A continuacion, el artista definird el encuadre de cdmaray lo
animara en caso necesario. Por Ultimo, el animador creara todos los efectos
generados por ordenador para el proyecto.

Cuando una escena pasa a la escena siguiente de un fotograma a otro sin
ningun efecto visual.

Corte brusco entre dos escenas. Normalmente, un corte de salto no es
visualmente agradable. Normalmente lo provoca el final de una escenay el
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curva Bézier

depuracién de
sonido

desaceleracién

desaceleracion
gradual

descomposicion

desglose de pista de
audio

desplazamiento
pequefio

detecciéon

comienzo de otra, con una imagen parecida. La falta de diferencia provoca
gue el ojo vea un pequefio salto entre las dos escenas.

Método para definir lineas curvas inventado por el matemético francés
Pierre Bézier. Una curva Bézier es una curva matematica o paramétrica. Los
puntos de control definen las curvas Bézier. En Harmony, las curvas Bézier
tienen un punto de inicio, un punto de final y dos puntos de control
interiores que influyen la curva entre los puntos de inicio y final.

Proceso que permite escuchar el sonido en tiempo real, mientras mueve el
cabezal de reproduccion hacia delante o hacia atras. Es muy (til para
realizar el ajuste preciso de una sincronizacién de labios.

Desaceleracion gradual en la accion. Conocida también como
desaceleracion gradual.

Desaceleracion gradual en la acciéon. Conocida también como
desaceleracion.

En animacion cut-out, la descomposicidn es la accion de descomponer un
personaje en trozos para crear una marioneta con articulaciones. Para
descomponer un personaje, el artista corta partes, como las manosy los
brazos, del modelo del personaje y las pega en capas independientes. A
continuacion, las articulaciones se fijan y se definen los pivotes. En la
animacion tradicional, una descomposicién es una pose de animacién que
normalmente se encuentra entre dos poses clave. Las poses clave son las
poses principales de una animacion y las descomposiciones son poses
secundarias que ayudan a describir el movimiento y la curva de rotacion
(normalmente denominada arco).

Desglose de una pista de pelicula animada en sonidos individuales para
generar la posicion fotograma a fotograma precisa de cada sonido.

Pequefio empujon (izquierda, derecha, arriba, abajo, hacia delante o hacia
atras) realizado con las teclas de flecha del teclado en un elemento
seleccionado. El desplazamiento pequefio se utiliza para mover una
seleccién de manera muy ligeray precisa.

Asignacion automatica de dibujos en un elemento a la carta de fonemas
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automatica de
sincronizacion de
labios

deteccién manual de
sincronizacion de
labios

dialogo

disefio del personaje

dpi

eje

escena

estilo de paleta

exposicion

generada para un sonido. Puede ahorrar tiempo al sincronizar los labios una
pista de voz.

Intercambio manual de dibujos de posicion de la boca para que coincidan
con una pista de voz. Para este proceso, se utilizan tanto la depuracion de
sonido (escuchar una onda de sonido descompuesta fotograma a
fotograma) como las sustituciones de dibujos.

Texto hablado por un personaje en una pelicula o animacion.

Cada personaje de una pelicula animada se dibuja desde varios angulos en
formato de estilo péster denominado hoja de modelo, que sirve como
referencia para los animadores.

Siglas en inglés para puntos por pulgada, que representa la medida
estandar de resolucién para impresoras computerizadas. En ocasiones se
aplica a pantallas, en cuyo caso es mas exacto denominarlo pixeles por
pulgada. En cualquier caso, el punto es el elemento diferenciado méas
pequefio que formalaimagen.

Linea imaginaria alrededor de la cual rota un objeto. Para gréficos 2D, hay
dos ejes: X (horizontal) e Y (vertical). Para gréficos 3D, hay tres ejes: X
(horizontal), Y (vertical) y Z (profundidad). En animaciones que rotan
constantemente, el elemento de eje especifica alrededor de qué eje rota el
objeto. Un nimero negativo provoca que una animacion rote en sentido
contrario a las agujas del reloj, mientras que un nimero positivo hace que
una animacion rote ala derecha.

Plano en una pelicula o programa. Una secuencia esta compuesta por varias
escenas. Una escena cambia a otra mediante un corte simple o por
transicion.

Un estilo de paleta es una segunda versién de una paleta existente con un
ligero cambio en el tinte y el valor. Un estilo de paleta se puede utilizar para
crear la version nocturna de una paleta. También se le puede denominar
paleta de clonado.

En animacion, una exposicion es el nimero de celdas en las que un dibujo
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film-1.33

film-1.66

flipping

fondo

fonema

fotograma

fotograma clave

fotograma clave de
movimiento

fotograma clave de
Stop-motion

fotogramas por
segundo

aparece en la escena. Para que un dibujo parezca mas grande, la exposicion
se debe ampliar durante un niimero de celdas mayor.

Resolucion idénea para el formato de pelicula panordmico que se ajustaala
proporcion estandar de 4:3 pixeles.

Resolucion idénea para el formato de pelicula panoramico que se ajustaala
proporcion de 16:9 pixeles.

En la animacion tradicional, flipping es la accion de pasar por los dibujos de
una secuencia de animacién muy rapidamente con el fin de ver la animacion
en movimiento. Flipping también puede ser la accién de crear una
transformacién en espejo de un objeto.

llustraciones que llenan el campo de la cAmaray que se encuentran detras
de los personajes y props. Normalmente, estas ilustraciones representan la
decoracién o escena en la que ocurre la accién.

Unidad de sonido de un idioma.

Un fotograma de animacién es una imagen fotografica inica en una
pelicula. En la animacion tradicional, el estandar norteamericano contiene
generalmente 24 fotogramas por segundo, mientras que el estandar
europeo es de 25.

Posiciones importantes en la accion que definen los puntos inicial y final de
cualquier accion. Un fotograma clave es una posicion generada por
ordenador en un momento especifico (fotograma) y en unatrayectoria
determinada.

Fotograma clave con interpolacién generada por ordenador.

Fotograma clave sin interpolacién generada por ordenador.

Representan la velocidad a la que se reproducen los fotogramas por
segundo. Se calculan por lo general en fotogramas por segundo. Por
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funcién

fundido de
entrada/fundido de
salida

fundido encadenado

gama

guion

HDTV

hoja de campos

ejemplo, una escena se podriareproducira 12, 24,25, 30 o 60 fotogramas
por segundo o a cualquier otro nimero. Es la medida de la frecuencia (tasa)
alaque un dispositivo de imagen produce imagenes consecutivas Unicas,
denominadas fotogramas. El término se aplica por igual a los gréaficos por
ordenador, videocamaras, camaras de peliculay sistemas de captura de
movimiento. La tasa de fotogramas se suele expresar principalmente en
fotogramas por segundo (fps) y en monitores de barrido progresivo en
hercios (Hz).

Movimiento, trayectoria o ruta generados por ordenador al que se pueden

conectar pardmetros de elementos, otras trayectorias y efectos. La funciéon
se puede controlar agregando fotogramas clave y puntos de control en la

curva de funcion.

El fundido de entrada o fundido de salida es un efecto de transicion
utilizado para abrir o cerrar una secuencia. Un fundido de entrada se
produce cuando la primera escena aparece progresivamente, desde una
transparenciatotal a su opacidad total. Un fundido de salida se produce
cuando la escena desaparece progresivamente, desde la opacidad total ala
transparenciatotal.

Cuando una escena pasa a la escena siguiente mediante un fundido en el
gue desaparece unay aparece la siguiente.

Rango de colores que puede representar un dispositivo determinado.

Texto original que contiene lainformacion de toda la pelicula o el
programa. En animacion, el guion contiene todas las descripciones de la
ubicacién, el didlogo, el tiempo, etc. Un proyecto comienza con un guion.

Acrénimo en inglés de television de alta definicion, que es el estandar de
resolucion actual para producciones televisivas. La resolucion de
producciones de HDTV es 1280%720 (HD ready) 0 1920%1080 (full HD), y
sus fotogramas por segundo normalmente oscilan entre 23.976 y 30.

Guia que contiene todas las unidades de campo que los artistas de
animacion y layout utilizan para definir el tamafio del campo de la camara,
asi como sus movimientos.
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hold Fotograma en la animacion en el cual el personaje mantiene su posicion sin
moverse. Se puede crear un hold entre dos fotogramas clave cualesquiera.

HSV Siglas en inglés para matiz, saturacion y valor. Método para definir los
colores en cuanto a matiz (tinte), saturacion (sombra) y valor (tono o
luminancia).
imagen en miniatura Imagen muy pequefia utilizada como una referencia o indicador.
ink and paint El proceso ink and paint es la accion de pintar las zonas vacias y colorear las

lineas en los dibujos de animacién finales siguiendo un modelo de color.

intercalado Dibujos que existen entre las poses clave. Se dibujan para crear
transiciones fluidas entre poses.

interpolacion Movimiento generado por ordenador creado entre dos fotogramas clave. Se
puede crear interpolacion, o no, entre los fotogramas clave.

layout Paso de comunicacién entre el storyboard y la animacion. Es la accion de
poner el storyboard en el modelo. Es decir, el personaje se dibuja siguiendo
el disefio del paquete de modelo, de modo que el animador puede
comenzar a trabajar. El artista de layout dibuja el fondo y crealacamaray la
guia de campo, haciendo coincidir la escenay el movimiento de la cAmara.
Por altimo, el animador dibuja en el modelo las poses de accion principales.

layout y pose Accién que consiste en poner el storyboard en el modelo (ala escala
adecuada) para que el animador comience a trabajar.

libreria Zona de almacenamiento que contiene plantillas y recursos que se pueden
reutilizar en un proyecto o escena.

linea de accion Linea central en una pose de accion. Cuando se pintan poses de accion sin
tocar lalinea de accion se garantiza que la pose sea dinamicay que su
silueta se ajuste ala direccién de la accién.

linea de tiempo Representacion horizontal de los elementos, el tiempo y los fotogramas
clave de una escena.
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lineas vectoriales
transparentes

mapa de bits

mesa de disco

mesa de luz

modelo de color

modelo/modelo de

color

morphing

multiplano

NTSC

PAL

Cuando no hacen referencia a trazos reales, las lineas vectoriales
transparentes son contornos invisibles que se utilizan para definir zonas de
color o para cerrar zonas de color abiertas.

Imagen definida por una malla de pixeles, asi como por el color individual
de cada uno de sus pixeles. Los gréficos de mapas de bits se caracterizan
por ser preferibles a los graficos vectoriales para ilustraciones muy
detalladas o fotorrealistas. Sin embargo, los gréficos de mapas de bits no
se pueden escalar, rotar o sesgar sin que laimagen pierda calidad.

Equivalente al disco/mesa de animacion, es un dispositivo que permite rotar
el espacio de trabajo para mayor comodidad mientras se dibuja.

Dispositivo que permite ver otras capas en transparencia mientras trabaja
en una capa determinada.

Disefio de color oficial que se debe utilizar para pintar la animacién. Un
modelo es el disefio de personaje, prop o ubicacion definitivo que cada
artista debe seguir para la produccion.

Disefio de personaje, prop o ubicacion definitivo que cada artista debe
seguir para una produccion. Un modelo de color es el disefio de color oficial
gue se debe utilizar para pintar la animacion.

Funcion que permite crear dibujos generados por ordenador entre un dibujo
de origen y otro de destino. La animacion creada con la funcién de morphing
se puede reutilizar en distintos proyectos.

Efecto de pasar por diversos niveles de dibujos para crear una sensacion de
profundidad en un plano. Un multiplano es una escena en la que las capas
estan colocadas a distintas distancias de la camara, de modo que, cuando la
camara se mueve, se produce una ilusion de profundidad. Con un
multiplano, toda la perspectivay la escala se calculan automaticamente.

Antiguo sistema de difusion televisiva anal 6gico estandar utilizado en
Norteamérica.

Resolucion que funciona mejor con el formato europeo para pantallas de
televisiéon y de ordenador, ya que los pixeles rectangulares se muestran con
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paleta maestra

paleta/paleta
maestra

panear

panel

papel cebolla

paso con doble bote

peg

pivote

pixel

una orientacion distinta.

Grupo de colores atribuidos a un personaje o prop. La paleta se utiliza
durante toda la produccion para mantener la coherencia en el aspecto y
para garantizar que se utilicen los mismos colores durante la produccion.
Conocida también como paleta.

Una paleta o paleta maestra es un grupo de colores atribuidos a un
personaje o prop. La paleta se utiliza durante todo el proyecto para
mantener la coherencia en el aspecto y para evitar cambios de color
durante la animacion. También se le denomina paleta maestra.

Mover la camara atravesando la escena en cualquier direccién.

En un storyboard, un panel es un fotograma en un plano. Un plano puede
estar compuesto por uno o varios paneles.

Funcién que permite ver los dibujos anterior y siguiente de una secuencia.

En los fotogramas clave y las posiciones de paso de un paso con doble
bote, el cuerpo es menor que una linea de referencia dibujada en posicion
vertical. Durante los intercalados, el cuerpo esta situado sobre estalinea,
ofreciendo asi un aspecto de rebote.

En la animacion tradicional, es una herramienta utilizada para garantizar el
registro preciso de la accion a medida que se mueven las capas de celdas.
En la animacion digital, en la que se realiza un rigging de marionetas mas
avanzado, se pueden usar capas de pegs. Las capas de pegs son capas de
trayectoria que no contienen dibujos. Son rutas de movimiento que puede
usar para agregar articulaciones de ruta. Para las Ultimas, también puede
utilizar una herramienta de cinematica inversa.

Punto alrededor del cual un peg o dibujo rota.

Elemento més pequefio de unaimagen mostrado en un monitor o pantalla
de television. El pixel, abreviatura en inglés de elemento de imagen, es un
punto Unico en una imagen gréfica. Es una pequefia muestra de una
imagen, un punto, un cuadrado o0 una seccidon muy pequefia compuesta de
filtrado suavizado. Si acerca el zoom lo suficiente en una imagen digital,
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planificacién de
layout

plano

plano de situacién

plantilla

pose clave

posicién de paso

proceso de layout

proporcion

vera los pixeles, que parecen pequefios cuadrados de distintos colores e
intensidad.

Dibujo de las funciones principales de la escena que se utiliza como
referencia al planificar la animacién y ejecutar sus etapas iniciales.

Escena en una pelicula o programa. Una secuencia esta compuesta por
varios planos. Un plano cambia a otro mediante un corte simple o por
transicion.

Escenaen la cual el espectador puede ver toda el area en la que se esta
produciendo una secuencia. Por ejemplo, si un nifio esta jugando en el patio
delantero de su casa, el plano de situacion seria una escena en la que el
espectador puede ver la casa, el patio, parte de la calle y los edificios
situados alrededor del punto de accién central. Esto ayuda al espectador a
entender la ubicacion de la historia y la orientacion de la escena.

Recurso almacenado en la libreria que se puede reutilizar en cualquier
proyecto. Una plantilla puede ser un dibujo, una serie de fotogramas clave,
un archivo de sonido, un panel, un personaje cut-out, un efecto, una
trayectoria, una animacién o cualquier otra cosa que se utilice en la
animacion.

Posiciones importantes en la accién que definen los puntos inicial y final de
cualquier transicién suave. Las claves, 0 poses clave, son los dibujos
principales de una secuencia de animacion que describen el movimiento.
Por ejemplo, si se agita un brazo, las claves corresponderan al brazo de una
extremidad del movimiento de onday ala otra extremidad. Al realizar un
flipping de dichos dibujos, el animador puede ver el esqueleto del
movimiento sin tener todos los dibujos.

Al dibujar una secuencia en la que un personaje camina, la posicién de paso
es el punto en el que una pierna pasa a la otra.

Paso de comunicacién entre el storyboard y la animacion.

Proporcion entre las dimensiones de ancho y altura de una escena,
fotograma o formato de pelicula. Actualmente, la proporcion méas popular
es 16:9. Las pantallas antiguas utilizaban una proporcién de 4:3.
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renderizado

resolucién

RGB

rigging

rotoscopia

secuencia

simbolo

sincronizacion de
labios

slugging

Paso final de la animacién por ordenador. Durante el renderizado, el
ordenador toma cada pixel que aparece en la pantallay procesatodos los
componentes. Ademas, agrega desenfoque de movimiento antes de que
produzca unaimagen final. Es el proceso de calcular las imagenes finales
después del proceso de composicion.

Tamafio de una escena, calculado por lo general en pixeles. Por ejemplo, la
resolucion NTSC es de 720 x 480. La resolucién debe coincidir con la salida
final: HDTV, film-1.33, film-1.66, NTSC, PAL, baja.

Siglas en inglés pararojo, verde y azul. Método que permite definir el color
especificando las cantidades de estos tres componentes del color.

Proceso de conectar las distintas partes de una marioneta cut-out.

Técnica de animacioén en la que los animadores trazan un movimiento de
pelicula de accion en vivo, fotograma a fotograma, para usarlo en peliculas
animadas. Es el acto de esbozar sobre material de accién en vivo para crear
una secuencia animada.

Serie de escenas o planos que forman una parte distinta de la historia o
pelicula, normalmente conectados por la unién de la ubicacién o el tiempo.

Un icono combina animacion, ilustraciéon o capas en un Unico objeto que
puede controlar en una capa. También puede crear iconos de cada parte del
cuerpo en marionetas cut-out. En un icono puede colocar o que desee.
Puede utilizar simbolos para animar una marioneta o crear animaciones
reutilizables, como un parpadeo.

Proceso que consiste en sincronizar la boca de un personaje con sonidos en
la pista de sonido del didlogo. La boca se ajusta fotograma a fotograma
para hacer coincidir el sonido del didlogo y aparentar que el personaje esta
hablando. La sincronizacion de labios se puede utilizar para cualquier
secuencia de sonido y no solo para el habla. Por ejemplo, puede hacer que
un pajaro pie o que un lobo adlle alaluna.

Indicacion de los tiempos de inicio y detencién de un dialogo y las acciones
relevantes.
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storyboard

tableta/lapiz

Totales acumulados
de columna

transicion

trayectoria

trazar y pintar

usar carta de rodaje

vector

velocidad

vibraciéon de camara

Plan visual de todas las escenas y planos de una animacion. El storyboard
indica lo que sucedera, cuando lo haray como se distribuyen los objetos en
una escena.

Dispositivo utilizado junto con un raton, o en lugar del mismo, para mover el
puntero (en ocasiones denominado cursor) por la pantalla del ordenador.

Campo de texto que contiene informacion de diélogo, efectos, sonido o
slugging en un storyboard.

Efecto colocado entre dos escenas cuando se pasa de una a otra. Los
efectos de transicion comunes son el fundido encadenado y el barrido.

Ruta o trayectoria generada por ordenador que pueden seguir los
elementos. Latrayectoria se puede controlar mediante puntos de control,
fotogramas clave y velocidad.

Unavez que los bocetos de las animaciones se han limpiado y se ha
realizado una prueba de linea o de l4piz final, cada dibujo se traza y se pinta
parala animacion final. En el mundo digital actual, esto se puede realizar de
maneras distintas alos métodos de celuloide o acetato tradicionales.

Asignar un dibujo determinado a un rango de fotogramas.

Unaimagen basada en vectores esta compuesta por puntos y curvas Bézier.
El ordenador lee los puntos y traza los segmentos, vinculandolos para
reproducir la forma de imagen. Una imagen vectorial no contiene tamafio
fijo ni resolucién. El grafico se puede ampliar y distorsionar segun se desee
y el sistema volvera a calcular los segmentos y reconstruird las formas. Las
imagenes vectoriales se trasladan y se muestran en pixeles una vez que el
calculo se harealizado.

En animacion, la velocidad es la aceleracion o la desaceleracion de un
movimiento. Se puede alcanzar mediante una curva de funcién o una serie
de dibujos animados. Otros términos comunes para aceleracion gradual y
desaceleracion gradual son aceleracion y desaceleracion.

La vibracién de camara se produce en una escena cuando la camara se
mueve ligeramente y rapidamente en varias direcciones. Este movimiento
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Zona

Zona segura

dalaimpresion de impacto, vibracién o, por ejemplo, baches en la carretera.

Area que se puede pintar con color.

Zona central del fotograma de una escena que no quedara recortada por el
fotograma de TV. Como un fotograma de TV corta un margen del tamafio
del fotograma original, al mantener una zona segura se garantiza que la
accion principal de la escena siga siendo claramente visible unavez que la
pelicula se proyecte en television.
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